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Using XenoDream is the guide to using XenoDream 1.6 and 2.x. This is the v2.7 edition. It is
meant as an introduction, and also includes more advanced tips and techniques.
What's new in this edition
For v2.7, three of the four new constructors have been added to the Constructor Gallery.
For v2.6, three of the eight new constructors have been added to the Constructor Gallery.
For v2.5, pictures of controls have been updated for the new look, and some tutorials have
been edited to account for changes to some constructors. There are updates to the
Constructor Gallery, Fractal Metamorphs 2 and Making Holes in Holons. A new FAQ section
has been added for Technical Questions.
For v2.4, there are new topics on extruding shapes, and mesh coloring. There are updates to
the Constructor Gallery, Trees, Fractal Metamorphs 3, Depth of Field and Frequently Asked
Questions.
For v2.3, there are new topics for making holes in holons, new fractal metamorphs, the com
and circ metamorphs, and the Depth of Field effect. There are updates to the Constructor
Gallery; Adding, Selecting, Deleting Holons; Fractal Metamorphs; Shadows; all the Mesh
Export tutorials, Frequently Asked Questions, and a few other minor edits.
For v2.2, there are new topics for cubic symmetries, fractal metamorphs and multiple render
techniques. The constructor gallery and metamorph categories have been updated to include
changes, and the topics about Pic Textures have also been expanded.
For v2.1, there are new topics covering the new view controls and lighting with regions. The
Metamorph Coloring Basics topic has a better example, and some other topics have been
updated to take account of changes.
If you previously used v1.6, you will find a few extra topics covering v2 features, and some
lighting topics enhanced by the use of Pic Textures.
Note: this is a separate document from the help reference. You can get specific help for any
control in the program by right-clicking the control and choosing 'What's this?'
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Foreword

Foreword
Welcome to the v2.7 edition of Using XenoDream. The first editions were introduced with v1.6
and v2.0, in response to requests for more tutorials, tips, illustrations and explanations of how
to achieve a variety of results. Some have wished for a book, and this guide is as much as I
have managed to write so far.
What I had in mind is to expand the existing topics and tutorials into a coherent narrative so
you can see how it all fits together, and provide recipes and techniques that you can use in
combination. So it is divided into sections covering objects, backgrounds, lighting, etc., and
within each section we will explore some of the possibilities. The topics contain a mixture of
tutorials, illustrations and suggestions.
I also want to say something about the interface. The number of controls can seem daunting
at first. I can assure you that most of the time you only need a few of them. Before long,
some of the recipes in this guide should become so familiar that you can do them with barely
any thought. Just a few of them may keep you happy for years. The others are there so you
never run out of possibilities.
On a related note, some of you may wonder how XenoDream was designed, or why some
features are implemented in a particular way. The answer is that due to XenoDream's
uniqueness, it has been as much evolution as design, involving a lot of discovery about what
is possible and how. Each release is the best we can do at the time, while maximizing
backward compatibility.
I hope this guide helps you to get as much enjoyment and creativity from XenoDream as you
can find time for.
Garth Thornton
CEO, XenoDream Software Ltd.
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Introduction

XenoDream is unique in a number of ways, so some aspects are bound to be new to you. We will start with an
overview of what the program does and how it is organized.
The main focus of XenoDream is making 3-D objects, and rendering them into pictures. You can export the objects
as 3-D meshes, point clouds or depth maps for use in other 3-D programs. You can also open picture files for
composition or applying effects.
First we will look at how XenoDream is organized for this, in The XenoDream windows
Next we will look at how the objects get their shape

4

4

.

.

In the following chapters we will find out how to use XenoDream for a variety of results. Some tutorials go all the
way to a finished picture. Others focus on particular features, and if you want to turn them into a complete picture
it is up to you to use what you've learnt. For some features we will only discuss how to use them or give
suggested steps or settings. Some tutorials will be relevant to more than one chapter, so we will refer to them
wherever they are relevant.
The first section is Creating Objects 9 . This is by far the largest section, covering a lot of possibilities from basic
to advanced, so there is no need to explore or master all of the techniques in this section before learning
something from other sections, especially backgrounds and lighting.
The Backgrounds 91 section covers some of the ways to make backgrounds behind objects. The resulting
pictures can also be used for other purposes.
The Pictures and Lighting 101 section introduces pictures and layering, and a range of lighting methods and issues.
Lighting is the process where rendered objects get their 3D appearance by combining light and background
options.
The Depth Window 127 section shows how to create depth from pictures and how to combine backgrounds with
objects for texture or shadows.
The Exporting 3D Data 132 section discusses exporting depth maps and meshes for use in other 3D programs,
with several tutorials on exporting meshes.
There is also a Frequently Asked Questions
objects, pictures and lighting and meshes.

142

section, with answers to general questions as well as topics on
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1.1 The XenoDream windows
XenoDream has separate windows for the major functions. The Main window is for editing objects; the Picture
window is for managing 2-D picture layers, and the Mesh Export window is for exporting objects as meshes. There
is a Lighting window for controlling the 3-D lighting, which is applied as an interactive post-processing step instead
of during the render, for reasons that are explained below.

Note that the Depth window is only used when you want to create or add 3-D depth from pictures, and is not part
of the usual process of creating objects and rendering them. Mostly you will use the Main, Picture and Lighting
windows (and associated dialogs and floating windows).
Rendering is a standard term for calculating the pixels in the picture from the model. In XenoDream, the 3-D points
cannot be calculated in pixel order, so we have to calculate all the points to know the shape of the object in detail.
This means that we can't calculate how the surface will respond to lighting until afterwards. Rendering calculates
the distance from the camera to each pixel (the Depth Map), the inherent color of each pixel (the Unlit Picture),
shadow maps for each light that can cast a shadow, and if required, the opacity of each pixel (the Alpha Channel).
After rendering we can apply lighting effects to make the Lit Picture. It may be saved as is, or have more filtering or
layering applied.
Now let's look at how the objects get their shape.

1.2 How objects get their shape
Holons, constructors and metamorphs
Most 3-D programs work by assembling independent building blocks, which may be standard shapes such as
spheres, cylinders, cubes etc (sometimes called primitives), or various kinds of meshes.
In XenoDream a building block can do either of two things. It can have an independent shape, or it can inherit its
shape from other building blocks. For this reason we called the building block a holon. (Hungarian philosopher
Arthur Koestler invented the word "holon" to describe something that is both a whole and an identifiable part of a
larger whole. It has the same origin as "hologram".) We will usually use the word "object" to refer to an overall
shape and not to individual holons.
We have called our independent shapes constructors. You can choose a standard shape from a list (bowl, blade,
cube, cone, cylinder, crystal, prism, sphere, torus, plane, frame, pipe, gearwheel, rotor, shaft and more) and adjust
some parameters to cover a wide range of shapes. Here are some of the variations using the two cube
constructors. The top row shows variations of the '.Boxed' style and the bottom row shows variations of the '.Cube'
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style.

Since we're making shapes in 3-D, each holon has parameters to change the size, orientation, position and skew
in each of three directions. (Skew is a rotation of one direction relative to others, and at 180 degrees it inverts or
mirrors the holon in one direction.)
We can also transform a holon in many ways using pre-programmed formulas that we call metamorphs. There
are over 380 metamorphs organized in the categories Tile, Mirror, Grid/Block, Local, Axial, Radial, Rotary, Warp,
Noise, Iterated, Fractal (and Constructors, which are implemented as metamorphs). Each has three parameters to
adjust the effect. The result of a metamorph depends on the shape it is applied to (except for constructors, which
have independent shapes). Here are some examples of metamorphs applied to a cube:

Inheritance and iteration
When a holon is not a constructor, it inherits the shapes of all holons. This means that it makes a copy of each
other holon's shape, and transforms it with its own parameters (scale, orientation, position and skew), and its own
metamorphs. Then, because it also inherits itself, it makes more copies of those shapes and transforms them,
and so on. We call this iteration. Usually you set the scale to reduce the size of each iteration (and you can also
limit the number of iterations of a holon). If a holon iterates, we will call it an iterator. Let's look at two examples to
see how it works.
Example 1: two holons - one constructor, one iterator.

The picture on the left shows the arrangement of the holons, which are drawn as cubes transformed by their scale,
skew, orientation and position. The picture on the right shows the resulting shape. The yellow holon is a cube
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constructor. The grey holon is an iterator, that reduces size to 93% and rotates 30 degrees counterclockwise. You
can see the effect of the inheritance in two parts. First it inherits the yellow cube and transforms it into the largest
grey cube. Then it inherits itself, each iteration making a smaller copy and rotating it further around the spiral.
Example 2: two holons - both iterators.

The holon arrangement is the same as before, but now each holon inherits the other and itself. The large holon
iterates in the overall spiral shape. The small holon shrinks the large spiral to 36% and moves it to the right,
making the yellow/green part of the spiral. Together they create a spiral of spirals.
The rest of this chapter is not necessary to use the program. It may be of interest to know why the program works
as it does.
Fractals
Shapes with some kind of self-similarity (variations of the same shape are repeated at different scales) are called
fractals. There are many types of fractals, and the type created by two or more iterators in three dimensions is
called a 3-D Iterated Function System (IFS). If you have encountered these before, the "holons" were probably
called transforms or functions. We wanted a name that is less overloaded, so you can play with these strange
building blocks without being distracted by mathematics or other word meanings. The IFS method (as explained
below) is used to generate all objects in XenoDream, even though constructors allow you to make shapes that
may not have any fractal characteristics.
Is XenoDream a fractal program? You can use it for making or exploring IFS fractals (and also some Julia set
fractals, using Fractal category metamorphs), but that is really a subset of what the program does. XenoDream
makes 2d or 3d objects that may or may not have fractal structure.
How is the shape actually made from the holons?
We have shown how holons produce iterated shapes. Iteration is also the process used to generate the shapes.
One point is calculated at each step. Starting with any point in the shape, each holon inherits that point and
transforms it to a new point. Two holons produce two new points. Repeating this process with those two points
produces four more points. Repeating enough times would produce millions of points, each with a different
sequence of holon inheritance. The number of points necessary to fill in the shape depends on the size of the
picture, and on the density of the shape, which depends on the scale factors of each holon. Longer sequences
would not produce any new points.
There are several methods of calculating the sequences of points. Some of them go through all the sequences in
order; but that has some major disadvantages, depending on which order is used. The other method chooses them
at random, and for this reason we call it the chaos method. At each step a holon is chosen at random, and it
inherits and transforms the previous point, creating one long random sequence. This works because a sufficiently
long random sequence contains all the different short combinations. One advantage of this method is that by filling
in the shape randomly, the whole shape is visible quite quickly, though the fine details take longer to accumulate.
Therefore we use it for previews as well as the default method for the full size picture.
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How does the program find a starting point that is in the shape? It just starts with a point that is probably not in the
shape, and with each iteration the point converges towards the shape. This happens because holons generally
don't have scales that expand*. The shape is sometimes called the attractor for the set of holons. So XenoDream
ignores the first thousand points in the random sequence to be fairly sure that the points are in the shape before it
starts plotting them.
* Actually, some combinations such as a scale of 100% or more, especially with a shift in position, can result in
divergence, and some metamorphs also can. We refer to such shapes as explosions, and by automatically
restarting the shape whenever it explodes too far, we can still make a picture. But if it explodes too fast, there's
nothing to plot and an overflow indicator appears.
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Creating Objects

XenoDream is all about 3-D objects, and the Main window is where you create them. In the previous section, the
How objects get their shape 4 topic described how objects are made of holons. This section starts with the
simplest objects using a single holon, and works up to more complicated combinations. The initial emphasis is on
holons and shapes, followed by coloring and other topics. Most topics have step by step tutorials.
Getting started with shapes and metamorphs
First look, one holon

11

introduces the Shape page, and the basics of working with a constructor holon.

One holon: Christmas crystal
saving the picture.

13

is a tutorial showing the complete process, from making the shape through to

The next three topics introduce the variety of metamorphs available to define or modify the holon's shape.
The Constructor gallery 15 illustrates typical shapes that each constructor style can have.
The One holon, two metamorphs 26 topic introduces the other categories of metamorph and how they modify
constructors.
The One holon: noise metamorphs 30 topic shows how to use some metamorphs in the Noise category to create
terrains, rocks and other effects.
The Adding, selecting, deleting holons 33 topic introduces the Holon toolbar and the various ways of adding,
selecting and deleting holons. It also covers the Undo and Redo buttons, and the Solo Holon button for working
efficiently with one holon amongst many.
Iterators and making more complex shapes
An iterator holon is any holon that is not a constructor. It allows more complex shapes by iterating other holons
into repeating patterns.
Iterators and spirals
A spiral shell

37

35

has tutorials showing how iterators make different kinds of spirals.

is a tutorial to make a classic two holon shell, with coloring and lighting.

Kaleidoscopes and vases
Iteration controls
Trees

41

41

39

introduces shapes made by an iterator that rotates without reducing size.

shows how to limit the number of iterations of holons, to reduce complexity of detail.

illustrates different kinds of trees, some made entirely from iterators and others using constructors.

Free holons and hidden holons 43 discusses the purpose of making holons hidden or free, and has a tutorial
exploring the combinations. Holons that are both free and hidden do not have direct effects, so this is a convenient
way to temporarily disable them. They can be used for other purposes, especially extending holons.
Extending holons for extra metamorphs

45

is an important technique for more control of shape, texture or coloring.

The next two topics are not essential to mastering the program, but can be useful for some things.
Displacement mapping

47

is a variation of extending holons that provides extra options for controlling the shape.

The Align Cyclic 49 dialog provides complex possibilities for varying the holon parameters in geometric patterns. It
can be used as a kind of multireplicator.
The next seven topics explore some very interesting and useful metamorphs and methods.
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Cubic symmetries

51

shows how to make various interesting cubical geometries.

Fractal metamorphs 53 introduces metamorphs in the Fractal category, which are typically Julia sets.
Fractal metamorphs 2 55 explores 2D and 3D Julia sets using internal tree iteration for more detail.
Fractal metamorphs 3 60 introduces fractals using Moebius transformations.
The Com and Circ metamorphs
stencils.
Making holes in holons
Extruding shapes
rotation or spirals.

66

63

62

are a basis for diverse and decorative patterns for coloring, displacement or

shows several ways to use metamorphs to cut away parts of holon surfaces.

shows several ways to extrude a 2D shape into a 3D shape, in a single direction or with

Setting the colors
There are different approaches to coloring, depending on the possibilities of the shape and what you want to do
with it. Coloring can follow the shape in various ways, depending on the holons and metamorphs, or it can have
patterns that are independent of the shape, or it can come purely from the lighting. The next five topics look at
ways to color the holons before rendering.
Coloring: two methods 67 introduces the Holon Sequence and Metamorph coloring methods and how to choose
between them.
Metamorph coloring basics 69 has tutorials on the basics of coloring holons with plain colors or gradients based
on the metamorphs.
Advanced coloring and wood 72 takes you through several ways to use metamorph patterns for coloring, and how
to create wood grain textures.
Stone textures 75 shows how to use similar methods to create a wide variety of granite, marble, agate and other
stone textures.
Picture mapping 78 has a tutorial on mapping the background picture onto holons.
Other topics
Transparent preview and rendering 79 discusses the usefulness of previewing the object with transparency, and
gives tips for rendering and lighting transparent objects.
Optimizing for quality and speed 81 is very useful information when you find that an object is taking a long time to
develop detail, or renders unevenly, or has defects in the lighting no matter how long you render it.
Views and the camera
of the object.

82

is an introduction to the camera and the six fixed direction views, and clipping the front

Stereo images 83 describes methods for making several types of stereograms (images that can be viewed in 3D
by using visual techniques or colored glasses). XenoDream can create some types of stereogram automatically.
Sample files and starters 85 discusses the sample files included with XenoDream.
Dirk Monteny's sample files 86 include notes on their use.
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2.1 First look, one holon
When you start XenoDream, the Main window appears. You may want to resize the Main window (either by
dragging one of the border corners, or by maximizing the window), especially if it shows scrollbars inside the right
or bottom border. Other windows may also need resizing the first time you see them.
Putting your name into your files
The first tab page in the lower part of the window is the File page. Before doing anything else, this would be a good
time to enter your name as the default creator, so it will be saved with any parameter files you create. From v2.5
onwards it defaults to your registered name.
1.
2.

Edit the text in the Creator field, replacing it with your name or alias (and a URL if you like.)
Click the Save button. The default Creator will be used when you start XenoDream, start a new file, or click
the Restore button.

The Shape page
Now click the Shape tab to go to the Shape page. You will probably spend more time here than anywhere else in
XenoDream.

From left to right, the groups of controls are:
1. The Drag Mode and other options for manipulating holons.
2. The holon parameters, showing Scale, Skew, Rotation and Position values for the active holon.
3. Iteration controls and extended holon controls.
4. Metamorph controls.
5. Shape Memory Spots.
Note: Most of the time the holon parameters and the metamorph controls are all you need, along with selecting
holons and dragging them around in the Holon window.
The Holon and Preview windows
Much of the Main window is taken up by two windows (both visible by default, but you can hide either one, or
change the background colors, with toolbar and Preferences options). The Holon window is on the left, and shows
the arrangement of holons, with each holon drawn as a cube outline. There is always at least one holon. One holon
is always active for editing, and is drawn in yellow. The X, Y and Z axes are drawn in red, green and blue
respectively. The Preview window is on the right, and there is nothing to see at first because the holon is not yet a
constructor. So the first thing we want to do is find out how to make constructor holons.
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Making a constructor holon
For an existing holon, we do this by setting the first metamorph to one of the constructor styles. A holon can have
two metamorphs, so there are two sets of metamorph controls. Next to the button labelled 'Metamorphs', there are
two Style buttons, with captions set to '(None)', indicating that no metamorphs are assigned to the active holon.
1.

2.

3.

4.

5.
6.

Click the first Style button (the one on the left). It stays down, and the Metamorph Styles list appears in a
floating window. Drag the window to somewhere convenient, and resize it if necessary. In the Metamorph
Styles window the Constructor category should be selected (if not, click it), and the style list shows the
constructor styles.
Click on '.Sphere' in the style list. The Style button caption changes to '.Sphere' and a large yellow sphere
appears in the Preview window. Notice that it takes a few seconds to fill in and become smooth. The
metamorph controls should look like this:

The .Sphere constructor is one of a few whose Amount parameter only matters whether it's positive or
negative. The numeric controls respond to mouse dragging, so click on the number in the Amount control and
drag it up and down. You can also use Ctrl and Shift with dragging for slower or faster effect. There are other
ways to adjust numbers. You can type them in, or use the arrow buttons on the controls, or the cursor keys
on the keyboard, or some shortcut keys. Try these keys in the Amount control: spacebar to get the default
value, 'n' for the minimum value, 'm' for the maximum value, 'z' for zero, 'c' to subtract 1, 'v' to add 1, 'b' to
round off decimals.
In the Metamorph Styles
window, right-click on '.Sphere'. This will show a brief description of what the controls do for this style. You
can right-click on any style name to find out about it.

To change the size of the sphere, adjust the Scale control (the one underneath Amount).
To see some variations on the shape, adjust the Special control.

Now let's have a look at a cube.
1.
2.
3.
4.
5.

Set the first metamorph's Amount to 0, Scale to 5 and Special to 0.
In the Metamorph Styles window, click on '.Cube'.
Experiment with combinations of positive and negative values of Scale and Special to see some of the shape
variations.
Also experiment with positive and negative values of Amount to see more variations.
When you've finished, set Amount to 0, Scale to 4 and Special to 20 for the next exercise.

The holon parameters
It will be useful to change the position and orientation of holons, and to vary the scale in different directions. This is
what the holon parameters are for. Metamorphs are normally applied after the holon parameters, and constructors
would override them. So we have the Reposition, Rescale and Reorient options to allow the holon parameters to
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modify the metamorph. Reposition is checked by default.
1.
2.

3.

4.
5.
6.
7.
8.

Make sure the Drag Mode dropdown box (top left of the Shape page) is set to Position. This setting and
some others are remembered between sessions for your convenience.
In the Holon window (the one showing the cube as a yellow outline), click and drag anywhere in the window.
The holon will move too, and the cube will move in the Preview window. (When you have more than one holon,
you will need to begin dragging near the active holon to avoid selecting a different holon.) Drag the holon
around a few more times.
Notice that the Position controls (the bottom row of the Holon Parameter controls) also change to show the
holon's position. Drag each of the three Position numeric controls up and down to move the holon in the X, Y
and Z directions. (Dragging numeric controls horizontally gives finer control.)
Set the X Rotation control (the one in the first column) to 30. Notice that the holon has rotated in the Holon
window, but not in the Preview window, because we haven't checked Reorient for the cube constructor.
Check Reorient for the first metamorph (this means click the checkbox so it has a check mark in it; we will
say uncheck when we want it cleared). Notice that the cube has now rotated in the Preview.
Check Rescale for the first metamorph. Notice that the cube is smaller in the Preview because the three
Scale values of 80% are now modifying the cube.
Experiment with the X, Y and Z Scale controls and observe how the cube is affected in both the Holon and
Preview windows.
Now experiment with all three Rotation controls to see their effects. First try them one at a time with the
other two set to 0, then in combinations.

In summary, we have learnt how to make a constructor holon and how to modify it with the holon parameters.
Suggested exercises: explore some of the other constructor styles. First set the holon parameters back to their
default values (scales to 80, rotations and positions to 0). You may find it useful to have some X and Y rotation to
see them from an oblique angle. For each constructor, right-click the style name to see what it does, and
experiment. The Constructor gallery 15 has illustrations of constructors.

2.2 One holon: Christmas crystal
This topic shows how to make a constructor
holon into a finished picture. We will use a
crystal constructor, add a second metamorph to
give it a pattern, and use presets for color and
lighting.

First, we want to make sure we are starting from scratch. If you just started XenoDream, you're ready to begin;
otherwise click the File New button

in the Standard toolbar.

Making the shape
For this exercise we are using only one holon, which is already there. We will set the two metamorphs and rotate
the crystal to be horizontal.
1.
2.
3.
4.

Click the Shape tab to go to the Shape page.
Click the first Style button. It stays down and the Metamorph Styles window is visible.
In the Metamorph Styles window, in the Constructor category, click on '.Crystal' in the style list.
Set the first metamorph's Special control to 4, to make a crystal with six sides (the number of faces around
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the crystal is the absolute value of Special plus two).
We want to rotate the crystal 90 degrees around the Z axis to make it horizontal. Check the first
metamorph's Reorient option, then adjust the Z Rotation (the third rotation control in the holon parameters)
to 90. The crystal shape should now be horizontal in the preview, but is still too large.
6. Set the first metamorph's Scale to 8 so it fits in the preview. Now we're ready to add another metamorph.
7. Click the second Style button. It stays down and releases the first metamorph's Style button.
8. In the Metamorph Styles window, click the Radial category, and click on 'Giblet' in the style list.
9. Increase the second metamorph's Amount to about 5 so you can see how it changes the crystal shape.
10. Set the second metamorph's Scale to 15 and Special to 10. If you are dragging the numeric controls, you
can just get close then press the 'b' key to set the decimal part to zero.
11. The pattern is stronger than we want, so reduce the second metamorph's Amount down to 1.
The metamorph controls and preview (shown smaller here) should now look like this:
5.

Setting the colors
1.
2.

Click the Color tab to go to the Color page. The preview changes to color preview mode.
In the Coloring Method dropdown box, choose Metamorph. You need to use this method for single holons,
and it's generally best when using constructors. Notice the additional controls that appear below the Method
control.

3.

Click the Gradient Presets button
to open the Custom Gradient Preset window. Click the 'Basic
combinations' category on the left, and choose the 'Prime RYB' preset. Click OK to close the window. The
gradient strip in the Color page shows the gradient we chose.
Set the first Meta pattern control to 2 and the second to 2 also. This creates a more interesting pattern.

4.

Rendering the picture
This is where we tell the program to calculate the data for the full sized picture. We will use default settings this
time.
1.

Click the Render New button in the Rendering toolbar above the preview. The Picture window appears and
the object fills in rapidly. It is showing the Unlit picture, which looks flat because it doesn't include depth,
lighting and shadows.

In the Picture window toolbar, notice the Stop Render button
, and in the status bar at the bottom, the render
time and rate panels. The Rate is the number of new pixels plotted each second, which starts off large and
reduces as the object surface is filled in. Note: the number can jump around a bit and depends on the computer
speed, so numbers given in the tutorials are only suggestions.
We can go ahead and preview the lighting while it keeps rendering.
Applying lighting
1.

Click the Lighting button on the Picture window toolbar to open the Lighting window. You may need to resize
it to show all the controls.
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Scroll the Lighting Preview until the crystal is visible. It will look a bit rough at first and improve as rendering
fills in more details (the preview only updates when you scroll it or change any lighting control.)
The fastest way to get started is with Lighting presets.

3.
4.

Click the Lighting Presets button
to open the Lighting Preset window.
Drag the Lighting Preset window by its title bar so that it doesn't cover the Lighting Preview. You may also
need to move the Lighting window to find a convenient layout.
5. The lighting preset categories are listed on the left. Click on the '1.6 Basic' category.
6. Click on 'Matte' in the preset list, and notice the effect in the Lighting Preview window. You can scroll the
Lighting Preview window around to see how the rest of the crystal looks, while the Lighting Preset window
remains open.
7. For this crystal we want a shiny surface, so click on 'High gloss' in the preset list.
8. Click the OK button to close the Lighting Preset window.
9. Look at the rendering progress in the Picture window toolbar. When it has slowed to around 600 new pixels
per second or less, check the Lighting preview again. It should look good enough to use.
10. In the Lighting window, click the large Stop button at the bottom left. The caption changes to Apply. (You can
also stop rendering by clicking the Stop Render button in the Picture window toolbar.)
11. Click the Apply button in the Lighting window to apply the lighting to the object. The Picture window now
shows the Lit picture.
Saving the results
First we'll save the Lit picture to a Jpeg file.
1.
2.
3.
4.

In the Picture window, click the File menu and choose Save Picture...
Create a folder for your pictures by clicking the button for New Folder, and name it anything you like. (If you
already have folders organized for saving pictures, navigate there first.)
Open the folder you just created.
Type a filename (eg Christmas crystal tut) into the Filename field and click the OK button.

Note: If you wanted to load this picture into another graphics program, instead of saving it in JPG format you would
choose either Bitmap or Photoshop format, or copy it to the clipboard and paste it into the other program.
After saving the picture, you are prompted to save the parameters, so you can recreate the object later. We'll save
the parameters in a XenoDream Parameter file, which has extension .xep.
5.
6.
7.
8.
9.

When prompted to save the parameter file, click Yes.
In the Save dialog, open the Data folder (or navigate to an alternative location if you wish to keep your files
elsewhere.)
Create a folder for your own parameter files by clicking the New Folder button and typing a folder name.
Either accept the suggested filename or edit it.
Click the OK button to save the parameter file.

Note: you can save the current settings as a parameter file at any time by clicking the Save As button
Main window Standard toolbar.

in the

2.3 Constructor gallery
This topic is a gallery of constructor styles. They are quite versatile so we show some of the possible shapes and
comment on their use. Constructor style names all start with a period '.' because in early versions all the styles
were in one list and it was convenient to list the constructors first. It is still useful to differentiate them from other
styles.
For most constructors the Scale control sets the size of the holon. Negative values produce a variation in the
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shape. But for some, the Scale control has different effects and to change the holon size you need to check the
metamorph's Rescale option and adjust the holon scales.
Before v2.5, constructors were filled in randomly, and a few styles were only true constructors with Amount set to
100 or -100.
From v2.5, constructors are filled in with regular patterns, continually reducing scale to fill the gaps. All styles are
always constructors.
Note: some of the more complicated constructors introduced in v2.6 and v2.7 are not shown here.
.Sphere
This is the preferred style for making a hollow sphere, with all points having equal density. Set Amount negative for
an hourglass, but the value has no other effect. The Special control distorts the central portion up or down, with
blunt or sharp points depending on whether Scale is positive or negative.

.Ovoid
Variations on a sphere for making egg and teardrop shapes. Use Amount to vary the vertical extension of the
sphere. Special controls the curvature of the extensions. Set Scale positive to extend upwards, or negative to
extend upwards and downwards. When Special is negative the sphere is biased upwards.

Balled (now demoted from constructor status, and located in the Warp category)
This was the first 'accidental' constructor in v1.1, and only behaves like a constructor when Amount is 100. It can
be used to modify other shapes when Amount is less than 100. It is unpredictable for some Scale settings when it
is the only holon. Set Scale positive for a hollow sphere with non-uniform density (noticeable as equatorial
brightness with transparent renders), or negative for a solid sphere with octahedral deformation (this does not work
at all when it is the only holon.) Special varies the radius.

.Cylibal
Another prototype from v1.1, but is a true constructor. Amount has no effect except as mentioned below. It
produces a hollow closed cylinder along the Z axis if Scale is positive, or a hollow sphere with uniform density if
Scale is negative. Special varies the radius along the Z axis, and also adds a spiral if Amount is negative. (For
cyclinders, .Pipe or .Shaft2 are usually easier to work with.)
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.Arccyl
A cylinder with variable extent around the Y axis. Amount sets the length, and negative values leave the front open.
Set Scale negative to taper the center. Special sets the extent around the Y axis, and negative values make the
rim spherical.

.Bowl
A truncated sphere with open or closed top, that can make a variety of bowls and cups. Amount sets the cutoff
height, and negative values close the top. Set Scale negative to fatten the top and bottom. Use Special to
modulate the diameter.

.Arcball
A truncated sphere with variable extent around the Y axis, for portions of an open or closed sphere. Amount sets
the cutoff height, and negative values close the shape. Set Scale negative to narrow the top and bottom. Special
sets the extent around the Y axis, and negative values make the top taller and thinner.

.Dumbell
A sphere extended by a central deformable cylinder. Amount sets the length, with negative values flattening the
top and bottom. Set Scale negative to square up the sides. Special deforms the cylinder to make a dumbell or
oscillating shaft.

.Oloid
The convex hull of two perpendicular circles. Amount sets the distance between the circles, starting from one
radius. Set Scale negative for scalloped ridges. Special adjusts the convexity between the circles.

.Boxed
The first of two hollow cube constructors. Amount has no effect except as mentioned below. Set Scale positive for
a cube, or negative for a 24-sided polyhedron. Special adds pyramids to each face, with curved faces if Amount is
negative.
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.Cube
The second of two hollow cube constructors. It produces a cube by default, and Amount moves the edges out or
in. Set Scale negative to truncate the corners. Special adds pyramids to each face, set back from the edges.
For coloring, the meta patterns are set up to allow picture mapping to map a picture to each face.

.Cubernd
A hollow cube with rounded edges. It produces a cube by default, and Amount sets the radius for rounding the
edges. If Amount is negative, the faces are rounded separately. If Scale is negative, the faces are indented.
Special expands or contracts the edges.

.Block1
A rectangular block with up to four rounded edges, depending on the sign of Amount and Scale. Amount, Scale
and Special set the length in each direction. Set Special negative to sharpen the curvature.

.Block2
A rectangular block with one or two curved ends. Amount, Scale and Special set the length in each direction. Set
Amount positive for a single curve or negative for intersecting curves. Set Scale positive for a flat bottom or negative
for a curved bottom. Set Special negative to use S-curves.

.Prism
This allows a wide variety of prism shapes oriented along the Y axis. Amount controls the height of the prism, with
closed ends for positive values and open ends for negative values. Set Scale positive for double ended prisms or
negative for pyramidal prisms. Special controls the number of faces around the prism, and negative values make
star shapes.
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.Prismbox
Rectangular prisms and stars with a closed bottom and open or closed top. Amount sets the radius of a central
hole, with negative values for an open top. Set Scale positive to vary the height with the holes size, or negative for
a fixed height. Special controls the number of faces around the prism, and negative values make star shapes.

.Crystal
Prisms in a number of classic crystal shapes. Amount has no effect, except for adding curvature when negative.
Special controls the number of faces around the crystal. Set Scale positive for elongated double ended crystals,
with a middle section if Special is positive. Set Scale negative for a rounded crystal, with a flat top for positive
Special or a mirrorball for negative Special.

.Planex, .Planey, .Planez
These styles make square or circular planes facing the X, Y or Z axis. Amount has no effect except for adding a
step to the ripples when negative. Set Scale positive for square or negative for circular. By default they are flat, but
Special adds a bump or ripples. Amongst other things they can be used for walls, back-planes or a basis for
terrains.

.Framez
Similar to .Planez but with a hole in the center, suitable for picture frames or portholes. Amount sets the size of
the hole. Set Scale positive for square or negative for circular. Special adds ripples.

.Triangle
A flat triangle facing the Y or Z axis. Amount sets the height. Set Scale positive for the Z axis or negative for the Y
axis. Special skews the triangle along the X axis.

.Blade
A flat kite shape facing the Z axis, with variable curvatures. Amount sets the position of the widest point. Set Scale
positive for equal curvature or negative for opposite. Special sets the curvature.
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.Cone
This can make an open ended vertical cone of variable height, or it can be curved into a variety of spiral shells.
Amount sets the height of the cone and the relative width of the base. Special adds curvature around the Z axis,
and negative values add bubbles. Negative values of Scale or Amount add pitch along the Z axis, useful for pointed
spirals or shells.

.Conic
A conic section (truncated cone) with open or closed ends and optional curved profile. Amount sets the width, with
negative values for closed ends. Scale sets the height. Special sets the relative width of the top. The signs of
Scale and Special select one of four profiles.

.Crescent
A crescent shape with a choice of eight profiles depending on the signs of Amount, Scale and Special. Amount
sets the angle between the cusps. Special adjusts the width of the concavity. If Amount or Special is 0, the shape
is a disc with asymmetric profile.

.Torus
A hollow torus (donut) shape. Amount sets the width of the ring, and hence the hole size. Special adds ribs if
positive, or bubbles if negative. Set Amount and/or Scale negative to increase the height of the ribs or bubbles.

.Arctorus
A hollow torus with variable arc length (how far around the circle to go). Amount sets the width of the ring. Special
sets the percentage of the circle to use (so there isn't much to see when Special is 0). Set Amount negative to
add ribs. Set Scale negative to add bubbles. Set Special negative to clip the front half of the torus.
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.Ecctorus
An eccentric torus (also known as a ring cyclide). Amount sets the size of the hole. Four profiles (circle, square,
airfoil and dumbell) can be selected, depending on the signs of Amount and Scale. Special squashes the upper
sides in, and negative values make a more eccentric torus.

.Tyrus
A hollow torus with a variety of thread and groove shapes, good for tyres. Amount sets the width of the ring. Set
Amount and Scale positive or negative for different groove shapes. Special varies the shape of a thread when
positive or rings when negative.

.Ring
A ring with choice of eight profiles, from triangles to hexagon and sine square and dumbell, depending on the signs
of Amount, Scale and Special. Amount sets the ring width. The whole number of Special adds twists.

.Pipe
Makes a straight pipe along the Z axis, with variable hole size. Amount sets the length of the pipe. Set Amount
negative to add ribs along the pipe. Set Scale negative to bevel the ends. Special sets the size of the hole. Set
Special negative for rounded ends.

.Pipecut
A pipe along the Y axis, with variable angle at one or both ends. Amount sets the length of the pipe. Scale sets
the diameter of the pipe. There is no hole when Amount and Scale are positive; other combinations set the
diameter of the hole to 50%, 85% or 100%. Special adjusts the angle of the top when positive, or both ends when
negative.

.Gearwhl
This makes a variety of gearwheel shapes, around the Z axis. Amount sets the size of the teeth and Special sets
the number of teeth (two teeth per unit). If either of these is 0 there are no teeth. If Amount is negative the teeth are
clipped. Set Scale negative for a bevel gear. Set Special positive for triangular teeth or negative for sine teeth.
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.Rotor
Similar to gearwheel but using a flat plane instead of a hollow solid. Amount sets the size of the blades and
Special sets the number of blades. If Amount is negative the blades are clipped. Set Scale negative to incline the
blades. Set Special positive for triangular blades or negative for sine blades.

.Springy
A spring winding around the Y axis. Amount sets the height. Set Amount negative to use coiled wire. Set Scale
positive for a light spring (thin wire) or negative for a heavy spring (thick wire). Special sets the number of loops.
Set Special negative to reduce the pitch at the top and bottom.

.Springy2
A spiral spring winding around the Y axis. Amount sets the height. Set Amount positive for single ended or
negative for double ended. Set Scale negative for a thicker wire. Special sets the number of turns. Set Special
negative for a curved profile.

.Screwhd
A screw head or rivet, positioned above the zero point for easy alignment with surfaces or shafts. Amount sets the
size of the groove. Set Amount positive for one groove or negative for two. Special adjusts the width of the base,
with negative values giving rounded edges. Set Scale negative to add a dimple for rivets or indented screws.

.Shaft1
A cylinder extending downwards, with variable curvature and options for thread and grooves. It is good for nails,
screws and drillbits. Amount sets the diameter, Scale sets the height, and Special varies the curvature. Set
Amount negative for grooves. Set Scale negative for a thread.

.Shaft2
A cylinder extending upwards, with a variety of optional thread and groove shapes. Amount sets the diameter and
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Scale sets the height. Set Amount and Scale positive or negative for different groove shapes. Special varies the
shape of a thread when positive or rings when negative.

.Shaft3
A pointed cylinder extending upwards, with a variety of optional thread and groove shapes. Identical to .Shaft2
except for the pointed top.

.Shaftsqr
A square shaft extending upwards, with a variety of optional thread and groove shapes. Similar to .Shaft2 except
for the square cross section.

.Wing
A single wing or horn shape, with four choices of profile (airfoil, triangle, diamond or oval) depending on the sign of
Scale and Special. Amount sets the forward pitch of the wing, with 50 being neutral. Positive values make a
triangular wing, negative values tapered. Scale sets the central width of the wing. Special adjusts the wing
curvature, blending through various shapes. To change the size, check Rescale and adjust the holon scales.

.Wings
A pair of wings or arrowhead shape, with four choices of profile (airfoil, triangle, diamond or rectangle) depending on
the sign of Scale and Special. Amount sets the forward pitch of the wings, with 50 being neutral. Positive values
make triangular wings, negative values tapered. Scale sets the central width of the wings. Special adjusts the wing
curvature, blending through various shapes. To change the size, check Rescale and adjust the holon scales.

.Crysmol
Rod and ball lattice models of molecules in crystal shapes. Eight arrangements depend on the sign of Amount,
Scale and Special. Amount sets the ball size. Scale sets the height of the shape. Special plus 2 is the number of
segments around the Y axis.
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.Cycloz1
Flat cyclic patterns of tubing around the Z axis. Amount sets the width of the oscillation, with negative values
making a ropy or beaded tube. Set Scale positive for thin tubing or negative for thick tubing. Special sets the cycle
frequency.

.Cycloz2
Flat looped cyclic patterns of tubing around the Z axis. Amount sets the width of the oscillation. Set Scale positive
for thin tubing or negative for thick tubing. Special sets the cycle frequency, with positive values having loops and
negative values having sawtooths.

.Cycoil
A cyclic pattern of tubing around the Y axis, in cylindrical or spiral shapes. Amount sets the size of the oscillation,
with negative values making ropy tubing. Set Scale positive for thin tubing or negative for thick tubing. Special sets
the cycle frequency, with positive values for cylindrical oscillation or negative for spirals.

.Griller
A diagonal grille pattern of either sine or triangle waves. Amount sets the thickness of the tubing, with negative
values adding a bulge towards Z. Scale sets the height, with positive values for circular tubing or negative values for
square tubing. Special sets the relative frequencies of X and Y waves, with positive values for sine or negative
values for triangle waves. To change the size, check Rescale and adjust the holon scales.

.Grillex
A grille pattern linear in the X direction, with four different waves depending on the signs of Amount and Special.
Amount sets the thickness of the tubing. Scale sets the height, with positive values for circular tubing or negative
values for square tubing. Special sets the relative frequencies of X and Y waves. To change the size, check
Rescale and adjust the holon scales.
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.Woverect
A rectangle of woven strands, with four profiles (circle, square, cord or rope) depending on the signs of Amount and
Scale. Amount sets the relative width of the rectangle, and the height is adjusted accordingly. To change the size,
check Rescale and adjust the holon scales. Scale sets the density of strands. Special reduces the thickness of
strands. Set it negative for 2x2 weave.

.Lissa
A 3D grille using combinations of sine or triangle waves (Lissajous figures). Amount sets the thickness of the
tubing. Scale sets the relative frequency of the Z wave, with positive values for circular tubing or negative values for
square tubing. Set Amount negative to change the Z wave phase by 90 degrees. Special sets the relative
frequencies of X and Y waves, with positive values for sine or negative values for triangle waves. To change the
size, check Rescale and adjust the holon scales.

.Lineart
Square patterns of lines or tubes, with a choice of eight patterns depending on the signs of Amount, Scale and
Special. Amount sets the line thickness. Special sets the number of lines. To make repeating 2D patterns, use
with Tilexy.

.Digit7
A seven segment digital display that can show different numbers or letters using the first metamorph color
parameter. Amount sets thickness of the segments, with positive values giving a flat top and negative values giving
a faceted top. The first color parameter uses two colors if Scale is positive, or three if negative (for the bezel, off
segments and on segments). Special sets the code for which segments are lit. 0 is all off. With positive values, 1
to 10 gives the numbers 0 to 9, 11 to 36 gives representations of A to Z, and higher numbers cycle through the
segments. With negative values, the whole number and first decimal give the binary code for the combination of
segments. (In the fourth example below, the first and second color parameters are multiplied together.)
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2.4 One holon, two metamorphs
Constructors provide a range of shapes
and adding a second metamorph
multiplies the possibilities hugely. They
may be used alone (as in the previous
topics and the examples shown here), or
they may be combined into more complex
objects. Either way they are fundamental
to creating shapes. In this topic and the
next we will explore the categories of
metamorphs.

The metamorphs have been organized into categories based on the type of transformation or geometry. We will
describe each category and what the metamorphs might be used for, and give examples with settings. The "One
holon: Christmas crystal" tutorial showed how to make a constructor with a second metamorph (click the first
Style button, choose a constructor style, set Amount and Scale and perhaps Special controls, click the second
Style button, choose a metamorph and adjust its Amount, Scale and Special controls), so you should be able to
make the shapes shown below by using the styles and parameters listed. The numbers after each style are
Amount, Scale and Special in that order.
Note: when working with one holon, the preview will show it in yellow (unless you switch to color preview, by
clicking the Preview Mode button

in the Preview toolbar). The background is black by default. You can change

it at any time by clicking the Preview Background Color button
in the Standard toolbar and choosing one
of the four options. Many examples in this guide are shown in grey on white to be printer-friendly.
Tile metamorphs
The metamorphs in the Tile category make a number of exact copies of the holon in various arrangements. They
can be used for modelling or decorative purposes. For example, the Tilex, Tiley and Tilez metamorphs make
copies in a line in each of the X, Y and Z directions, and the Tilespher and Tilesph2 metamorphs arrange copies
around a sphere. Rotatex, Rotatey and Rotatez are most convenient for making rotational symmetries that can be
reoriented and positioned easily. In most cases the Special control sets the number of copies. Some exceptions
are Cubsym1 and Cubsym2, which make 24 tiles, and Tilestar, which makes 7 tiles. Amount and Scale usually
adjust size, radius or height. Styles that allow adjustment of tile size are easy to use in any context, while the
other styles work best when you can adjust the holon size, usually constructor Scale, to suit.
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Crystal 0, 10, 2;
Tilex 9, 11, 4

Crystal 0, -10, -4;
Tilexyd 12, 12, 6

Crystal 0, -10, 6;
Kaliz 10, -5.6, 7.1

27

Crystal 0, 10, 2;
Tilespher 5, 10, 5

Grid/block metamorphs
The metamorphs in the Grid/block category divide the holon into cells or grids, to allow repeating patterns of holes,
bubbles, vortices or deformation towards a lattice, or random patterns of blocks or mazes. Many can be applied to
a plane constructor to add a regular pattern, such as bricks or paving stones; for example, Planey with Bricksy or
Fblocky1/2/3, etc. The Circ and Com metamorphs can provide a huge number of decorative patterns.

Cube 0, 9, 0;
Gridcub 70, 6.2, 0

Sphere 0, 11, 0;
Holesz 80, 5, -20

Sphere 0, 11, 0;
Fstonez 30, 10, 10

Sphere 0, 11, 0;
Vortices 70, -4.6, -5

Local metamorphs
The metamorphs in the Local category affect the shape within specific regions, or on one side of a plane. Some
are useful when applied to more complicated objects than a simple constructor. For example, Domey can flatten a
terrain away from a central peak, and Powery can make plateaus or terraces in a terrain. There are several that
extrude the shape in various directions: Extrudez in a line, Helixy in a helix, Rotatey and Rotatez in a circle,
Shelly in a spiral.

Sphere 0, 10, 0;
Clipbb 50, 7.4, 0

Sphere 0, 10, 0;
Clampbb 100, 8, -1

Cube 0, 5, 20;
Flaty 10, 15, 2

Cube 0, 5, 10;
Project 20, -15, 0

Axial metamorphs
These metamorphs warp or rotate in ways aligned with the six axial directions. Auger, Ogre and Zypes rotate
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around the axes, and the other styles warp in various ways. Axibits and Axibots divide each direction into grids for
randomized radial warps. Hairpoly and Hairy make coarse or fine spines that can bend in one or two directions.

Cube 0, 7, 0;
Auger 50, 12, 0

Cube 0, 6, 15;
Zypes 50, 15, 0

Cube 0, 6, 8;
Spikes2 36, 15, 0

Cube 0, 7, 0;
Toves 75, 21, -20

Radial metamorphs
These styles modulate the distance from the center of the holon in various patterns. In general, points on a sphere
will be moved in or out. They are most useful with constructors.

Sphere 0, 10, 0;
Ribblet 10, 15, 1

Sphere 0, 10, 0;
Ripplet 5, 24, 8

Sphere 0, 10, 0;
Nubble 12, 12, 50

Sphere 0, 10, 0;
Warble 2, 12, -4

Rotary metamorphs
These metamorphs involve rotation or symmetry around or along a single axis. The purely rotational styles have no
visible effect on a sphere (other than coloring), so they are best with other constructors or with iterator holons.
Other styles make rows of arms or horns or holes, circular mazes, or cut the shape into strips or rings or spokes.

Cube 0, 5, 18;
Crinkle 18, 10, 0

Cube 0, 5, 18;
Twistz 25, 10, 10

Cube 0, 5, 18;
Zagzigz 25, 10, 0

Cube 0, 5, 18;
Ringoz 25, 15, 0

Warp metamorphs
This category includes any kinds of warping that doesn't fit into other categories. Some are asymmetric and others
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have symmetries other than radial, rotary etc. Squarer is useful for making circular shapes square around one or
more axes, for example any constructor with circular symmetry.

Cube 0, 7, 0;
Waver 14, 10, 25

Cube 0, 9, 0;
Styro 52, 24, 0

Cube 0, 8, 0;
Twirl 20, 40, 0

Cube 0, 13, 0;
Shell 60, 29, -8

Iterated metamorphs
These metamorphs use a formula that is internally iterated, allowing some interesting patterns. For all except
Latoocaz, the number of iterations is the value of the Special parameter plus one (so Special should be kept small
to avoid slowing down too much). Gnarl, Spinz and Popcorn warp in the XY plane, and Gnarl3, Gnorl, Gnurl and
Sphynx are 3-D variations. Curleryc, Curlerys and Spinry have cylindrical symmetry around the Y axis, so are
most interesting when applied to shapes without cylindrical symmetry.

Sphere 0, 9, 0;
Gnarl3 9, 10, 2

Sphere 0, 9, 0;
Sphynx 12, 9, 3

Sphere 0, 10, 0;
Popcorn 3, 10, 2

Cube 0, 6, 0;
Curlerys 13, 12, 3

Mirror metamorphs
These break the holon into pieces and manipulate them.

Cube 0, 8, 0;
Mirrors 20, 10, 15

Cube 0, 8, 0;
Mirage 95, 23, 34

Cube 0, 8, 0;
Mirball 80, 3, 0

Sphere 0, 10, 0;
Mirtile 100, 30, 0

Most metamorphs are useful with constructors, and that is also a good way to see what they do. Remember that
the result will depend on the shape they are applied to. Many metamorphs create interesting and sometimes very
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complex results when used with iterator holons, especially in combination with other metamorphs. We have used
examples with positive Amount values, and negative values usually have an opposite effect (useful or otherwise),
but for some styles it is the same as the positive value with some other change.
We will explore the Noise metamorphs in the next topic, and the Fractal metamorphs in later topics.

2.5 One holon: noise metamorphs
A constructor with a metamorph in the
Noise category can make a variety of
terrains (hills, mountains etc), rocks
and other surfaces. Noise
metamorphs are also very useful for
coloring, but this topic will focus on
shapes.

First we will look at the FBM styles (Fractal Brownian Motion, also known as Perlin noise due to Ken Perlin's
pioneering work). This is a kind of random noise, with two important properties. It varies smoothly with a
characteristic frequency, albeit in a random way, which is useful because we can control the roughness by adding
copies of the noise at higher frequencies (octaves). Second, any given parameter values will produce the same
result each time; which is useful if you want the mountain you make today to look the same tomorrow.
Planey with Fbmy
We will start with terrains on a horizontal plane. It will be convenient to view it from slightly above, so we will move
the camera (we could rotate the holon, as you've already learned to do, but when the terrain is not the only holon it
often makes more sense to move the camera.)
1.
2.
3.
4.
5.

Click on the first Style button and choose .Planey from the Metamorph Styles window.
Set Scale to 15.
Click the View tab to go to the View page. Near the middle of this page you will see three controls labeled
Angles.
Adjust the X Angle control to 40. This rotates around the X axis for a top front view.
Click the Shape tab to return to the Shape page.

For a terrain oriented in the Y direction, we will use the Fbmy metamorph.
1.
2.
3.
4.
5.
6.

Click the second Style button and choose Fbmy from the Metamorph Styles window.
Set the second metamorph's Amount to 6. The plane should now be curved like a section of low hills.
Increase the second metamorph's Scale to 20. This increases the frequency of hills (although not realistic for
that purpose).
Set the Scale back to 10. Now it's time to add some octaves.
Set the second metamorph's Special value to 8. Notice how the surface is now lumpy.
Increase Special to 10, notice the effect, then increase it to 12, then 14. Now it looks like rocky mountains.

The Special parameter controls the strength of octaves in bands of 25. Between 0 and 25, each octave is twice
the frequency of the previous one. That is the standard type of noise. Between 25 and 50, each octave is four
times the frequency; between 50 and 75 it is eight times, and above 75 it is 16 times the frequency. These higher
ratios give unusual rock or mud patterns. Negative values of Special behave the same way, except that higher
octaves are reduced faster for less roughness.
1.

Set Special to each of these values in turn and notice the effects: 32, 55, 77, -20, -40, -60.
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Here are some of the results (shown in grey on white instead of yellow on black):

Fbm y 6, 10, 8

Fbm y 6, 10, 14

Fbm y 6, 10, 55

Using the absolute value of each octave adds creases to the surface, and we get this by using negative values of
Scale.
1.
2.
3.
4.

Set the second metamorph's Special to 0 and Scale to -10. Notice the creases.
Set Special to each of these values in turn and notice the effects: 6, 9, 12, 53, -40.
Now set Special to 0 and Amount to -10. This gives an inverted creased terrain.
Set Special to each of these values in turn and notice the effects: 5, 8, 12, 55.

Here are some of the results:

Fbm y 6, -10, 9

Fbm y -10, -10, 5

Fbm y -10, -10, 12

Another useful thing to know about the noise metamorphs is that each 0.01 change in Scale gives you a different
placement of the hills without affecting the characteristics noticeably, so you can get plenty of variation.
Planey with Fbmymx
Next we will look at the Fbmymx metamorph, which is identical to Fbmy except that it uses the maximum value of
the octaves instead of adding them together. With positive Amount the effect can be like a rocky riverbed, and with
negative Amount it can give pitted rocks.
1.
2.
3.
4.
5.

Choose Fbmymx from the Metamorph Styles window.
Set Amount to 10, Scale to 10 and experiment with the range of Special values.
Set Scale to -10 and experiment with the range of Special values.
Set Amount to -10, Scale to 10 and experiment with the range of Special values.
Set Scale to -10 and experiment with the range of Special values.

Here are some examples:
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Fbm ym x 10, 10, 12

Fbm ym x 10, -10, 36

Fbm ym x -10, -10, -40

The Fbmz and Fbmzval metamorphs can be used to make similar types of shapes on a Planez or other surface, or
used for coloring. Next we will look at noises with radial displacement. Fbm styles using 'value' noise have a
different shape, more aligned with a square grid.
Fbmrad and Fbmrmx
These metamorphs use Fbm noise to displace radially (outwards from the center) so are good for turning spheres
or other shapes into rocks. The way that Amount, Scale and Special behave is otherwise the same as for Fbmy
and Fbmymx.
1.
2.
3.
4.

Click on the first Style button and choose .Sphere from the Metamorph Styles window.
Set the first metamorph's Scale to 10.
Click on the second Style button and choose Fbmrad from the Metamorph Styles window.
Experiment with different values for the second metamorph's Amount, Scale and Special.

Here are some examples of Fbmrad on a sphere:

Fbm rad 4, 10, 13

Fbm rad 10, -15, -15

Fbm rad -10, -13, 28

Now set the second style to Fbmrmx and experiment with its Amount, Scale and Special values.
Fbm3d and Fbm3dval
The noises we have looked at all displace in a direction set by the metamorph. The Fbm3d and Fbm3dval
metamorphs displace in random directions. They can be used with planes, spheres etc for terrains or rocks that
may overhang or intersect themselves. Another use is displacing other metamorphs, but that is a more advanced
topic for later (see Extended holons). They are slower than other Fbm noises.
Here are some examples:
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Sphere 100, 10, 0;
Fbm 3d 25, 12, 9

Planey 100, 15, 0;
Fbm 3d 10, -17, 8
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Planey 100, 15, 0;
Fbm 3dv 10, 17, 10

Voronoi noise
Voronoi patterns arise from randomly positioning points in a grid of cells and measuring the distances to the
nearest points. A variety of patterns result from different ways of calculating the distances and combining them.
Voroy2 and Voroy3 displace vertically; Voromy2 and Voromy3 displace vertically with a "city block" pattern
instead of irregular shapes; Vorminy2 is similar but uses the minimum of the X and Z distances; Voroz2 displaces
in the Z direction; Vororad displaces radially, and Vorogrid moves points towards or away from cell points in 3D.
The Poisson metamorphs are related, but with a more even distribution of cells and different options.
Here are some examples using Planey:

Voroy2 15, 2, 0

Voroy2 15, 2, 36

Voroy2 15, -2, 0

Other noises
The four Waves patterns combine a number of spherical waves at randomized positions. They cover the
combinations of constant and variable frequencies in the radial and Y directions.
The Agate and Wood patterns are intended for coloring. Agate can displace in the Z direction (and Agater in the
radial direction), but the Wood styles never affect shape.
In general, choosing colors for rocks and terrains can be as simple as setting the Coloring Method to
Metamorph, opening a Custom Gradient preset, and optionally adjusting Meta Pattern controls.

2.6 Adding, selecting, deleting holons
In this topic we will work with more than one holon. We will see how to select holons and how to add, copy and
delete them.
The Holon toolbar is located between the Holon window and the tab pages. It contains the general holon controls,
and the Preview controls (not shown in this image).

At present, holons are only identified by numbering. One holon is always active for editing, and the Active Holon
control provides one way to select a holon. The 'sel' box shows the number of holons that are selected, and the 'of'
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box shows the total number of holons in the object.
Adding holons
There are three ways to add a holon to the current object.
Click the Add Holon button in the Holon toolbar, to add a holon with default parameters and no metamorphs
assigned.
Click the Clone Holons button in the Holon toolbar, to add copies of the selected holons.
Right-click in the Holon window at the position where you want to add a holon. A popup menu appears, with the
choice of a plain holon (iterator) and a variety of constructor shapes. Choose one of them.
After adding a holon, the number of holons has increased and the new holon is active. The active holon is drawn in
yellow and other holons are drawn in grey, in both the Holon and Preview windows.
It is often convenient to have the Shape page visible when adding and deleting holons so you can see the
metamorphs and other parameters, and you are probably most interested in the shape while doing this anyway.
Selecting holons
Besides the Active Holon control, there are four more ways to select holons.
1.

Clicking in the Holon window. (For this to work, the Holon Select button
in the Standard toolbar must be
down. It is down by default, but sometimes you may find it convenient to release it to allow dragging
operations without the risk of messing up the selection.)
When you move the mouse in the Holon window, the nearest holon to the pointer is drawn in red, unless it
already happens to be the active holon. There are two options:
Click in the Holon window to make the nearest holon active.
Ctrl-click in the Holon window to select the nearest holon, so that it stays selected when not active.
Selected holons are drawn in the Holon window in cyan (aqua) when not active.

2.

Right-clicking in the Preview window. Moving the mouse over the preview shows a hint (tooltip) to identify the
holon under the pointer. In Grey preview mode, the holon also shows in pink if it's not already active. Rightclick to make this the active holon.

3.

There are four buttons in the Holon toolbar for selecting holons:
Select active holon
Invert holon selection
Select all holons
Deselect all holons

4.

You can select holons in the Holon Info List
, which has checkboxes for selection and lists the
metamorph details for each holon. As well as clicking the checkboxes you can click the text to set the active
holon, or double-click the text to select all or deselect all holons.

To try out the different ways of selecting holons you will need to add some holons first. Add some holons using
one or more of the three ways described above, and drag them around in the Holon window. (Don't worry about
what the result looks like in the Preview window. It's common to see some chaos when adding one or more iterator
holons before adjusting them.) Then experiment with selecting holons in different ways.
Deleting holons
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There is only one way to delete holons from the current object:
Click the Delete Holons ('Del') button in the Holon toolbar, to delete the selected holons.
As this button deletes all selected holons, not just the active holon, it is a good idea to check if any other holons
are selected before clicking it.
Note: there must always be an active holon, so you can't delete all holons. If you try, holon 1 will not be deleted.
The Solo holon button
It is often convenient to see just the active holon, especially when working with many holons. It also speeds up the
preview while adjusting the shape or coloring of the holon. It applies to the render too, so you can test render just
the active holon.
Click the Solo Holon button

in the Holon toolbar to show only the active holon.

Ctrl-click the Solo Holon button to show all selected holons. If the button is already down it will stay down.
Remember to release it to see the whole object.
Undo and Redo
It is often useful to undo changes when they don't work out, or weren't what you intended to do. There are 12 levels
of undo and redo, and they work for anything that changes the object. Controls that don't directly affect the object,
such as drag modes, don't have undo, but each drag operation can be undone. You can undo opening files or
restoring from memory spots.
Click the Undo button

to undo the last change to the object.

Click the Redo button

to redo the last undo operation.

2.7 Iterators and spirals
As described previously, a holon is either a constructor (with independent shape) or an iterator (inherits the shape
from other holons and iterates it). If you have more than one holon and they are all constructors, they are
independent of each other and you can manipulate each one without affecting the shapes of the others. If one or
more holons are iterators then their shapes depend on all the holons, and this interaction allows complex shapes,
but also makes editing more challenging.
An iterator by itself does nothing, except iterate itself into a single pixel. This is what you see when you start
XenoDream, or choose File New (the pixel disappears with preview shading enabled). The simplest way to see how
an iterator works is with one iterator and one constructor holon.
Iterator with one constructor
1.
2.

Click the File New button
in the Standard toolbar. This starts us off with holon 1 as an iterator with
scales of 80%. If you're not already on the Shape page, click the Shape tab.
Right-click in the Holon window near the right end of the X axis (the horizontal red line), and choose 'Cube >
Trunc cube' from the menu. You now have a cube with truncated corners for holon 2, and it is iterated into a
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line of overlapping cubes by holon 1.
Select holon 1 by clicking inside the large holon in the Holon window.
Drag holon 1 around in the Holon window, stopping to notice how the position affects the direction and
spacing of the iteration in the preview. (If you accidentally select holon 2, just click near holon 1 again to
select it.)
Drag it back near the center (the point where the X, Y and Z axis meet is called the origin, and has position
0,0,0.) You can set it exactly by clicking in the X Position control, pressing the spacebar (or the z key) to
zero it, pressing Tab or clicking in the Y Position control and pressing the spacebar, etc.
Adjust the Z Rotation control gradually. Rotating an iterator holon around the Z axis makes a spiral around
the Z axis. Notice how the spiral changes with the angle.
Increase the X Scale to 93. Click the Sync Scales button
to conveniently set the three scales equally.
At 93% the spiral is much fuller. Adjust the Z Rotation control again to see how it looks at different angles.

For more variation, you could select holon 2, check Reorient for the Cube metamorph, and experiment with holon
2's rotation controls. The orientation of the cube is affected throughout the spiral, without affecting the spiral
position. Then drag holon 2 around in the Holon window and see how it does change the spiral arrangement.
Two iterators
With two or more iterators, each iterator affects each other's shape. The iterator with the largest scales has most
effect on the overall shape. Smaller iterators modify the detail that is repeated within the shape.
1.

Click the File New button

in the Standard toolbar.

2.
3.

Increase the X Scale to 95. Click the Sync Scales button
to set the scales equally.
Right-click in the Holon window near the right end of the X axis (the horizontal red line), and choose 'Holon'
from the menu.

4.
5.
6.

Adjust the X Scale to 40. Click the Sync Scales button
to set the scales equally.
Select holon 1.
Set the Z Rotation to 20. It makes a spiral but it is flat and too dense to see any detail. We could make it 3D
by adjusting one of the Z Positions, but it is more interesting to vary the angle of holon 2.
7. Select holon 2.
8. Experiment with all three rotation controls. Take your time to see some of the variety of spiral shapes.
9. Select holon 1.
10. Experiment with the Z Rotation. Optionally repeat steps 7 to 10.

As you can see, 3D spirals allow a lot of variety. A non-zero value of Z Position for the large holon will move the
center point towards or away from you. Rotations of the small holon provide most of the variety in the detail.
Suggested exercise: spirals with more than one constructor. Starting from new, right-click somewhere in the
Holon window and choose Sphere from the menu. Right-click somewhere else and choose a different constructor,
and again with a third shape. Then select holon 1 and adjust the scales and the Z Rotation for a suitable spiral.
Drag the three constructor holons around to make different arrangements. You may need to reduce the constructor
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metamorph scales.

2.8 A spiral shell
This spiral shell made from two iterators
is an example of a 3D fractal resembling
a natural object. To make the finished
object we will use the shape, view, color,
shadow and lighting controls.

Unless you just started XenoDream, click the File New button

in the Standard toolbar to start from scratch.

Making the shape
1.
2.

Click the Shape tab to go to the Shape page. The holon parameter controls are in three columns headed X, Y
and Z.
Adjust the X Scale parameter to 95.

3.
4.

Click the Sync Scales button
to make the scales equal.
Adjust the Z Rotation to 30. This will be a good start for a spiral, so we will add another holon and see how it
looks.
5. Click the Add Holon button in the Holon toolbar to add a new holon. A second holon appears in the Holon
window and is yellow to show it is now the active holon.
6. Adjust the X Position to 100. Instead of a spiral we have a mess, because the scales are too big.
7. Adjust the X and Y Scales to 40, and Z Scale to 30. Now it's better defined but still flat.
8. Select holon 1 using the Active Holon control.
9. Adjust the Z Position to 7. Now the spiral is in 3D with the center nearest to the camera, and holon 2 needs
some rotation.
10. Select holon 2.
11. Adjust the Y Rotation to 330 and the Z Rotation to 180.
12. Check the Optimize option, and notice that the preview fills in faster, so leave it checked.
Now it should look like a spiral shell:

Changing the view
Now we want to rotate the shell to a different viewing angle. There are three ways you can do this: dragging the
Camera Rotate icons; adjusting the Rotate By increment and clicking the rotate buttons, or adjusting the Angles
controls. We will use the Angles controls.
1.

Click the View tab to go to the View page.
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2. There are three controls under the Angles label. Set X to 348, Y to 335 and Z to 340.
3. Adjust the X Position to -0.10 to center the shell horizontally.
4. Adjust the Y Position to -0.12 to center it vertically.
The shell should now look like this:

Coloring the shell
The shell does not use constructor metamorphs, so we can use Holon Sequence coloring to provide fine details,
and Parametric Gradients so we can randomize both holon gradients together. In this case we want both holons to
have the same coloring, so we need to keep the same Initial Color.
1.
2.

Click the Color tab to go to the Color page.
Set the Method to Holon Sequence if it isn't already.

3.
4.

Click the Select All button
in the Holon toolbar to select both holons.
In the Map To dropdown box, choose Parametric Gradient.

5.

Click the Edit Gradient button
to open the Parametric Gradient Editor window. Drag it to a convenient
position, which will depend on your screen resolution, making sure you can see the Color Memory Spots
(the grid of cream squares) on the Color page.

6.

In the Parametric Gradient Editor, click the Randomize Global Pattern button (lower

).

7.

Ctrl-click the Randomize Gradients button (uppermost
) to randomize only the Holon Modifiers, and
wait a few seconds to see how the preview looks. (If you click this button instead of Ctrl-clicking, it will
randomize the Initial Colors and give the two holons different colors - not what we want.)
8. Repeat steps 6 and 7 in any order until you get some interesting coloring. You could adjust the Gain or other
controls to vary the pattern.
9. To increase color variation around the spiral, adjust the Blend control up or down (leave Blender set to 1).
10. Click on one of the Color Memory Spots to temporarily save the color scheme. It turns blue to show that it's

in use.
11. Repeat steps 8 to 10 until you have several color schemes saved.
12. Now click on each of the blue memory spots in turn to compare the color schemes, and choose one.
Here's an example:
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Rendering the shell
The first step is to select which shadows we might want.
1. Click the Rendering tab to go to the Rendering page.
2.

3.
4.

In the Shadows panel on the left, click the Lighting/Shadow Presets button
. The Lighting/Shadow
Presets window shows all the lighting presets, with pictures of the light positions. The lights have black stalks
if a shadow is enabled in the preset, or white if not. Select the '1.6 Basic' category and click the 'Soft with
shadows' preset. Click OK to close the dialog.
To start the render, click the Render New button in the Render toolbar at the top of the Main window.
The Picture window appears and you should see the object filling in. It only shows flat colors, because depth
and lighting haven't been incorporated yet.

Lighting the shell
1.
2.

Click the Lighting button in the Picture window toolbar to open the Lighting window.
Scroll the Lighting Preview to show an interesting part of the shell.

3.
4.

Click the Lighting Presets button
to open the Lighting Preset window.
In the Category list click '1.6 Basic', and in the Preset list click some of the presets to see how they look in
the preview.
Select 'Soft with shadows' in the preset list. This is the one we chose earlier, and the extra shadows give the
shape more depth.
Click the OK button to close the Lighting Preset window.
You can scroll the preview to see the picture update as it renders. By the time the Picture window render rate
falls to about 600, the Preview should look complete and finely detailed. Click the Stop button at the bottom
of the Lighting window. The caption changes to Apply.
Click the Apply button to apply the lighting to the shell.

5.
6.
7.

8.

2.9 Kaleidoscopes and vases
When an iterator has all scales
100, each iteration is the same
size, and any rotation will spread
copies around a circle. A small
number of copies results in
kaleidoscope-like objects, while
a large number of copies can
make objects with cylindrical
symmetry like bowls, vases or
lamp shades.

Making a kaleidoscope
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Real kaleidoscopes use reflection rather than pure rotation, but it's a convenient name for these shapes. We will
use Z Rotation of 45 degrees, to create eightfold symmetry.
1.

Click the File New button
Shape tab.

2.
3.
4.

Set the X Scale to 100. Click the Sync Scales button
to set the scales equally.
Set the Z Rotation to 45.
Right-click in the Holon window near the end of the red line (X axis) and choose 'Holon' from the menu.

5.
6.

Set the X Scale to 35 and click the Sync Scales button
.
Right-click in the Holon window near the middle of the green line (Y axis) and choose 'Sphere > Sphere' from
the popup menu.
Reduce the Sphere metamorph's Scale to about 1.0 to make it smaller.

7.

in the Standard toolbar. If you're not already on the Shape page, click the

8.

Set the X Scale to 25 and click the Sync Scales button
. This has no effect on the size (because
Rescale is not checked) but helps balance the density and speed up the preview and rendering.
9. Right-click in the Holon window half way to the top right corner and choose 'Cone > Shell' from the menu.
10. Set the Cone metamorph's Scale to about -2.0.
11. Set the X Scale to 25 and click the Sync Scales button
. Again this is to balance density.
12. Now experiment with the rotations of holon 2, and the positions of all three small holons. You can drag the
holons around in the holon window after making sure the Drag Mode is set to Position.
13. For additional experiments, add more or different constructor holons, or add second metamorphs to them.
Note: if you use Metamorph coloring for kaleidoscopes, best results usually come from setting the large holon with
both Inherit Color checked and Map From set to Inherit All, so it replicates the coloring of the smaller holons.
You can also do this for any other iterator holons.
Vases and other shapes
For kaleidoscopes it is convenient to rotate around Z and use the default view, although you can view them from
other angles. For vases and other shapes it is convenient to rotate around Y and either use the default view or an
oblique angle. The Y Rotation for the large iterator holon (the one with all scales 100) may be an angle such as 28
that creates 90 copies, or it may be an angle that doesn't divide evenly and smears the copies into a continuous
ring.
The small holons may be constructors, to build the main shape or for embellishment, or they may be iterators.
Iterators that are long and thin or flat are most useful. It is a matter of rotating, scaling and positioning them
interactively. Constructors provide more control and smooth surfaces, while iterators may produce interesting
surface textures.
Some examples in the Data\Artificial folder that you can experiment with are: 'Urn', 'Lampshade slatted alight',
'Teacup', 'Wastebasket', 'Curlers', 'Anemobolic'. (Note: 'Teacup' uses a Free holon for the handle. 'Lampshade
slatted alight' uses two regions to allow the center holon to be lit with plenty of glow.)
Many shapes in these categories work well with transparency. See Transparent preview and rendering
examples and hints.
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2.10 Iteration controls
The Shape page has a group of controls for limiting iterations of holons. The
Max Iteration control applies to each holon independently. For an iterator, it
sets the number of iterations of the holon. For a constructor, it sets the
number of copies allowed by any combination of iterators.
The other two controls are for Exclusive Iteration, and are not set per holon.
They limit the total number of iterations of holons other than the specified
Exclusive Holon.
You probably won't use these controls often, but they can be very useful in some circumstances. The Max
Iteration control is most useful for constructors and large iterators, but rarely useful for small iterators because
they only have a few visible iterations anyway.
Exclusive iteration is useful for reducing clutter by eliminating small iterations where several iterators are involved.
Setting Max Iteration for each iterator would not stop combinations of iterators from producing a lot of detail. This
tutorial shows the effects, and the next topic discusses using it for making trees.
Using Exclusive Iteration
1.
2.
3.
4.
5.

If you're not already on the Shape page, click the Shape tab.
In the File menu choose Starter Shapes... and select 'Octahedron 1' from the list.
In the Iteration panel, set the Exclusive Holon control (labeled 'Exc hol') to 1.
Set Exclusive Maximum ('Ex max') to 1 and observe the effect.
Increase Ex Max to each value up to 6 and observe the results. Values from 1 to 4 are shown below.

Now we will try it with a constructor.
1.
2.
3.
4.

Click the Metamorphs button to enable metamorphs.
Click the first Style button, and select '.Torus' from the Constructor category.
Set the first metamorph's Amount to 4, Scale to 9, and check Reposition.
Try each value of Ex Max from 1 to 5. The first four are shown below.

5.
6.

Set the Ex Max control to 2.
Try each value of the Exc Hol control from 2 to 6, to see how it looks when different holons are exclusive.

Note: The results in step 4 are the same as using Max Iteration for the constructor holon. The results with the
exclusive holon set to iterators can only be obtained with exclusive iteration.

2.11 Trees
A variety of trees and plants may be made using just a few holons. Usually the largest holon iterates vertically to
make the main repeating structure, and at least one holon is rotated outwards to make a branch. If the main holon
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is rotated around the Y axis, the branches are distributed in a spiral up the trunk. There are two ways to make a
trunk. One way uses one or more iterator holons, with X and Z scales very small to squash the holon into a trunk
shape. The other uses a constructor holon, typically a cylinder or cone shape. It is only necessary to make the
lower part of the trunk, as the other holons iterate it upwards into a complete trunk and outwards into branches.
There are some sample files in the Data\Organic\Trees folder. It is usually easier to start from a file and modify it
because some of the rotations and positioning can take some adjustment to get right. Here are some that use
only iterators, and no metamorphs.

Fir 3

Oak 1

Sapling 1

Next we use a constructor for the trunk. Some of the samples use a
metamorph to bend or spiral either the trunk constructor or the branch
iterators.
The foliage is not a separate construction, it is just the effect of small
branches, with the coloring changed by using Inherit Color with a
small Inherit Count for the iterator holons.
We can use the iteration controls to limit the branch density. Using Max
Iteration on the branches reduces self-branching close to the trunk.
Using Exclusive Iteration on the vertical iterator holon limits the fine
branching all over the tree. (Using Max Iteration on the trunk
constructor gives the same result.) This can be used to thin the leaves,
or prevent them altogether for a deciduous or dead tree. It can simplify
trees even further, as in the cactus example below.

Eucalypt 1
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Cactus 1

You can use more than one constructor to make a trunk section, or a constructor with a tile, and different shapes
to make alien or fantasy trees. The more recently added .Conic and .Shaft3 constructors are generally more
convenient than .Prism. Some useful metamorphs for warping trees are Spiral, Waver, Shifty, Shearyx/Shearyz
and Fbm3d.
Another option is using the Spiralin or Spiralout tile metamorphs to do some of the iteration, as in the OrnamentalPalm samples.

2.12 Free holons and hidden holons
The Holon toolbar has buttons to set the status of holons to Free or Hidden. This serves a variety of purposes. In
this topic we will explore the basics. First the definitions:
A Hidden holon is invisible but contributes to the object if it is inherited by other holons.
A Free holon inherits all the holons that are not Free, but is not inherited by any holons. In other words, it makes
copies of the parent shape that may be independently modified.
A holon that is both Free and Hidden has no direct effect on the object, but has important uses. First, it is a
convenient way to temporarily disable a holon. Second, its parameters can be used indirectly by several other
features (extended holons 45 , coloring with the Other holon option, background creation mode 93 .)
There is also a button to Hide Parent Shape, for when you only want to see modified copies of it.
Now let's see them in action.
1.
2.
3.
4.
5.
6.
7.
8.
9.

In the File menu, choose Starter Shapes... and select 'Octahedron 1' from the list. Click OK to close the
dialog.
Reduce Object Size in the Holon toolbar to 33.
Click the Add Holon button in the Holon toolbar.
Set the holon's X Position to -110 and Y Position to 80.
Click the Free Holon button
in the Holon toolbar. Now instead of extruding the octahedron, the holon is
a smaller copy of it.
Click the Clone Holons button in the Holon toolbar. The new holon is also free.
Set the holon's X Position to 110 and Y Position to -80.
Click the Clone Holons button in the Holon toolbar. This holon is free too.
Set the holon's X Position to -100 and Y Position to -75.

10. Set the X Scale to 60 and click the Sync Scales button

. We now have a central parent shape with three
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free holons around it, as illustrated below.
11. Click the Metamorphs button to enable metamorphs.
12. Click the first Style button, and select '.Cube' from the Constructor category.
13. Set the first metamorph's Scale to 2.0. Because this holon is free, the cube is not inherited by the other
holons.
14. Release the Free Holon button

to see what happens when it is part of the parent shape.

The preview after step 10, after step 13, and after step 14.

15. Click the Free Holon button
16. Select holon 6.

again to make it Free.

17. Click the Hide Holon button
in the Holon toolbar. Holon 6 is now invisible but still an important part of
the parent shape. The hidden status is inherited by the free holons, as illustrated below.
18. Click the Free Holon button

. Now holon 6 is both free and hidden, and has no effect at all.

19. Release the Free Holon button. Click the Hide Parent Shape button
while the free holons are unchanged.
The preview after step 17, after step 18, and after step 19.

. The parent shape disappears
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You may want to experiment with other combinations of Free and Hide with these holons. Also notice that when
you move the mouse in the Holon window, the mouse-over hint (tooltip) shows the nearest holon's number,
followed by 'f' or 'h' to show whether it is free or hidden.

2.13 Extending holons for extra metamorphs
Holons can only have two metamorphs each, and sometimes you want more. You can achieve this by extending a
holon to use another holon's parameters and metamorphs. You could think of it as chaining two holons together,
but it's more like borrowing the second holon in addition to its usual operation. Having holons do two different
things makes for confusion and difficult adjustment (as if they weren't confusing enough already), so we strongly
recommend using Free Hidden holons as extenders, so they're inactive as ordinary holons.
In this exercise we will use a free hidden holon to extend the first holon with two extra metamorphs. Then we will
use another method to allow two more.
Extending a holon
1.
2.
3.
4.
5.
6.
7.
8.
9.

Click the File New button
in the Standard toolbar. If you're not already on the Shape page, click the
Shape tab.
Click the first Style button, and select '.Cube' from the Constructor category.
Set the first metamorph's Scale to 8.
Click the second Style button, and select 'Gridcub' from the Grid/block category.
Set the second metamorph's Amount to 50. The cube should now be a cage with thick bars.
Click the Add Holon button in the Holon toolbar to add a new holon.
Click the Free Holon button
and the Hide Holon button
in the Holon toolbar.
Select holon 1.
In the Extend panel in the Shape page, set the Holon control to 2. Now holon 1 is extended by holon 2, and
is smaller because holon 2's Scales are at 80.
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10. Select holon 2.
11. Ctrl-click the Sync Scales button
to set all scales to 100. This restores it to full size. Now we can add
metamorphs.
12. Click the first Style button, and select 'Gridcub' from the Grid/block category.
13. Set the first metamorph's Amount to 50 and Scale to 60. The cage should now be made of mesh.
14. Click the second Style button, and select 'Warp' from the Warp category.
15. Set the second metamorph's Amount to 100 and Scale to 60. You should now have this shape:

We used four metamorphs to make this object. What if we wanted to use more? We can't extend an extender to
get another two metamorphs (it's theoretically possible, but not implemented). However, we can use a free holon to
add metamorphs, and hide the parent shape. Let's do that now.
1.

Click the Add Holon button in the Holon toolbar.

2.

Click the Free Holon button

3.
4.
5.

Ctrl-click the Sync Scales button
. This restores it to full size.
Click the first Style button and select 'Holesz' from the Grid/block category.
Set the first metamorph's Amount to 70 and Scale to 3.

, and the Hide Parent Shape button

. Now we have a smaller copy.

We could add a second metamorph, and if we needed more we could extend this holon with another one.
Extending holons is recommended in general because it's more flexible than using a free holon and hiding the
parent shape, and also renders faster.
Any holon may be extended by any other holon.
More than one holon may share the same extender.

Creating Objects

47

However, sometimes hiding the parent shape is the only way to get what you want, especially when the parent
shape involves more than one holon.

2.14 Displacement mapping
Displacement mapping is just a way to get a greater variety of displacement patterns than metamorphs alone can
provide. It uses both the metamorph shapes and meta patterns (normally used for coloring) of an extended holon to
distort the holon, either radially or in one direction. It is a good choice for making planets or moons, as well as
unusual shapes. However, it can be a challenge to remember which holon is affecting shape and which is
controlling color, so we recommend that you are comfortable with metamorphs, coloring and extended holons
before trying this. It can also be slow to preview and render.
The Data\Single\Displacers folder has sample files of displacer holons that can be used as presets, by appending
them to the current object and setting one or more holons to use it. Unfortunately you can't preview the
displacement from the File Append dialog. We will start with one of the samples and experiment with other
metamorphs.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.

Click the File New button
in the Standard toolbar. If you're not already on the Shape page, click the
Shape tab.
Click the first Style button, and select '.Sphere' from the Constructor category in the Metamorph Styles
window.
Click the Color tab to go to the Color page.
Set the Color Method to Metamorph, if it isn't already.
Set the first Meta Pattern control to 0. It is easier to see the shape without any coloring to begin with.
Click the Shape tab to go to the Shape page.
In the File menu, choose Append... and in the File Open dialog, navigate to the Data\Single\Displacers
folder.
Select the file 'Spinrivets.xep' and click OK to close the dialog. Note that holon 2 is already free and hidden
because it was saved for this purpose, but it doesn't do anything until the first holon is extended.
Select holon 1.
In the Extend panel in the Shape page, set the Holon control to 2, and set the Extension Mode dropdown
box to the Disp radial option. Now the displacement will show in the preview.
Select holon 2. This pattern is made with a single metamorph, 'Spinz'.
Reduce the first metamorph's Scale to 10, to make the pattern easier to see. The result is shown in the first
picture below.
Go to the Color page. The Meta Pattern and Curve controls of holon 2 are part of the displacement pattern.
Only the third Meta Pattern is being used for this shape.
Set the third Curve to 'Linr'.
Check the Wrap option. In Displacement mode only, this allows unlimited displacement instead of bouncing
the values within a range. The result is the second picture below.
Set the third Curve to 'Cos'. The result is the third picture below.
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Curve = Rippl

Curve = Linr, Wrap checked

Curve = Cos, Wrap checked

Next we try with the Vororad metamorph for the displacement.
1.
2.
3.
4.
5.

Go to the Shape page.
In the Metamorph Style list, select the Noise category and the 'Vororad' metamorph.
Set the first metamorph's Amount to 10, Scale to 2 and Special to 0.
Go to the Color page.
Set the first Meta Pattern to 6, the third Meta Pattern to 0 and the third Curve to Linr. (Leave Wrap
checked.)
6. Set the first Curve to Cos. The result is the first picture below.
7. Set the first Curve to Sinst. The result is the second picture below.
8. Set the first Curve to Step, and uncheck Wrap.
9. Go to the Shape page.
10. Set the first metamorph's Scale to -2, to make rounded instead of angular patterns. The result is the third
picture below.

Curve = Cos

Curve = Sinst, Wrap checked

Curve = Step

Next we try coloring.
1.
2.
3.
4.

Go to the Color page.
Set the first Curve to Cup, to make a cratered shape.
Select holon 1. These color controls affect the coloring, not the displacement.
Set the first Meta Pattern to 3.

5.

Click the Gradient Presets button
, choose the 'Basic plain' category and select the 'Cream apricot hues'
preset. Click OK to close the presets. The pattern comes from the sphere constructor. It is shown in the first
picture below.
Go to the Shape page.
In the Extend panel, check the Color option. This lets holon 1 use the displacer holon's patterns, and control

6.
7.
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them using holon 1's color settings. The result is the second picture below. This is usually the better choice.

Coloring from holon 1

Coloring from holon 2

Here are some more tips for displacement mapping.
You can use any metamorphs for the displacer holon except the ones in the Constructor and Tile categories,
because those just create random noise.
If you only use one metamorph, its Amount controls the displacement. If you use two, the first metamorph's
Amount controls how much it distorts the second metamorph, and the second metamorph's Amount controls
the displacement.
Besides spheres, you can use radial displacement mapping on cubes or other constructors. It may be less
useful with some shapes such as a torus because the displacement is radial from the center of the holon, not
perpendicular to the surface of the constructor. It can also be used on iterators but is less likely to be useful
than with the smooth surfaces of constructors.
The Disp X, Disp Y and Disp Z options are ideal for displacing the corresponding plane constructors, and can
also be used with others.
The Data\Space folder includes some examples of planets. 'Mars' and 'Earth like planet' are just spheres with
Fbmrad metamorphs for coloring, while others use displacement mapping to increase the possibilities for the
shape.

'Mars'

'Earth like planet'

'Volcanic m oon'

'Crater lake w orld'

2.15 Align Cyclic
The Align Cyclic button on the Shape page opens a dialog that uses waveforms to arrange any of the holon
parameters. The obvious use is for arranging holon positions in a circle or other geometric shapes. You can also
distribute the scales, rotations or skews, and make quite complex patterns. The default settings arrange the X and
Y positions in a circle.
There are two ways to use it:
In the first, you select the holons that you want to arrange before opening the dialog.
In the second, you don't select any holons, but set the active holon's parameters and metamorphs as you want,
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then open the dialog and choose how many copies of the holon to add, and arrange them using the waveforms.
In this topic we will take the second approach, with a constructor.
Setting up the holon
1.

Click the File New button
Shape tab.

in the Standard toolbar. If you're not already on the Shape page, click the

2. Set the X Scale to 20, and click the Sync Scales button
.
3. Click the first Style button, and select '.Gearwhl' from the Constructor category.
4. Set the first metamorph's Amount to -10, Scale to -1, and Special to 6.
5. Check Reorient for the first metamorph.
Note: we would also check Rescale if we were going to vary the scales in Align Cyclic.
Replicating in circles
1.

2.
3.
4.
5.
6.
7.

Click the Align Cyclic button
on the Shape page. The Align Cyclic dialog opens, with Align set to
Position and the X and Y Curve set to Cos and Sine respectively. (Cos and Sine will combine to make a
circle. You can also make a circle using Cos and Cos or Sine and Sine with a phase difference of 90 or 270
degrees.)
Set the Add Holons control to 15. This will give a total of 16 holons but they are all at the same position.
Set the X Range to 180 and the Y Range to 180. Now you should see the holons arranged in a circle. Next
we will rotate them to face inwards.
Set the Align dropdown box to Rotation. Each Align option has its own set of controls so you can set them
independently and switch back and forth.
Set the X Curve to Saw and the X Center to 90.0. This rotates all the holons to point down. (They all have
the same direction because we left X Range at 0.)
Set the Z Curve to Saw and the Z Range to 360. This rotates them around the circle, but they are facing the
wrong way.
Set the Z Center to 90. Now they all face inwards.

A more complicated pattern
1.
2.

Set the X Center, Z Center and Z Range to 0.
Set the Align dropdown box to Position.

Creating Objects
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4.
5.
6.
7.
8.

Set
Set
Set
Set
Set
Set

Add Holons to 47.
Y Cycles to 3.0
Z Curve to Cos, Z Cycles to 2.0 and Z Range to 180. You should see the first result below.
the Align dropdown box to Rotation.
X Curve to Cos, X Cycles to 2.0 and X Range to 360.
Y Curve to Sine and Y Range to 360. You should see the second result below.

2.16 Cubic symmetries
This chapter describes various ways to make interesting objects with cubic symmetries.
Variations of the Menger Sponge
This type of symmetry is created by using holons for every
position; 20 in this case.
There are many things you can do with the Menger Sponge
starter shape. One is to apply metamorphs to some or all of the
holons to warp them, while retaining the basic character.
Another is to use constructors for either all the corner holons, or
all the edge holons. The Menger Sponge v2 starter includes
selection memory spots with some useful holon selections to
make it even easier. The Menger Cycoil sample file in the
Geometric folder is shown here.

Using six-fold symmetry to replicate a shape for each face
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This approach allows any shape to be used for the faces of a
cube (as long as it doesn't use any Free holons). There are two
ways to do it. The first is more flexible; the second is simpler.
First method
1. Make the shape for one of the faces, using any number of
holons and metamorphs. Don't use any Free holons.
2. Add five Free holons, with the Scales set to 100, and rotate
and position each one to make the other faces of the cube.
Second method
1. Make the shape for the top face. It should be oriented around
the Y axis, centered at the origin.
2. Add a free holon and hide the parent shape.
3. Set the first metamorph to Tilestar, with Scale negative and
Special 0, and adjust Amount for the size of the faces.

Lipstick Stack sample file

The Geometric\Lipstick Stack sample file uses the second
method.
24-fold symmetry using two holons for rotation
This configuration starts with two holons that iterate any other
holons into 24 positions arranged in a cube.
1.

Start with two holons with all Scales set to 100. Set one
with X Rotation 90, and the other with Y Rotation 90.
2. Add small holons, either constructors or iterators, that will
be replicated into each face, edge or corner.
To put them into a corner, set each of the three positions to
either 100 or -100.
To put them into an edge, set two of the positions to either
100 or -100.
To put them into a face, set one of the positions to either 100
or -100.
The Cubenoid, Glisstron and Springdriventhing sample files in
the Geometric folder use this method. You can also position
holons inside or outside the cube.
Glisstron sample file
24-fold symmetry using the Cubsym tile metamorphs
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The Cubsym1 and Cubsym2 metamorphs make 24 copies of the
holon in cubic symmetry. The only difference between them is
that Cubsym1 has reflective symmetry within a face, while
Cubsym2 has rotational symmetry. You can apply them
individually to holons, or use a separate holon and extend any
number of other holons. Alternatively, you could apply one to a
free holon and hide the parent shape.
Some arrangements require Reposition to be unchecked and the
holon position adjusted.
The Strongbox sample uses two holons; .Cubernd with Cubsym1,
and .Pipe with Cubsym2.

2.17 Fractal metamorphs
Fractal structures in XenoDream generally arise from two or more iterator holons interacting. Using Fractal
metamorphs, you can make a single iterator holon into a fractal. The available types are different from what you
can make just by combining holons.
How they work: most Fractal metamorph formulas choose at each iteration between two or more
transformations that define the fractal attractor (rather like including a special set of holons inside the
metamorph). Some choose randomly, while others (the names with a T suffix) work through all the
permutations like exploring branches of a tree. This topic introduces some that choose randomly.
Julia fractals
A Julia set is the result of iterating complex numbers in the complex plane (or a higher dimensional complex
space). XenoDream works in real 3D space, but by using complex arithmetic in the metamorph formulas we can
pretend that the Y or Z axis is for imaginary numbers, or mix real and complex metamorphs together.
The Julia2z metamorph makes a 2D Julia set in the XY plane.
1. Starting with a single holon, set all scales to 100.
2. Set the style to Julia2z in the Fractal category, and set Amount
to 100.
3. Adjust the Scale and Special parameters to make a variety of
Julia set attractors.
By itself, this isn't very interesting. If you are used to seeing colorful
Julia fractals, those are produced with a different rendering method,
based on escaping from the attractor. XenoDream doesn't work that
way, but iterates towards the attractor instead and plots every point
on the way. This is very useful when we add more holons, especially
constructors.
Am ount 100, Scale 10, Special 40
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Setting Scale and Special to 0 makes the Julia set into a circle.
When a constructor holon is added, it is iterated into patterns that
can resemble the Circle Limit series of art by M.C. Escher. The
Juliatworings sample (shown at right) uses two torus constructors.
As you adjust size and position of constructors, you will find that
sometimes they get warped into large areas that take a long time to
render, and can have holes that never fill in. You can adjust the
constructors to minimize or avoid the effect, or accept it and perhaps
use other holons to hide some of it. Balancing holon densities helps
reduce render time, but cannot eliminate the problem. The chaos
render method is not optimal for these fractals.

An oblique camera view of circular Julia fractals reveals even more
potential. The "Escherpods 1" sample file (shown at right) uses a
variety of constructors. As the Julia holon is an iterator, it is set to
inherit all coloring from the constructors.
The Julia2y metamorph is the same as Julia2z but oriented around
the Y axis. Which one to use is in many cases just a matter of
convenience, depending on which holons need rotation.
You can also add iterator holons to these structures. The "Julia's
Pizza" sample file uses only iterators.
Other things to do are moving holons outside the circle, and using
different values for Scale and Special for other Julia sets. The sample
file "Kandinsky Set" is an example of this.
The Julia holon can also be rotated. The "Juliassic Net"
sample file (shown here) has Y Rotation 90 and a
higher value for Amount. It has only one constructor (a
large thin torus). It is often worth hiding large
constructors so that only the iterated copies are visible.

Quaternion fractals
The Quat2 metamorph by itself can make pure quaternions. With some combinations (eg Amount >10) a small X
Rotation may be needed to push it into 3D. As with the 2D Julia fractals, adding one or more constructors is
useful. Quaternions have their own character and are less versatile than the other Julias.
The Apollonian gasket
The Apolloz metamorph makes the Apollonian gasket fractal when applied to an iterator holon with all Scales 100
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and all other parameters 0. The only metamorph parameter that has any effect is the Apolloz Scale control, which
sets the overall size. You can add constructors to the fractal, but the size and position is critical to getting a nice
shape, and the difference between a slow render and an extremely slow render.
The Gumowski-Mira attractor
This attractor has a chaotic circular orbit that usually
increases slowly outwards without limit. The Gumomira
metamorph makes the attractor when its Amount is set
near 100, and applied to an iterator holon with all Scales
100. As with the Julia metamorphs, one way to use it is to
add constructors (optionally with Max Iterations set.) When
used by itself, the attractor hits many pixels just once,
which is not helpful for either 3D lighting or transparent
renders. However, we can make it revisit pixels by adding a
second holon with a Tile metamorph set to make a grid of
tiny points, and use transparent rendering. Giving the
points a small size blurs the pixels slightly for a smoother
result. The "Gumomira Cream" sample file shows how and
is a good starting point.

2.18 Fractal metamorphs 2
This topic explores the fractal metamorphs with a T suffix. (The T stands for Tree, because they use an internal
tree structure to iterate through the combinations of transformations that make the attractor.) This method allows
far more detail than choosing randomly, and makes it worth exploring a wider variety of formulas.
Note: these metamorphs generally need to be used on an iterator holon with scales 100 to work efficiently. It is
also possible to use them as the second metamorph of a constructor, to warp the shape. When working with
purely 2D fractals, it's easiest to see them with Shaded Preview off.
2D Julia formulas with variable power
The JulianT metamorph is the basic Julia fractal with formula z^n+c (where z means a 2D complex number, not the
Z axis). Amount is the power n multiplied by 10. Setting Amount to 20 gives power 2, the same as Julia2z but with
negative values of Scale and Special. (Julia2z uses z^2-c, because the programmer wasn't paying enough
attention to standardizing with the rest of the universe.) If you're not at all mathematical you can ignore the
formulas. Amount controls the rotational symmetry; 20 or -20 gives two rotations in a circle, 30 or -30 gives three,
and so on.
JulianyT is the same as JulianT but oriented around the Y axis. The others in this group are JuliconT, JulianneT,
JulienneT and JuliniumT. They use different formulas, but all have Amount setting the power. Amount needs to be
greater than 10 or less than -10 for them to converge.
You may notice that these metamorphs don't fill in evenly. Different spirals fill in at different times as the tree
iterates through its branches. The inner parts of tight spirals are usually the last to fill in, and often take several
stages as the tree resolution is increased. The consequences are discussed further below.
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JulianT 20, -36.5, 8.2

JulianT -20, -31.5, 18.5

JuliconT 20, 18, 0

JulianneT 20, 65.4, 5.8

The need for a seed
Fractals with internal trees start from a seed point, which defaults to 0,0,0 unless it is inheriting from other holons.
But if the seed point is not on the attractor, it will generate sequences of stray points that converge to the
attractor. To eliminate these, you can use the Seed metamorph to set the seed point. The Seed metamorph can
be put anywhere, either on the same holon or another holon (a free hidden holon is also a good place for it,
because it is only used in initializing and not during the render.) Adjust the Amount, Scale (and Special for 3D
fractals) to put the seed point somewhere on the fractal. It's usually a matter of experiment to move the stray
points towards the attractor (and easiest to see with Shaded Preview off.)
When using a Julia metamorph with power less than 2 (Amount between -20 and 20), the seed point can become
a major factor in the shape, and some settings need a seed in a particular area to get anything worthwhile. Powers
less than 1.8 often need careful adjustment of the seed. For example, JulianT 15, -10, 0 (also known as the Glynn
set) doesn't show the attractor if the Seed has Amount greater than -6.1. At -6.1 the result is clean, but more
negative values cause stray points to mess up the attractor. The next two pictures show a zoom into the fractal
with the seed at -6.1, 0, 0 and -20, 0, 0 respectively.

The fractional powers between 1 and 2 (positive or negative) can be rewarding to explore, with the extra challenge
of adjusting the seed to find and stabilize the attractor.
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JulianneT -11, -50.2, 0; Seed -4.3, 0, 0

For pure 2D fractals the simplest way to render is at a large size with 100% opacity, and resample afterwards for
antialiasing. Three or more times the final size is best. If you render in plain white, it's easy to invert the color
afterwards if you prefer black on white. It can also work to use low opacity, although the density can be uneven so
the gamma can usually be increased in lighting, typically with some variation of "Ambient only" lighting. The
JulianneT example above needs transparent preview and a low opacity render to see the intricacy.
2D Julia quadratic and cubic rational formulas
These metamorphs have formulas with one complex polynomial divided by another, with the maximum power either
2 or 3. The quadratic rationals have maximum power 2, and are named JasmaicaT, JasmineT, JasonT, JasperT,
JassicT and JasticeT. The cubic rationals have maximum power 3, and are named JackalT, JackarooT, JackboxT,
JackdawT, JackieT, JackoT, JacobT, JacuzaT and JacuzziT. The formulas include a real constant a set by Amount
and a complex constant c set by Scale and Special.

JackalT 0, -19.8, 0.058; Seed 4, 0, 0

JacuzaT -18, -33.5, 0
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JacobT -30, 44, 23

JackoT 0.2, -0.2, -0.5; Seed 2, 0, 0

Making 2D into 3D
There are various ways to make 2D Julia formulas into 3D shapes. You can rotate the holon in X and/or Y, which
can take some experimenting to find a clean shape. You can add other holons, either constructors or iterators.
When using constructors, their scales or density are important. If too high, the first few iterations get filled in well
but the higher ones don't. If too low, the first iterations won't get filled in very well. The problem of constructors near
repeller points or anywhere where they get hugely expanded is worse with tree metamorphs because the filling can
be uneven. For best rendering, arrange constructors to avoid or minimize the expansion zones. In the "Julianne
Toricurls" example below, the torus was moved to the right of center to avoid an expansion zone in the center.
Limiting the Max Iterations for constructors is also useful for making simpler shapes.

"Julianne Toricurls"

JacobT w ith tw o Screw hd constructors

3D Julia formulas in spherical coordinates (Triplex metamorphs)
A formula for a 3D Mandelbrot set in spherical coordinates, dubbed the Mandelbulb, was developed in 2009 by
Paul Nylander and Daniel White and rapidly became popular. Julia sets with these "triplex numbers" have been
implemented as metamorphs with tree iteration. The constant c has parameters for X, Y and Z, so there are
separate metamorphs with various powers. For example, the Triplex2T style has power 2. The Tripco styles are
variations with different symmetry. Two other versions have variable power (TripcoveT and TripsivaT), and can be
dependent on the position of either a Seed metamorph or any constructor holons.
These metamorphs are often slow to render, depending on the parameters. Some combinations are very slow and
take a while for the preview to get an update. This happens when the tree has to iterate to a greater depth to reach
convergence. If the object makes rapid progress after several seconds in limbo, it may render well enough, but if it
never seems to get going then you will probably not want to render with those parameters. (This is also true for 2D
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Julia fractals that are rotated into 3D.) Adding constructors works well with these metamorphs, especially with
Max Iteration set to low values.

Tripco2T -40, 0, -6

Triplex4T -50, 0, 0 w ith Torus, Max Iter 2

TripsivaT 15, -10, 0; Seed -5, 0, -5

TripcoveT 65, -16, 0; Seed -6, 0, 0

Quaternion Julia sets
Quaternions using tree iteration have been included with powers 2 and 3 (Quat2T and Quat3T).
Rendering issues
As mentioned already, constructors don't fill in evenly, especially where they get expanded. Adjusting the holon
scales or density is important to minimize rendering time. If more than one constructor is involved, they are in
competition, and it may not be possible to find a balance. In this case you can stop rendering, change densities
and render more. Even with only one constructor, it can be useful to render for a while with the constructor having
lower density to let the fractal details fill in, and the rest of the time with higher density to fill in the larger
constructor areas.
Because the tree iteration fills in different parts at different times, the rendering rate of new pixels can vary wildly,
and can even drop to 0 for many seconds before going high again. Therefore, if you are setting termination values,
especially for batch rendering, using Time instead of Rate is highly recommended.
When rendering any object with a tree metamorph, the Picture window status bar includes some information about
the tree progress. It shows the number of passes through the tree, the maximum depth of branches reached, and
the cutoff value. Cutoff is just a limit for measuring the importance of branches for generating details. The numbers
can vary widely depending on the metamorph and whether constructors or Max Iteration are used, but they can
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give some indication of what the tree is doing. However, if two or more tree metamorphs are used, the numbers
can be updated from any of them and may be difficult to make any sense of.
A note about coordinates
The numbers used in the metamorph parameters have been normalized to the standard ranges of Amount, Scale
and Special for convenience. If you want to explore these fractals in other programs, right-click the metamorph in
the style list to get the popup help. This gives the formula, and the scale factor for the parameters. For example, if
it says that Scale is the real part of c (multiplied by 50), then you can divide the Scale value by 50 to get the real
part of c.

2.19 Fractal metamorphs 3
This topic looks at fractals using Moebius transformations. A moebius transformation is a combination of scale,
rotation, translation and inversion in a circle (or sphere). Two or more in combination can make fractals with
characteristic spirals or gaskets.
As the Spheric metamorph in the Radial category provides a
spherical inversion, it can be used for this purpose, in
combination with other holons. It needs Amount 100, Scale
10, Special 0. The "Semikleinian rings" sample file has
another holon with Z Rotation 120, and a torus constructor.
However, there are limitations in trying to construct more
complex fractals this way. It's easier to use metamorphs
with several built in Moebius transformations to reduce the
number of tricky adjustments, and they also fill in more
efficiently.
The Maskit3d metamorph in the Fractal category combines
four transformations to make a repeating pattern in the X
direction. Apply it to a single holon with all scales at 100. A
good starting point is Amount 0, Scale 100, Special 0
(shown here.) If you reduce the Object Size you can see how
it repeats.
Note: it's easier to adjust 2D fractals with Shaded Preview
off.
The Maskit3d parameters need careful adjustment to keep
the pattern well behaved. Adjusting Amount creates spirals
in the X direction, with Scale adjusted to match. Here is
Amount 0.6, Scale 98.
Adjusting Special instead of Amount makes spirals in the Z
direction. Or you can combine them.
Setting Scale to 0 and Special 50 makes a different gasket
in the XZ plane.
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Adding constructor holons requires careful adjustment of the
scale, rotation and position, otherwise some iterations of the
constructor can be very large and obscure other areas of
interest. It doesn't matter if they are large but out of view.

The Maskits metamorph is similar, but only in 2D, with
Special used to vary the X repetition and not inverting Y for
negative values. Setting Special to 2 is equivalent to
Maskit3D; other good values are 1, 3, -2 or -3. Here is
Amount 1, Scale 98.4, Special 1.
Some other interesting settings are:
(2.513, 95.152, 1); (11.245, 87,445, 1);
(15.972, 81.658, 1); (0, 86.6025, 1);
(0, 80.9017, 1); (0. 92.388, 1);
(0. 25, -2); (0, 12.5, -4);
(7.2, 90.6, 2);

The Moebiusy metamorph has the same two spherical
inversions as Maskit3d, but without the repetition in X. It
needs the holon scales set to 100, and needs at least one
other holon to define a shape. Using similar settings to
Maskit3d and adding one or more constructors can make
simple spirals, as in the "Moebility" sample file (shown here),
or iterators can be added to create more repetition, as in the
"Mobicycle" sample file.
Other settings can give very different results.
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2.20 The Com and Circ metamorphs
Inspired by the work of Asao Tokolo, there are
several metamorphs that make a huge variety
of patterns by combining groups of concentric
rings in a grid layout. With the Circ styles the
rings are always circles, while the Com styles
also allow squares, rounded squares and
diamonds.
Metamorphs in the Grid/block category with
names starting with Com or Circ use a planar
grid, while those in the Radial and Rotary
categories use cylindrical or spherical grids.
Some can displace the surface and others
can cut stencils. All can be used for coloring
alone.
Some knowledge of the parameters makes it
easier to navigate through the possibilities.
Planez/Com diz 0, 14, 4.016; Shaft2/Com dicy 1, -8, 97.090

The patterns are defined by the digits of the Special parameter. The Ctrl and Shift keys are very useful for adjusting
the Special control when using the mouse to click the up/down arrows or pressing the up/down cursor keys. Shift
changes the second decimal, Ctrl changes the first decimal, and Ctrl-Shift changes the whole number.
The whole number in the Special parameter specifies a spatial layout of rings. The patterns are organized in a grid,
but most are seamless so the grid edges are invisible except for the few patterns that avoid crossing edges.
Patterns 0 to 44 are single repeating cells. Patterns 45 to 91 and 100 use two or more repeating cells, with 79, 81
and 83 to 91 and 100 having random choices. Patterns 92 to 95 choose single cells randomly. Patterns 96 to 99
are random cells that don't cross grid edges.
As well as the layout of rings, the final pattern depends on the priorities assigned to each ring. Where rings
overlap, the rings with the highest priority appear on top. The first decimal in Special specifies one of ten schemes
for setting ring priority. Schemes 0 and 1 choose randomly, 2 sets all rings equal, 3 to 5 are chequered and 6 to 9
are diagonal patterns across the grid. Schemes 0 and 8 have unique priorities for each ring so they never merge.
Here are examples of each scheme from 0 to 9, using Circdiz with Special from 4.0, 4.1, 4.2, ... 4.9 (or Comdiz
4.001 ... 4.901), with a gradient that goes from black to grey. Each scheme works better with some patterns than
others.

Creating Objects

63

The last two decimals of Special change the seed for any random elements in the pattern, allowing more variety.
For the Circ styles that's all they do. For the Com styles they also specify the combination of ring shapes to use.
0 gives rounded squares, 1 gives circles, 2 gives squares and 3 gives diamonds. Choosing 4 to 51 gives different
arrangements of pairs of shapes. 52 to 99 use all four shapes in different ways, with 79 to 83 having random
multicell patterns, and 84 to 99 being purely random per cell.
Another useful variation is using negative Scale to get thin rings, with the base level showing in between. For
coloring, the meta patterns and gradients expand the possibilities further.

Com diz 0, 6.2, -30.065 w ith Meta Com diz 0, -6.2, 30.065 w ith linear Com diz 0, 6.2, 30.565 w ith Meta
pattern 6.32, 0, 0 and a step
gradient
pattern 4, 0, 0
gradient

As the Grid/Block Circ and Com styles all face the Z axis, if you want to pattern a horizontal plane you need to
use Planez with Comdiz or Circdiz and reorient it.

2.21 Making holes in holons
Sometimes you may want to cut away parts of holons, to change their shape or see inside. There are three ways
to do it.
Camera clipping
Use the camera clipping controls to cut away the front of the object. There is no adjustment for individual holons.
See Views and the camera 82 for more details.
Metamorphs that make holes or tunnels
Some metamorphs provide specific shapes for clipping or holes. In the Local category, Clipbb clips the holon to a
sphere or cube, leaving holes where any part was outside. In the Grid/block category, Holesz makes a grid of
holes facing the Z direction. The holes vary from circular to square and lobed patterns. In the Rotary category,
Holecyly makes a cylindrical grid of holes, and Holesphr makes a spherical grid of holes. Metamorphs don't hide
points, but move them to the edges of the holes, which can create rims around the holes depending on the holon
shape. Here are some examples with a cylinder:
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Holesz 70, 5.6, 20

Holesphr 80, 8, 0

Holecyly 75, 5, -40

Sometimes you may need tunnels, that is holes with internal walls. This is more useful than holes for exporting
meshes. In the Grid/block category, Tunnelsz makes a grid of tunnels in the Z direction (the same as Holesz but
with walls). In the Local category, Borez makes a single tunnel with options to bevel the ends. Scale and Special
can take some adjustment to get the bevel right. Note that the tunnels extrude to the holon's Z center, so you can
get tunnels extending well beyond the starting shape, as shown in the second example below (Tunnelsz on a tilted
torus).

Tunnelsz 70, -6, 0

Tunnelsz 70, 10, 20

Borez 15, 15, 5

Meta pattern Masks
New in v2.3, this is the most flexible way to cut away holons. It only works with Metamorph coloring. The same
meta pattern that controls the gradient can also be used as a mask to decide which parts of the holon are visible.
The Meta pattern Mask control adjusts how much to cut away, with positive values starting from the high end, and
negative values starting from the low end.
Here is a tutorial to get started.
1.

3.
4.
5.

Click the File New button
in the Standard toolbar. If you're not already on the Shape page, click the
Shape tab.
Click the first Style button, and select '.Sphere' from the Constructor category in the Metamorph Styles
window.
Go to the Color page.
Set the Color Method to Metamorph.
It will be easiest to see the pattern with a gradient having two light colors. Click the Gradient Presets button

6.
7.

, choose the Basic Monochrome category and select the 'Linear white midgrey' preset. Click OK to close
the presets.
In the Mapping panel, set the first Meta Pattern to 6, to give vertical stripes.
The Mask control is also in the Mapping panel. Set it to 20, and notice that it hides the parts of the sphere

2.
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where the gradient is darkest. Actually it doesn't care about the gradient colors; it hides the top end of the
gradient. Increase the value to cut away more of the sphere.
8. Set Mask to -50, and notice that it cuts away the bottom end of the gradient instead.
9. Set the second Meta Pattern to 6, to get spiral slices.
10. To make a grid of holes in the sphere without using a second metamorph, set the first two Curve dropdowns
to Sin, and the first Blend dropdown to 'x'. Set the Mask to 50 and the first two Meta Patterns to 9. The
Mapping controls are shown here, and pictures of the last four steps:

Step 7, Mask 40

Step 8, Mask -50

Step 9

Step 10

11. Now we want to use a second metamorph for the masking. Go to the Shape page.
12. Click the second Style button, and in the Grid/block category select 'Fblock3d'.
13. Go to the Color page.
14. Set the first Meta Pattern to 3, the second to 0. Click the Reset Curves and Blends button
. Increase
Mask to 70. Now we have a sphere with holes cut in a pattern set by Fblock3d.
15. Next we want the second metamorph to change the shape. Go to the Shape page and set the second
metamorph Amount to 30.
16. Go back to the Color page and set Mask to different positive and negative values.

Step 15

Step 17, Mask 85

Step 17, Mask -20

More notes about masking
If you have a constructor holon set up with masking, and want to add a second metamorph to modify that shape,
set Map From to First Metamorph, otherwise the mask will use the pattern from the second metamorph.
When you have iterator holons as well as constructors, it is quite likely that
you will want some iterators to inherit the masked shape. To do this for an
iterator holon, just set its Map From to Inherit All. (If you want to vary the
masking, you could set Map From to Inherit Style and adjust the Mask and
Meta Pattern controls.)
Here is a simple example of an iterator set to inherit the mask of a sphere.

You can change gradients and the Cycle, Noise or Inherit Color controls without affecting the mask. However,
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the mask and coloring always share the same meta pattern.
Here is a way to make a random lattice on any constructor. Set the second
metamorph to Poissrad in the Noise category, and adjust Scale for a
suitable lattice size. Set Amount to 0 for a flat lattice or negative for angled
edges. Set Special to about -4. In the coloring, set the first Meta Pattern to
3 and the Mask to between 80 and 90.
This example uses a torus constructor.

2.22 Extruding shapes
There are several methods of extruding shapes (extending the shape in a particular direction.) The initial shape is
usually 2D but it doesn't have to be. A large solid shape is not good for extruding because the result fills a
significant volume, which is very slow.
Extruding 2D fractals - the classic method
For a 2D fractal made from iterator holons, there is a simple method to extrude it into the third dimension:
1.
2.
3.
4.

Click the Select All Holons button
.
Set Z Scale to 50 (if it isn't already.)
Click the Clone Holons button.
Adjust the Z Position to set the depth of extrusion.

For example, the Sierpinski triangle (found in the File menu Starters):

This method doesn't work with Fractal category metamorphs.
Extrusion metamorphs
More generally, there are several metamorphs in the Local category for controlled extrusion. Extrudez provides
straight lines in the Z direction. Helixy makes helical revolutions; Revolvey and Revolvez make simple revolutions;
Shelly makes spiral shells.
For a constructor holon, you can simply apply one of these metamorphs to it. If the second metamorph is already
used, you can use an extended holon for the extruder.
Here is a shape made with the .Griller constructor (Amount 0, Scale 5, Special 2.250) and then with a little rotation
and Helixy added:
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Extruding a fractal with one or more iterators
In this case you will usually want to prevent the extrusion from interacting with the fractal shape. This can be done
by extruding a Free holon, with the parent shape hidden.
1.
2.

Make the fractal shape (usually 2D).
Click the Add Holon button.

3.

Click the Free Holon button

4.

Click the Hide Parent Shape button

5.
6.

Ctrl-click the Sync Scales button
to set all scales to 100.
Select your choice of extrusion metamorph and adjust the parameters.

.
.

Here are two examples. The first is JacuzaT and Extrudez with a plane behind it, allowing for shadows. The
second is JulianneT and Shelly.

2.23 Coloring: two methods
The Color page is where you choose coloring for the object before rendering. Two methods are available, and
whichever you choose applies to the whole object. The methods are quite different, so the first step in coloring is to
choose between them.
Holon Sequence coloring

68

Using XenoDream v2.7

Uses color directly, so every pixel can have a unique color.
Calculates color by blending gradients according to the holon sequence that generates the pixel.
Ideal for pure fractals; ie shapes with no constructor metamorphs, because intricate shapes can have
corresponding detail in the color.
Produces random noise for constructors - not usually what you want, but it can work with suitable lighting.
Gradients are used indirectly, so the colors are hard to control. It is often a matter of experimenting, whether by
randomizing or trying combinations of gradients and tweaking parameters.
Metamorph coloring
Ideal for objects with constructors.
Colors are mapped to gradients or a picture.
Choose how the colors are mapped for each holon.
Can be used whether or not the shape uses metamorphs.
If the object has constructors, Metamorph coloring is usually best, otherwise Holon Sequence coloring is usually
best.
Here is an example of a spiral with all iterators and no metamorphs.

Holon Sequence coloring. The colors follow the
holon iteration.

Metam orph coloring, using a m etam orph style not
in the shape.

Here is an example of a spiral with a constructor.

Holon Sequence coloring, w hich results in random
noise for constructors.

Metam orph coloring, using one of the patterns in
the torus.

The Spiral Shell 37 tutorial uses Holon Sequence coloring. Many of the sample parameter files were made with
v1.0 or 1.1 and use Holon Sequence coloring.
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2.24 Metamorph coloring basics
In this topic we will see how to get a variety of coloring effects for an object having a constructor and an iterator.
The same ideas will apply when you have additional holons of either type.
First, make the shape:
1.

Click the File New button
Shape tab.

in the Standard toolbar. If you're not already on the Shape page, click the

2.
3.
4.
5.
6.
7.
8.
9.

Set the X Scale to 90 and click the Sync Scales button
.
Set the Z Rotation to 45.
Click the Add Holon button.
Set the X Position to 120.
Click the first Style button and choose '.Sphere' from the Constructor category.
Set the first metamorph's Scale to 5.
Click the second Style button and choose 'Hexagoz' from the Grid/block category.
Set the second metamorph's Amount to 10, Scale to 10 and Special to 10. This is the shape we want but
the inside of the spiral is slow to fill in, so we need to balance the effective densities.

10. Set the X Scale to 55 and click the Sync Scales button
. Now the spiral is balanced. (There are no
magic numbers; you just have to adjust the scales until it looks about right.)

Exploring simple coloring
First we will look at holon 1, and try solid color, gradients and inheriting.
1.
2.
3.

Click the Color tab to go to the Color page.
In the Method dropdown box choose Metamorph.
Select holon 1.

4.

Click the Edit Gradient button
to open the Custom Gradient editor. We want the gradient to start with
red.
To change the color, click the white color rectangle to open the Color Picker. Choose bright red and close the
color picker. The first node should now be bright red. While the editor is open, we will change the second
color to blue.
Double-click the second node (the black circle at the right end of the gradient) to select it and open the Color
Picker. Choose bright blue and close the color picker. You should now have a gradient that goes from red to
blue.

5.

6.
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Click OK to close the Gradient editor.
In the Mapping panel there are three Meta Pattern controls, and the first one defaults to 3. Set it to 0. Now
holon 1 should be solid red. The Meta Pattern controls set the strength of three patterns, and we need them
all to be zero to get a single color.

9.

Adjust the Cycle control. This sets the starting point of the gradient, so you can use any color in the gradient
for the holon.
10. Set Cycle back to 0. Now increase the first Meta Pattern control and notice that it controls the gradient in
the X direction. When the holon has no metamorphs, the three patterns are set to the X, Y and Z directions
respectively. Sometimes this is useful. You can get more options by using a metamorph on the holon (but not
in the Constructor or Tile categories) with Amount set to 0, to use its meta patterns for coloring without
affecting the shape. But since an iterator holon inherits the shape of other holons, we usually want to inherit
the pattern for coloring too.
11. Set the Map From dropdown box to Inherit Style. Now the three patterns come from the other holon, but use
this holon's mapping controls. Experiment with the three Meta Pattern controls to see the effects.
12. Set the Map From dropdown box to Inherit All. This uses the mapping from the other holon, ignoring the
values for this holon. Adjusting the Meta Pattern controls has no effect. Inherit All is the way to go for
iterators when you want to repeat the pattern exactly, so it will probably be your default choice.

13. Now the holons have different gradients. Often you want them to use the same gradient. We could just use
the same gradient for both holons. But if we had more holons, this holon would be inheriting them all, possibly
with different gradients. To make sure we inherit the gradients from all holons, check the Inherit Color box.
Now the holon inherits the gradients from the other holon too.
14. Beside the Inherit Color checkbox is the Inherit Count control, defaulting to 392. If you increase it, it wraps
around to 1. The holon inherits the gradient for the specified number of iterations, then uses its own gradient
after that. Experiment with it, then set it back to 392.
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Now that we have set holon 1 to inherit all its coloring from holon 2, we will look at holon 2.
1.

Select holon 2. The default setting for Map From is Last Metamorph. This means that the pattern will come
from the second metamorph if there is one, otherwise the first metamorph is used. In this case the pattern
comes from the Hexagoz style.

2.

For something more colorful, click the Gradient Presets button
and in the Basic Plain category choose
'Cream Forest Hues'.
Adjust each of the three Meta Pattern values in turn to see how the patterns vary. Here are the results with
each set to 7 and the other two set to 0:

3.

4.
5.

Set Map From to First Metamorph. Now the patterns come from the Sphere constructor.
Adjust each of the three Meta Pattern values in turn to see how the patterns vary. Here are the results with
each one set to 6 and the other two set to 0:

You can mix the Meta Pattern values to combine patterns. Most of the time you can get what you want by using
one or two Meta Pattern controls and a suitable gradient. For more variations there are also Curve and Blend
options to modify the patterns.
In this topic we saw how to:
use solid colors or gradients
use patterns from the holon's metamorphs
inherit the pattern and/or colors from other holons
Usually you will want iterators to inherit the pattern and colors, especially for large holons. You will likely not want
constructors to inherit patterns because it just results in noise. Constructors can inherit color from one other holon
cleanly, but if there are two or more other holons the colors will be noisy.
In the next topics we will see how to:
use metamorph patterns from other holons
make wood and rock textures
map the background picture onto a holon
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2.25 Advanced coloring and wood
In this topic we will look at three ways to use metamorphs purely for coloring, and explore wood grain patterns.
Using the second metamorph just for coloring
Most metamorphs (except for the Constructor and Tile categories) have no effect on the shape when Amount is 0.
So if a holon is only using one metamorph, we can add a second metamorph just to supply the pattern for
coloring. Not all metamorphs have useful patterns in this role. The best are to be found in the Local, Axial, Radial
and Noise categories.
1.
2.
3.
4.
5.
6.
7.

Click the File New button
in the Standard toolbar. If you're not already on the Shape page, click the
Shape tab.
Click the first Style button and choose '.Sphere' from the Constructor category.
Release the Shaded Preview button
in the Preview toolbar. It is much easier to see color adjustments
quickly with shading off. You can turn it on and off to see the shape any time without restarting the preview.
Click the second Style button, and choose 'Fstonez' from the Grid/block category. This pattern has spots in
randomly subdivided squares.
Go to the Color page.
Set the Color Method to Metamorph.
Adjust each Meta Pattern control in turn with the other two set to 0. Then set the first two Meta Pattern
controls to 3 and the third to 0. The second pattern combines well with either of the others. These four results
are shown here:

The Wood metamorphs
The Noise category includes three metamorphs that are designed for wood coloring and never affect the shape.
Which one you use depends on which direction you want the straight or circular grain to run.
1.

To continue, set the first Meta Pattern to 3 and the other two to 0.

2.

Click the Gradient Presets button
, choose the Woods category and select the 'Birch' preset. Click OK
to close the presets.
Go to the Shape page.
In the Metamorph Styles list select 'Woodz' from the Noise category for the second metamorph. This makes
a circular grain around the Z axis.
Increase the second metamorph's Amount to 15. This adds some smooth randomness to the rings.
Increase the second metamorph's Special to 12. This adds octaves to the noise, making the rings rougher.

3.
4.
5.
6.
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Using an extra holon just for coloring
If we were already using the second metamorph for the shape, as often happens, how can we use a wood
metamorph? We have a choice of two methods, both using an extra holon that is free and hidden. One is to extend
the holon (see Extending holons for extra metamorphs 45 if you haven't already), and the other is to set Map
From to Other Holon.
Extending the holon
1.
2.
3.
4.

Click the first Style button and choose '.Planez' from the Constructor category.
Click the second Style button, and choose 'Twisty' from the Rotary category.
Set the second metamorph's Special to 0 (leave Amount at 15). Now we want to add a wood texture to this
shape, so we need another holon.
Click the Add Holon button in the Holon toolbar.

5.

Click the Free Holon button

6.
7.
8.

Ctrl-click the Sync Scales button
to set all scales to 100.
Select holon 1.
In the Extend panel (middle of the Shape page) set the Extend Holon control to 2, and check the Color
checkbox.
Go to the Color page.

9.

and the Hide Holon button

.

10. Click the Gradient Presets button
, and select the 'Pine macrocarpa' preset in the Woods category.
Click OK to close the presets.
11. Select holon 2.
12. Go to the Shape page.
13. Click the first Style button and choose 'Woody' from the Noise category. For this shape we want a vertical
grain.
14. Set the first metamorph's Amount to 30, and Special to 9. This makes a nice wavy grain.
15. Set the first metamorph's Scale to -10. This uses the absolute value of the noise for an angular pattern.
16. Select holon 1.
17. Go to the Color page.
18. Set the first Meta Pattern to 0, and the second one to 3. This uses stronger distortion for knotty or burled
wood.
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Using Other Holon coloring
1.
2.
3.
4.
5.

Go to the Shape page.
Set the Extend Holon control to 0, to stop extending the holon.
Go to the Color page.
Set the Map From dropdown box to Other Holon. The Other Holon controls appear beside it.
Set the Other Holon control to 2. The preview should now be the same as it was when using the extended
holon.

Both these methods can be a little confusing with having to switch back and forth between holons and the Color
and Shape pages. For both methods you use the Color page for the holon being colored and the Shape page for
the Other/Extender holon.
Extending the holon has advantages when you want to affect the shape; otherwise they have the same speed and
give the same result, with one difference. Extending the holon provides a Repos option to allow the pattern to be
relative to each holon, while the Other Holon method uses absolute position. So if you have several holons sharing
a wood pattern from another holon, the Extender method gives the choice of identical patterns or being part of a
single pattern, while the Other Holon method cannot provide identical patterns.
Here are more examples of wood textures, using Planez and Woody.

Woody 32 10 7
Meta Patterns 3 0 0
Gradient 'Oregon 1'

Woody 22 12 10
Meta Patterns 2 0 0
Gradient 'Kauri 1'

Woody 56 -9 11
Meta Patterns 0 3 0
Gradient 'Walnut 1'

Woody 45 11 8
Meta Patterns 3 0 0
Gradient 'Blue gum '

When you adjust Scale to suit different situations, you will need to adjust Amount too.
The wood metamorphs can also make rock textures with suitable gradients. In the next chapter we will explore
rock textures using other metamorphs.
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Saving textures
When you use a separate holon for texture (using either the Extend Holon or Other Holon methods), you may wish
to save it as a preset that could be used with other objects. XenoDream doesn't yet have presets for holons or
metamorphs, but it does allow you to save single holons in an .XEP file by using the File menu Save Holon
option. Later you can add them to an object using the File menu Append... option. If the holon is free and hidden
when it is saved, it will be appended free and hidden, ready for other holons to use by extending or Other Holon
coloring. It will be helpful to organize such texture holons in one or more folders so you can find them easily.

2.26 Stone textures
In this topic we will explore a variety of stone textures. The standard stone textures are granite, marble and agate,
which can be adapted to look like other kinds of rock. We will also look at Voronoi patterns and brick effects. To
use them in practice, you will often need to use either Extended holons or Other Holon coloring as described in the
previous topic, Advanced coloring and wood 72 .
Granite and marble textures
The easiest way to explore stone textures is applying them to a plane. Granite and marble are made from standard
FBM (Fractal Brownian Motion) noise. The metamorph parameters and the gradient can provide plenty of variety.
Unlike the Wood metamorphs, we keep Amount set to 0 unless we want to affect the shape.
1.

Click the File New button
Shape tab.

2.

If the Shaded Preview button
in the Preview toolbar is down, release it. This makes coloring faster to
work with.
Click the first Style button and choose '.Planez' from the Constructor category.
Set the first metamorph's Scale to 12.
Click the second Style button and choose 'Fbmz' from the Noise category.
Go to the Color page.
Set the Color Method to Metamorph.

3.
4.
5.
6.
7.
8.

9.
10.
11.

12.
13.
14.

in the Standard toolbar. If you're not already on the Shape page, click the

Click the Gradient Presets button
. There are four categories specifically for stones. Select the 'Stones
marble' category and choose 'Marble white 4'. Although there are separate gradient categories for marble and
granite, which one they most resemble will depend on the Fbm metamorph settings, and also whether you
consider a close or distant view of the rock.
Go to the Shape page.
Increase the second metamorph's Special control to 8. This adds octaves to the noise and it begins to look
like marble.
Increase Special in steps of 1. Up to about 16 it looks like milky white marble. Then up to about 23 it looks
like a close up view of the crystalline structure of marble or granite. (Values above 25 use higher frequency
ratios for the octaves and produce more exotic rocks or coral.)
Set Special to 20 and try various positive values for Scale. This lets you zoom in or out. Also notice that tiny
changes to Scale move to different random patterns, so you have plenty of choice of pattern at any scale.
Set Special to 2 and Scale to -10. Negative values of Scale use absolute values of the octaves for a creased
or ridged effect.
Increase Special in steps of 1. Up to about 16 it makes classic marble. Above that it gets more like granite.
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Fbm z 0 10 11
Gradient 'Marble w hite 4'

Fbm z 0 3 20
Gradient 'Marble w hite 4'

Fbm z 0 -10 10
Gradient 'Marble w hite 4'

Fbm z 0 -10 18
Gradient 'Marble w hite 4'

You can also use negative values of Special to get a stronger mix of lower octaves and less high frequency noise.
The next step is to use different gradients. Here are some examples. The gradients are from the marble, granite
and agate categories.

Fbm z 0 10 12
Gradient 'Marble w hite 1'

Fbm z 0 10 12
Gradient 'Marble black 1'

Fbm z 0 8 15
Gradient 'Marble green 1'

Fbm z 0 -10 11
'Granite pink burgundy'

Fbm z 0 -10 16
Grad 'Granite ochre tan'

Fbm z 0 -4 19
Grad 'Granite w hite pink 1'

Fbm z 0 -4 17
Gradient 'Marble red 4'

Fbm z 0 -4 21
Gradient 'Agate cream 3'

We used Fbmz to get the standard Fbm noise on a surface facing the Z direction. For a horizontal surface you
could use Fbmy instead, and for general shapes you might need to use Fbmrad or Fbm3d.
Agate textures
For agates and similar rock textures you can use Fbm metamorphs, but often you will want straight or circular
banding. The Agate metamorph provides bands in the Y direction, and the Agater metamorph provides spherical
banding. Here are some examples.
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Agate 0 10 12
Gradient 'Agate green'

Agate 0 -8 -14
Gradient 'Agate rose'

Agater 0 8 14
Gradient 'Agate blue 1'
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Agater 0 -5 10
Gradient 'Agate cream 3'

Voronoi patterns
Voronoi metamorphs can be useful for some cellular stone textures. For most of them, the first Meta Pattern
produces a pattern depending on the metamorph settings, the second uses the distance to the nearest cell and
the third uses the distance to the second nearest cell. You can use Voroz2 for surfaces facing Z, Voroy2 and
Voromy2 for horizontal surfaces and the others for any object. The Vorogrid metamorph provides a random cell
color for the third Meta Pattern instead.

Voroz2 0 3 0
Meta Patterns 2 0 0
Gradient 'Agate caram el 2'

Voroz2 0 -3 0
Meta Patterns 2 0 0
Gradient 'Marble blue 2'

Voroz2 0 3 0
Meta Patterns 0 0 1
Gradient 'Jade green 1'

Vorogrid 0 6 0
Meta Patterns 0 0 3
Gradient 'Agate caram el 2'

Bricks and blocks
In the Local category there are metamorphs for brick and block patterns. They can be colored in a variety of ways.
If you want the classic brick pattern with fairly uniform bricks surrounded by mortar, use a gradient with a small
amount of mortar color at the start and a sharp transition to the brick color, as in the 'Bricks red' gradient in the
'Stones other' category. You can adjust the transition position for less mortar. Although these metamorphs let you
square up the brick shapes with the Special control, the color isn't affected and needs to be set in the gradient.
Using textures in practice
The 'Data\Artificial\Gallery sculpture 1.xep' file is an example of a scene made from constructors with each holon
having a different wood or stone texture. It does not use any extended holons, but sometimes you will need to
extend holons to use an extra metamorph for coloring. Note also that the floor and wall have shadow casting
disabled to improve shadow quality, as discussed in Shadows 116 .
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'Gallery sculpture 1'

2.27 Picture mapping
Metamorph coloring includes an option to map the pattern to the Background picture. Instead of mapping one
pattern into a gradient, two pattern parameters are used; one for the picture's X coordinate and one for the Y
coordinate. This allows you to wrap the picture onto the shape in a wide variety of ways. This tutorial shows the
simple example of mapping a picture onto each face of a cube that is iterated in a spiral.
You will need a picture file in JPG, BMP or PSD format. A photograph of similar size to the render size would be
ideal. Alternatively, you could create a background picture using the Pic Texture filter.
First we will create the spiral of cubes.
1.
2.
3.
4.
5.
6.
7.

Click the File New button
in the Standard toolbar. If you're not already on the Shape page, click the
Shape tab.
In the File menu, choose Starter Shapes... and choose 'Spiral 1' from the list. Click OK to close the dialog.
Select holon 2, either with the Active Holon control or by clicking near the smaller holon in the Holon
window.
Click the Metamorphs button to enable metamorphs.
Click the first Style button, and select '.Cube' from the Constructor category.
Set the first metamorph's Scale to 2.0, and check the Reposition and Reorient checkboxes. You should
now have a spiral of cubes.
Check the Optimize checkbox beneath the Holon parameter controls, to balance the holon densities.

Next we will set up the picture mapping and open the picture.
1.
2.
3.

Go to the Color page.
Change the Coloring Method to Metamorph.
Set the Map To option to Background Picture. The preview shows the small holon with a checkered pattern
because we haven't opened a background picture yet. The picture mapping panel appears in the center of the
Color page.

4.

Click the Picture Map Defaults button
. This sets the picture mapping and Meta Pattern controls to
suitable defaults. Now we need a background picture.
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5.
6.

7.
8.
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Click the Picture button in the Rendering toolbar, to go to the Picture window.
In the File menu, choose Open Picture... and find a picture to open. Select it and click OK. When the
Picture Destination dialog appears, choose New Background Picture. If the picture size is different there will
be some resizing options; choose either the third or fourth option.
Return to the Main window. The preview should now show the small holon with the picture on each face of the
cube.
If necessary, adjust the Picture Offset controls to position the picture, and the first two Meta Pattern
controls to scale it.

Now we want to iterate the picture around the spiral.
1.
2.
3.

Select holon 1.
Set the Map From dropdown box to Inherit all. This inherits the cube mapping and Meta Pattern controls
around the spiral.
Check the Inherit Color option. This inherits the Picture Map and Offset controls around the spiral. Now the
spiral should color each cube identically.

Picture mapping is limited to using one picture at a time, because it always uses the Background picture. In
principle you could create a montage from several pictures and adjust the Offset and Meta Pattern controls for
several holons to use different parts of the picture.

2.28 Transparent preview and rendering
Any object may be rendered with some transparency, allowing the object's internal shape and color to be seen,
and allowing some background colors to show through. Transparent renders can be left unlit (or lit with only
ambient light and other adjustments), or they can combine 3D lighting and transparency. The Preview toolbar
includes a Transparent Preview button
to reveal internal structure, so you can get a quick idea of how an
unlit transparent render might look. Transparent preview can take a few seconds to reach medium opacity and will
over-saturate fairly quickly. It is only an approximation, with the emphasis on quick feedback. Before rendering you
need to set the opacity options on the Rendering page. Here is an example showing the shaded and transparent
previews, and the results after rendering with Holon Opacity set to 10.
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Shaded preview

Transparent preview

Unlit transparent render

3D lighting w ith transparency

Some types of object look much better rendered transparent. Generally, any object that is messy or chaotic is a
good candidate for transparency.
Some samples of transparent objects are included in the Data\Transparent folder. Many of them are of the
kaleidoscope type, with one holon having scales of 100 and some rotation. In fact, many of them came from just a
few starting points because they are such a rich vein for exploration. Before opening files in this folder, it is useful
to enable Transparent Preview so you can preview them transparently from the dialog.

Iris 2

Colony 3

One of the secrets to finding good variations from these kinds of objects is to identify which parameters need to
stay the same and which can be freely varied. You can do that by modifying one parameter at a time and noticing
if it preserves or destroys the important characteristics of the shape. After varying each parameter you will need to
return to the starting point, either by using Undo or by restoring from a Shape Memory Spot. For all kinds of
kaleidoscope object, the large holon's Scale, Rotation and Position controls should be left alone or adjusted very
carefully when doing minor variations. The rotation values tend to have 'islands of stability' that can be hard to find if
using more than one rotation axis. For a single rotation, the obvious stable points are angles such as 30, 45, 60,
72 etc that are divisors of either 360 or a low multiple of it such as 720. The metamorphs applied to the large holon
are also critical to the shape. The Amount is usually small, and the Scale and Special parameters are good to
experiment with.
In general, the Opacity Mode should be Uniform, especially for messy objects. Enhance Depth can improve the
appearance, provided that the object has even density at the front, otherwise it is prone to speckling. It works well
with constructors.
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In the Lighting window, the alpha controls let you adjust the opacity response. Increase Gamma to bring up the
lowest opacities. You can increase it more early in the render to get quick feedback and experiment with lighting,
and reduce it as the render proceeds.

2.29 Optimizing for quality and speed
The time it takes to render can vary widely, from seconds to days. It depends on the volume and density of the
object, the complexity of metamorphs used, and the render size. Since the quality of the picture depends on both
render size and how long you let it render, there is a tradeoff between quality and time. When either is an issue, it
is often worthwhile to try some of these methods.
Tuning for speed
First, if you are rendering the object purely in white (or another single color), or you don't care about the color
because you will use lighting that ignores it, use Metamorph coloring. Metamorph coloring can be twice as fast as
Holon Sequence coloring.
Second, balance the holon density. The time to achieve satisfactory quality depends on the slowest holons, so
you want to balance the holon density as much as possible.
If the object is dominated by iterators rather than constructors, try checking Optimize Density (on the Shape
page). This gives a better balance for iterators, provided that none have scales near 100. If some scales are near
100, it is usually much better to uncheck it. (With transparent renders, the results are often better with it
unchecked, to emphasize the centers of spirals.)
For constructors, the metamorph scale is not taken into account, so large constructors are likely to be less
dense than they should be, and small ones are likely to be more dense. When you are not using the Rescale
option it is useful to adjust the holon scales approximately in proportion to the metamorph scale. This also
makes the Holon window more intuitive than leaving the holons at the same size. When you are using Rescale,
you may not have the flexibility to change the scales, so you can rely on Density adjustment instead.
Adjust the Density control for any holons that are faster or slower than the others. For a large iterator, the spiral
center or tail will be incomplete if the holon's density is too low, or fill in faster than the outer part if the density is
too high.
An easy way to check density is to click the Transparent Preview button in the Preview toolbar, notice which
holons appear much faster or slower than the others, and make the above adjustments until the holons appear to
develop evenly. Some small holons may not be obvious with this method, so check it again without Transparent
Preview.
Another factor is the distance from the camera. Holons that are far away will render faster, and can have Density
reduced to compensate. Holons that are very close to the camera will be slower to fill in the closest parts, and can
have Density increased to speed them up. This doesn't help much with holons that cover a large distance range.
There may still be times when it is unacceptably slow, or the appearance is unsatisfactory in some ways. Then
you have two choices: abandon the object, or try changing it to make it viable or worthwhile.
Tuning object appearance
When working with iterator holons, the three scales determine the size of the holon. Collectively they determine
the density of the object, or how much of the volume is filled and how much the holons overlap each other.
Sometimes you may find that when you render the object it's not quite what you hoped for - too slow, too cluttered,
too weedy in places, etc. This often means that some scales need adjusting.
If holons have a lot of overlap, resulting in a very dense object, it will be very slow. A big clue is the Holon Volume
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field showing more than 90%. It can be difficult to guess which holon scales need reducing. Set the Preview Mode
to gray so you can see the effect of the active holon, and try adjusting different holon scales to find which ones
make the holon thinner in the right direction. Similarly, some holon scales may need increasing to make features
larger or better defined.
Other times the object is inherently messy. If it's messy in the preview, it is likely to be messier in the render, so
consider whether some holon adjustments can produce a nicer result before you render.
Perspective distortion
Sometimes you may notice that objects near the edges of the picture appear distorted, for example spheres
appear elongated. This is due to perspective distortion, and occurs with a wide angle lens. The default camera
position is relatively close to the object and can produce noticeable distortion, but moving closer and reducing
Camera Zoom will exaggerate the effect further. To reduce or eliminate the distortion, increase the camera's Z
Position and increase Camera Zoom. You may want to set the Default Distance to a value larger than 4.

2.30 Views and the camera
As we are creating three dimensional objects, you can view them from any position and direction, like using a
camera with a powerful zoom lens. The Camera view is the most flexible and is used for rendering the picture.
In addition (new in v2.1), there are six views with fixed directions (Front, Back, Right, Left, Top, Bottom). These are
convenient for viewing an object from different sides, and use parallel projection to make aligning holons easier.
They are only used in the Main window. This topic gives an introduction to the view controls.
1.
2.
3.
4.

In the File menu choose Starter Shapes... and select 'Spiral 2' from the list.
The active view name shows in the lower left of the Holon window, and is initially 'Camera'. Click on the name.
It changes to 'Front', and the view is updated.
Click on each view name in turn until it returns to 'Camera'. Now Shift-click on each view name to switch views
in the reverse order.

5.

You can also set the view with the View menu. Click on the View Menu button
choose Right from the menu.
Click on the View tab to go to the View page, if you're not already there.

in the Holon toolbar and

6.
7.

In the View page, drag the View Position XY icon
to center the object in the preview.
Ctrl-drag the View Position XY icon to move the holons in the Holon window independently of the preview.

8.

Click the Sync Window Positions icon
to move the Holon window back to match the preview. It is only
visible when the Holon window has been moved for the active view.
9. Adjust the Camera Zoom control to zoom in or out in the Preview.
10. Adjust the Holon Zoom control to resize in the Holon window.
11. Click on the View Menu button
in the Holon toolbar and choose Camera from the menu. The same
adjustments work for the camera, and more.

12. Drag the View Position Z icon
vertically to move the camera toward or away from the object. You can
also adjust position with the numeric Position controls.
13. The camera can also be rotated, and the most direct way is by dragging the icons. Drag the Camera Rotate

XY icon

to rotate around the X and Y axes. If you try using this with any other view, it will switch to
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the Camera view first.
14. Drag the Camera Rotate Z icon

vertically to rotate around the Z axis.

The way the camera rotation controls work (especially the Camera Rotate XY icon) depends on the Trackball
mode. In the default World mode, it rotates around the world axes in order Y, X, Z. In Screen mode, the icons
rotate relative to the screen each time. Holon mode allows rotating around the active holon. In Camera mode, the
controls rotate the camera instead.
Clipping controls
The clipping planes allow the front or back of the object to be cut off so you can see inside.
1.
2.
3.
4.

In the File menu choose Open Sample File... and navigate to the Tutorials folder. Select 'Bauble ring' and
click OK to open it.
If you are not already on the View page, click the View tab.
Click the Set Clip Front button
to set the front clipping plane to the nearest point.
Increase the Clip Front control (dragging it upwards is easiest) by about 0.1 at a time and observe the
results. Three stages are shown below.

Clip front 3.3

Clip front 3.5

To experiment with back plane clipping too, click the Set Clip Back button
control value. To disable back clipping, set the Clip Back value to 0.

Clip front 4.0

, then reduce the Clip Back

2.31 Stereo images
XenoDream makes it easy to produce several kinds of images for stereo viewing. You can make stereo image
pairs for cross-eyed viewing, parallel viewing or the four most common colored glasses. There is also a single
image stereo technique.
Stereo image pairs
Making them is very simple. The View page has a Stereo panel with a few controls in it.
1.
2.

First make the object. Anything will work as long as it has some depth, ie not completely flat.
Go to the View page.

3.
4.

Click the Stereo button
to enable stereo mode.
Adjust the Camera Zoom. Usually you will want some clear space around the object, but you can also have
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objects that are clipped or even fill the whole area.
Adjust the Stereo Depth to control how deep the object appears in stereo.

The preview can show stereo images for cross-eyed viewing, parallel viewing or colored 3D glasses. Cross-eyed is
the most flexible, but if you have difficulty seeing them this way you may prefer one of the other methods. The
Stereo Preview Method dropdown box only applies to the preview. Stereo pictures are always rendered for
cross-eyed viewing, and can be converted to other types afterwards.
Stereo options for after rendering
Lighting now fully supports stereo mode, with the exception of hole filling, which does not correlate between
images and should be avoided. Pic Textures also support stereo mode, so you can create stereo textures to use
as backgrounds with lighting.
The Picture window Edit menu has options to convert stereo renders from cross-eyed to parallel or anaglyph
(colored glasses).
These options should be the final step before saving the picture. Do any lighting or filtering first.
They should be done in order. If you are converting to anaglyph, do that first. If you are swapping left and right for
parallel viewing, do that second. If you are adding a black border around each image, do that last.
Holmes cards
If you want to produce stereograms for printing Holmes cards, here are the important steps:
1.
2.
3.
4.
5.

Set the Render Size to 2100x1050.
Render, apply lighting and any filtering etc.
In the Picture window Edit menu, choose Add Stereo Border.
In the Picture window Edit menu, choose Swap Left And Right.
Save the picture. If saving as PSD, you probably don't need layers unless you are adding other picture
elements.

Stereo distance and compositing
If you are compositing multiple renders, you will need to adjust the Stereo Distance control for each render to set
the desired distance, otherwise they will likely all intersect when viewed in stereo. If you are concerned with the
exact distance relative to the picture frame, you can adjust Stereo Distance for this purpose too.
Methods of viewing stereograms
Viewing cross-eyed stereograms can be challenging, especially at first, but once you start to see them it gets
easier. Here are two methods to begin.
Method 1:
Hold a finger up in front of the screen, below the center of the picture. Slowly bring it closer to your face, focusing
on the tip of your finger. When it gets to about nine inches (22cm) from your eyes, you should see a central image
behind it. Keep focusing on your finger and move it forward or back until the image is clearest. Try shifting your
focus between your finger and the image without changing your focus distance. When you can hold it steady, you
can bring the object into sharp focus, and see it in full 3-D.
Method 2:
Hold both hands up about eight to ten inches from your face, palms towards you, with a gap of about two inches
between them. Looking at your hands, move them so that the image appears between them, and move them
further or closer until the image comes into focus. This method has the advantage of hiding the distracting side
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images.
Viewing parallel stereograms also takes patience to learn. It requires relaxing your eyes to focus in the distance,
well behind the screen, until the images converge into a central 3D image.

Single image stereo
There are several types of stereogram that encode distance into a single image. One of them simply has repeating
horizontal tiles, each tile adjusted for the proper viewing angle. When your eyes focus on adjacent tiles instead of
the same tile, the image appears in stereo. It is simple to create these in XenoDream. We will call them XSIS
images (XenoDream Single Image Stereogram) to distinguish them from stereo pair images. Barney Johnson
(http://www.3dwonderstuff.com) has patents pending on techniques for creating this effect in software, so be aware
that this may affect any commercial use of XSIS images you create.
To create an XSIS image, use the Tile category 'Tilex' metamorph on all holons. Amount sets the size of each
tile, Scale sets the overall size, and Special sets the number of tiles (usually between 5 and 20). For a single
holon, the first metamorph will be a constructor and the second will be Tilex. For multiple holons you can either
use Tilex on all of them, or use one of the methods of extending holons for extra metamorphs 45 .

2.32 Sample files and starters
More than 600 sample parameter (.xep) files are included with XenoDream. There are three ways to open them:
In the File menu, choose Open Sample File... to browse through the sample files.
On the File page, move the mouse over the Quick Start panel and click the green Random Sample File button
to choose one randomly.
In the File menu, choose Starter Shapes... to quickly select from a set of generic shapes. Lighting is not
included.
The sample files are sorted into categories. Many of them date back to v1.0 or 1.1 and were selected to
demonstrate a variety of shapes and purposes, and may or may not include suitable lighting. Some others were
tests or demonstrations of recent features, and some were more deliberately created as art. We encourage you to
use these files for learning or as starting points for your own creations.
The Data\Tutorials folder contains some parameter files that are used in tutorials, and a few examples of the
tutorial results.
In addition, John McAskill has provided 47 sample files of objects made from constructors, located in the 'Data
\John McAskill' folder. Note that most were produced in v1.5, and some could be made more easily in v1.6 or later
by using some of the new Tile metamorphs and constructors.
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Sample files by Juliette Gribnau are in the 'Data\Juliette Gribnau' folder.
Sample files by Markus Vogt are in the 'Data\Markus Vogt' folder.
Dirk Monteny has provided 42 sample files, described in the next topic
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2.33 Dirk Monteny's sample files
Dirk Monteny was a talented artist with a gallery of mostly XenoDream work at Renderosity (http://
www.renderosity.com/mod/gallery/browse.php?user_id=174399). He has provided a selection of parameter files
and some notes on their use. The files are located in the 'Data\Dirk Monteny' folder. Note that he achieves the high
quality images shown in his gallery by rendering at typically 6000x4000 and resampling, and the lighting may vary
from the xep files included.
Sierpinski constructions
These shapes are made with all iterators and usually no metamorphs.
They have the structure of blocks that repeat themselves with fine
details. The general guideline is to rotate holons only around Y, or to
rotate or skew 180 degrees for inversion. Adjust scales and positions
in each direction to avoid overlapping blocks, instead having the
holons either fit together exactly or leave gaps.
'20061109Sirps01.xep'
First example
'20061109Sirps02.xep'
This one shows how to place little corner towers
'20061109Sirps08.xep'
A variation; the rest, as they say, is easy ;-))
'20061109Sirps15.xep'
And a last one, giving you 45 degree corners
Note: with more holons arranged horizontally you can create more
expansive buildings, and even whole cities, by reducing horizontal
scales to create gaps at ground level and some Free holons to
change the pattern.
An example is 'Data\Artificial\Antares castle 1.xep', although it has no
gaps at ground level.

'20061109Sirps15.xep'

Building construction
The principles are similar to Sierpinski constructions, but most holons are flattened or elongated to make them
into rough panels or planks.
'20061105constructions01list.xep'
These may look a little daunting at first, not least for the amount of holons involved. But I assure you, it's all quite
straightforward, really. This first file contains the basic shape out of which my cathedral-like objects came about. I
hid holons 133 to 142. Click them on again one by one, and you will see the object grow.
'20061105constructions03.xep'
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The second file. We make an extension, a floor and a roof. Look at the new holons and understand how the
positions work. Note that, except for the roof, we never use rotations, instead we change the XYZ scales and
positions. This thing already starts to look like a building.
'20061105constructions04.xep'
Here we extend the floor and roof once more, we lose some holons and we build a single tower. Again, it's all just
a clever placing and adding of "empty" holons (holons without metamorphs). Look at it carefully and you will
understand the procedure.
'20061105constructions06.xep'
A different view, with some more extensions, and we resized and slightly replaced holons 160 to 163 to give us a
smaller top at our tower. I hope you are still having fun ;-))
'20061105constructions07.xep'
And the last file, this time with a double tower and some more adding and deleting of holons. I guess that with this
technique, you should be able to construct just about every geometric shape or building you can imagine.
A temple
This is a step by step approach to a complex building, with
constructors for some elements.
'20060709temple.xep'
How to build your own temple, step by step. This first file shows
the basic design. We will progress from there.
'20060709temple-0001.xep'
Now were are going to add some battlement.
'20060709temple-0002.xep'
We give some support for the battlements
Tem ple-0004

'20060709temple-0004.xep'
We work on the windows, leaving 4 doors open, and give them
some steps
'20060709temple-0007.xep'
We create a mirror image, underneath our temple, and add some pathways inside
'20060709temple-0008.xep'
We give some colour and texture to the "floor" on which the temple rests.
'20060709temple-0014.xep'
Now we add some texture to the columns and work a bit more on the pathways inside the temple.
'20060709temple-0015.xep'
We give texture to the arches
'20060709temple-0019.xep'
How to create an interesting pattern, on the flat spaces between the arches
'20060716templeFIN-0001.xep'
And a final view , combining your temple with others. Use a background to your own liking. I hope this was not too
difficult to follow. And feel free to develop your own versions of this style.

88

Using XenoDream v2.7

A castle
'20060718thetower-0010.xep'
For those who want to play with castles and towers in XD, here's a pretty basic file for a fantasy tower. Feel free to
change, improve and post your versions. Many of the elements are hidden unless you release the Hide Holon
button.

Life spirals
'20070116 life series 1.xep'
Here are some xep's from my 'life' series. As you will notice, I use
always the same basic spiral. It's the lighting and the creation of
'textures' that make the difference.
'20060207starsailors01.xep'
More of a flowerlike design.
'20060207starsailors14.xep'
Here I created a more 'cracked' like structure to the flowers.
'20060207starsailors16.xep'
This one has a more organic look
'20060207starsailors20b01.xep'
And a weird looking plant.
Still life
'20060930stilllife03.xep'
The making of a still life; how to create apples, eggs, oranges,
candles.
'20061004stilllife05.xep'
Second still life. How to make that basket, vases and
"nutty" (LOL) things.

Ukiyo-e style

Creating Objects
This is a Japanese style of art.
'20061115japan05.xep'
Create a background for these, could be in XD or Photoshop, whatever. Most
important about this style, is not to cast shadows. The lighting I use is very
efficient to get a decent 2D graphic style image.
'20061119japan08.xep'
Use soft gradients in the background, it gives the work a serene and balanced
feel.
'20061123japan11e.xep'
If you want to get in to this style, remember to give lots of "empty" space in
the background, to balance your composition.
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Backgrounds

The main focus of XenoDream is creating objects. When you render them in XenoDream (as opposed to exporting
them as meshes) they have a black background by default. It's easy to change the color, but often you will want
some other background. Backgrounds can be included when you apply lighting, or they can be merged using layer
effects in the Picture window. In this section we will look at the options for background content.
Methods you can use after rendering the foreground object:
Lighting may include haze, which can have simple fog or cloud effects.
Expand the object's edges outwards using the hole filling option
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in the Lighting window.

Methods for either before or after rendering a foreground object:
Open a picture from a file to use as the background.
Create color patterns based on metamorphs, using the Background Creation mode
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in the Color page.

Create textures using the Pic Texture filter 96 in the Picture window Effects menu. This was first designed with
skies in mind, but can also do simple gradients, rocks, water effects and much more. There are some more tips
for creating textures in Advanced Pic Textures 98 .
Methods that need to be used before rendering the foreground object:
Add a plane or other surface to the object to serve as a back-plane that can have shadows cast onto it. The
back-plane can have a texture or picture mapped onto it.
Render one or more objects to fill the window and copy them to the background picture before rendering the
main object. Rendering with transparency is useful for this. One option is to render the same object zoomed in,
perhaps in different colors, with transparency and perhaps apply some blur to it. Fractal clouds also make useful
backgrounds; either from this random fractal cloud tutorial 94 or opened from a file.
See also Combining backgrounds with objects

128

for a method of casting shadows onto backgrounds.
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3.1 Hole filling backgrounds
The Lighting window has some controls in the Surface Cleaning panel for filling holes. With settings of 5 or more,
they can be used to expand the object outwards to partially or completely fill the background. The new colors and
depth are averaged from the nearest pixels in the object.
The steps are as follows:
1.
2.
3.

Render the object.
Open the Lighting window.
In the Surface Cleaning panel, set Holes to 5 or more.

4.
5.

Ctrl-click the Fill Holes button
, and wait for it to finish.
Apply lighting, unless you only want the Unlit picture.

A setting of 5 will usually not fill the whole background. You can fill again with a higher value to complete it. You
can also stop the filling by clicking the Fill Holes button before it finishes.
Use 5 to 7 for smooth diffusion, or 8 for solid areas and strong diagonals.
Here are examples using a torus with Fbmrad as the second metamorph.

Original object, w ith lighting.

Filled w ith Holes 6, Unlit picture

Filled w ith Holes 6, lighting applied

Filled w ith Holes 8, lighting applied

An expanded range of possibilities is possible by using negative values for Holes. This works more like cellular
automata, specifying the exact number of neighbors allowed by using a binary mask. See the main help file for an
explanation of how the numbers work.
Undo for the depth map
There is no direct undo option for changes to the depth map, but you can save the depth map before filling holes
(or applying any other surface cleaning tools, or using the Depth window), and reopen it from the file if you want to
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start again. This is very useful if you want to try out different hole filling values.
To save the depth map: In the Picture window File menu, choose Save Depth Map... and in the Save Dialog,
choose PGM files and type a filename. When prompted to set the base at the back of the object, choose Yes
(for best resolution).
To open the depth map from the file: In the Picture window File menu, choose Open Depth Map... and select the
file you saved previously.
You will most likely want to delete the depth map file once you no longer need the undo option, unless you're
using it for other purposes.

Note: hole filling can be used in stereo mode but the depths and patterns are not correlated across the images, so
the results will usually be unsatisfactory.
Tip: you can use the Polish filter in the Lighting window after filling holes, to smooth out fine serrations that often
occur.

3.2 Background creation mode
Background Creation mode lets us produce
geometric or abstract patterns directly in
the Background picture, using the active
holon's metamorph coloring. It can be
enabled on the Color page when the
Metamorph coloring method is in use.

For this tutorial we will start from scratch. Sometimes you may want to use this method after rendering an object.
Then you may find it convenient to add a holon, make it free and hidden, and use it for creating the background
pattern. Then it can be saved along with the object without affecting it.
1.
2.
3.

Click the File New button
in the Standard toolbar.
Go to the Color page.
In the Coloring Method dropdown box, choose Metamorph. The Background Creation controls are at the
bottom of the metamorph coloring panel:

4.
5.

Click the Background Creation Mode button
. As long as this button is down, the preview shows a
background pattern created from the active holon's parameters, and does not show the object.

Click the Gradient Preset button
to open the Custom Gradient Preset window. Choose the 'Basic
stripes' category and the 'Malachite ripple' preset, and click OK to close the preset window.
6. Go to the Shape page.
7. Click the second Style button, and select 'Ripplet' in the Radial category. We will leave the first metamorph
free for later.
8. Uncheck Reposition for both metamorphs. This is necessary for holon position to have an effect (some
controls work kind of backwards in this mode.)
9. Set the Z Position to 30. Some of the radial styles are more interesting when the position is not zero.
10. Set the second metamorph's Special to 10. This makes a fairly busy pattern, similar to the first picture
above.
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11. Click the Create Background Picture button
to create the background picture. There is one on the
Shape page for convenience, as well as one on the Color page. The Picture window appears and the
background picture is created. Let's see how it looks with anti-aliasing.
12. Return to the Main window and go to the Color page.
13. Set the AA control to 2 (located beside the other background creation controls).
14. Click the Create Background Picture button
the result is much smoother.

. It takes about 8 times as long to update the picture, and

Next we will see how two metamorphs work together. In this mode, the first metamorph warps the second, or
'drives' it.
1.
2.
3.
4.
5.
6.
7.

Return to the Main window.
On the Color page, reduce the first Meta Pattern from 3.0 to 1.0, for a smoother pattern.
Go to the Shape page.
Change the second metamorph to 'Nubble' in the Radial category.
Click the first Style button, and select 'Gnarl' in the Iterated category. It has no effect on the Nubble pattern
while Amount is 0.
Set the first metamorph's Special to 2.
Increase the first metamorph's Amount (in steps of about 1, up to 20) and notice the effect in the preview.
With a setting of 10 the result should be like the second picture above.

Note: you can use Background Creation Mode for simple linear gradients by either selecting a holon with no
metamorphs, or setting Map From to 'World space'. Adjust the first two Meta Pattern controls for X and Y
scaling.
Avoid metamorphs in the Constructor, Tile and Fractal categories for background creation, because they almost all
produce noise.

3.3 Random fractal clouds
Here is a routine for making fractal clouds from randomized holons. It can be useful for sky backgrounds that are
different from the types you can make in the Pic Texture filter. Since it involves rendering objects, it's not suitable
for making a background after you've rendered the foreground object (unless you are saving PSD files and layering
in another program).
Making cloud shapes
Note: you won't see anything in the preview until step 10.
1.

Click the File New button
Shape tab.

in the Standard toolbar. If you're not already on the Shape page, click the

2.

Click the Preview Mode button

3.
4.
5.

Click the Transparent Preview button
to make the preview transparent.
Set the X, Y and Z Scale parameters to about 50.
Click the Clone Holon button in the Holon toolbar seven times, for a total of eight holons.

6.
7.

Click the Select All button
, to select all the holons.
Set the Drag Mode to Rotate.

8.
9.

Click the Random Sequence button
Set the Drag Mode to Position.

10. Click the Random Sequence button

to set it to Color mode instead of Gray mode.

to randomize the rotations.
to randomize the positions. Optionally click the Center Holons
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button
, or adjust the holon Position parameters, or drag in the Holon window.
11. Repeat any of the previous four steps to make different cloud shapes. It is easiest to try out a number of
random rotations, then a number of random positions, etc.
12. Experiment with higher or lower Scale parameters, either keeping the three values equal or varying them.
13. Save the best cloud shapes to Shape Memory Spots.
Rendering the clouds
1.
2.
3.
4.

Go to the Rendering page.
Set Holon Opacity to between 5 and 10.
Click the Picture button on the toolbar to show the Picture window.
Click on the Background Color rectangle on the toolbar, and choose a suitable sky blue from the color
picker dialog.

5.

Click the Render New button

6.

When the clouds look thick enough, click the Stop Render button

.
.

Adding layers of clouds
By making new clouds and clicking Render More
, you can blend different clouds together. However, that
doesn't give you any undo option if the new cloud doesn't work out. Using the Background picture is more flexible,
as follows:
1.
2.
3.
4.

5.
6.
7.
8.
9.

Click the Copy/Merge button
Background picture.
Return to the Main window.

and click OK, to merge the Unlit picture and Background Color to the

Click the Preview with Background button
in the Preview toolbar. This makes it easier to arrange the
clouds together.
Either restore a different cloud from a Shape Memory Spot, or continue randomizing to create a different
one, to find a good combination with the background. Drag in the Preview window to reposition the cloud as
required.
Click the Render New button on the toolbar.
As soon as the new cloud has the right density, click the Stop Render button.
If you don't like the new cloud, return to the Main window and repeat the preceding three steps.
To merge the new cloud into the background layer, click the Copy/Merge button and click OK.
Continue adding more clouds if desired.
Another option is to change the colors of each cloud layer before rendering.
Lighting clouds is possible, but light sources can be tricky because they use surface angles, so you are mostly
restricted to adjusting ambient intensity and color, glow and haze.
Some Gaussian Blur can also improve the appearance.

Here are two examples; one with three layers, and one with two.
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3.4 Pic Texture filter
The Pic Texture filter is a 2D texture generator located in the Picture window Effects menu. Textures are made of
one or more layers. Each layer can have several elements combined together to produce color and opacity. In
general you combine a contour (simple shape) and noise together, distort with turbulence, and choose a gradient.
You can also change the perspective and direction. The simplest textures have just a contour and a gradient; like
a gradient fill but more flexible. So that's where we will start.
First you need to select the picture you want to apply the texture to. Usually this is the Background picture.
1.
2.
3.

Go to the Picture window.
In the File menu choose New Background Picture.
In the Effects menu choose Pic Textures.... The Pic Texture editor window opens. Initially it has one layer
enabled, and the default settings have only the contour and gradient active.

4.
5.

Click the Zoom Preview button
under the Preview window to see the whole picture.
The layer elements have panels down the right side of the window. The Gradient panel is second from the
bottom. It has an Opacity control that adjusts relative opacity for the layer. Increase Opacity to 150 to stop
the existing picture from showing through. Now the preview should show a ramp from white to black, matching
the default gradient.

6.

In the Gradient panel, click the Gradient Presets button
. Select the 'Sky split' category and choose the
'Orange earthsky 1' preset.
In the Contour panel, set the Shape dropdown to Ellipse. At first it is more like a double sided ramp. Click

7.

8.
9.

the Set Defaults button
to set the Slope parameters for a circle. Experiment with the Top, Bottom, Left
and Right settings.
Now try the other Shape options, and experiment with the Top, Bottom, Left and Right settings with each
shape.
To continue, set Shape back to Ramp and Click the Set Defaults button

.

Now we will see how to use turbulence to warp the shape. In the Turbulence panel there are two turbulence
sources that can be combined. The first is a single pattern, while the second allows several octaves (copies at
higher frequencies) to be combined. We will use the second turbulence because it is more powerful, and only use
the first one when we want both.
1.
2.
3.

In the Turbulence panel set the second Amount to 80. Perlin noise gives a smoothly varying random warp.
Increase Freq to 3 for greater variation. The result is the first example below.
Now increase Octaves one at a time, to add higher frequencies to the turbulence. Above 6 octaves the
difference is too small to be seen in the zoomed preview. The result is the second example below.
With the default settings for the octave Ratio and Roughness, each octave doubles the frequency and halves
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the amplitude. This is good for many purposes but sometimes you want to change them. With Octaves set to
6, increase Rough to 0.8. The result is the third example below.
Set Rough back to 0.5. In the second turbulence dropdown box choose Gnarl from the list. Try different
combinations of Amount and Octaves.

Perlin Freq 3 Octaves 0

Perlin Freq 3 Octaves 6

Sam e; Rough 0.8

Gnarl Freq 3 Octaves 3

With the complexity that even single layer textures can have, it is often convenient to use presets rather than start
over. You can use presets as they are, tweak them a bit, or use one or more layers as starting points for a new
texture. You can save your own textures as presets. Next we will take a look at texture presets, tweak one of
them and apply it.
1.
2.
3.
4.
5.
6.
7.
8.

Click the Pic Texture Presets button
(located under the preview, not in the Gradients panel) to open the
Pic Texture Presets window. You may need to resize this window to suit your system.
The categories of presets are listed on the left. Click on each category to see the presets in it.
In the Gradients category, select the 'Cross' preset and click OK to close the presets window. We will add
some turbulence to it.
In the Turbulence panel set the second dropdown box to Zigzag.
Increase the second turbulence Amount to 150.
Increase the second turbulence Freq to 20.
Increase Octaves to 5. This is the effect we want.
Click the Apply button at the lower left of the window. The progress bar above it shows progress until the
finished picture appears in the Picture window. Textures usually replace the existing picture completely so
you can apply any time to check the result without closing the window. But sometimes that is not the case
and you will want to get it right before applying. You can release the Zoom Preview button to examine the
result in detail, to be sure it's ready to apply.

The Cross preset

Tip: using simple gradients

Turbulence: Zigzag, Freq 20

With 5 octaves
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Sometimes you just want a simple gradient. Here is a quick way.
1.
2.
3.
4.

Click the Pic Texture Presets button
.
In the Gradient Linear category, select a preset ('Blue scroll' only if you want symmetric, otherwise choose
another.)
To change the gradient: in the Gradients panel, click the Gradient Presets button and choose a gradient
preset. Edit it if you want.
In the Global panel, adjust Scale and Direction if necessary.

Using picture frame presets
The Pic Texture presets include a category of picture frames by Christina Bartsch. In most cases you apply
textures to the Background picture to use as a background for layers or lighting. Picture frame textures can be
used that way, but sometimes you may need the frame to cover part of the rendered object. In that case, apply it
directly to the Lit picture after you have applied lighting.
The picture frame presets are designed so you can easily replace the gradients. There are versions for several
aspect ratios for common picture sizes, so you don't always have to adjust the Contour panel Top, Bottom, Left
and Right settings to get equal frame widths. If you need a portrait orientation you can just swap these settings
around, or adjust them for different aspect ratios.

3.5 Advanced Pic Textures
This chapter has some general tips for exploring presets, and specific tips for making clouds, copying texture
layers, adding grain to textures, and using stencil layers.
One way to learn more about making textures is to explore presets. After opening a preset, notice how many
layers it has. Try disabling and enabling each layer to see what it contributes to the texture. (In general, layers are
independent, but the exception is when layers have the Combine mode other than Normal in the Gradient panel.)
After isolating a layer of interest, identify which features are active:
In the Spatial panel, any non-zero control is affecting it.
In the Contour panel, if the Height is not zero, the contour is active.
In the Turbulence and Noise panels look at the Amount controls.
In the Gradient panel, notice the Opacity control, the Bump control and whether Picture is checked.
Once you can see which features are active, notice which controls are not at default values and experiment with
them.
Ways to make clouds
There are lots of presets for skies with clouds in them. The clouds are made in a variety of ways, so here is some
explanation.
There are two basic ways to get a cloud effect.
1. A contour shape (typically Ramp or Ellipse) distorted by turbulence; usually Perlin with octaves set to at least
3.
2. Noise (usually Perlin) with octaves set to at least 5. (This can also be distorted with turbulence.)
Each of these can use gradients in two ways.
1. 'Fake opaque': a gradient with both sky and cloud colors. This can be very effective visually. However, it isn't
useful for a layer in front of other layers unless clipped by a perspective horizon.
2. Transparent: a gradient using cloud colors. The Opacity is set so that the noise and/or turbulence determines
where the lower layers show through. (The gradient may include other colors, but have the Strength and
Cycle controls set to use either a single color or only part of the gradient.)
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Tip: when using a cloud layer with strong perspective, you can usually change the appearance of the clouds near
the horizon by adjusting the Contour panel Height, Top and/or Bottom controls. It is often desirable to have some
fadeout near the horizon for clouds or a sea or ground plane.
Copying and pasting layers
You can copy a layer from a preset to another texture by using the memory spots.
1. If you are already working on a texture that you want to paste layers into, save it to a Texture Memory Spot
(the group on the right).
2. Open the texture preset.
3. Select the layer to copy, by clicking the numbered Layer button.
4. Click on an empty Layer Memory Spot (in the group on the left).
5. Restore your texture from the Texture Memory Spot.
6. Select the first unused layer by clicking its numbered Layer button.
7. Restore the Layer Memory Spot containing the layer from the preset. This also enables the selected layer.
8.

If desired, move the layer to a lower position by clicking the Move Layer Left button

.

Adding noise or grain to textures
Sometimes you may want to add some fine texture to a layer, perhaps to make it sandy, grainy or noisy. Here is a
way to do that, by combining a high frequency pattern layer with the layer above it.
1.
2.
3.
4.

First set up the 'target' texture layer that you want to add some grain to.
In the target layer's Gradient panel, set the Combine mode to Add instead of Normal.
Make a new layer below the target layer. (Just enable the next unused layer and click the Move Layer Left
button to move it below the target.) We will refer to this as the 'grain' layer.
In the grain layer's Noise panel, set Freq to at least 20, set Amount positive, and adjust the other controls to
make the kind of pattern you want. Adjust Amount for the strength of the grain.

Before applying, release the Zoom Preview button and adjust the grain layer's noise frequency to suit the picture
size, or to fine tune the pattern. High frequency noise can have a lot of aliasing and the result can depend on the
exact frequency or aspect ratio.
Example presets in the Textile category are 'Grainy Dark' and 'Grainy Denim'.
Using a layer as a stencil
A layer can act as a stencil to make holes in the layer above. This is achieved with the top layer's Combine mode
set to either Multiply or Min, and suitable settings for Opacity in both layers. To get sharp boundaries, use high
values for Noise Amount in the stencil layer.
Example presets using three layers (background texture, stencil layer and top texture) are in the Tile Patterns
category: 'Granite stones', 'Marble agate inlay', and 'Marble parquet tiles'.
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Pictures and Lighting

The Picture window provides flexibility in combining the 3D and 2D aspects. It is the hub for rendering and lighting,
and also allows layering, filtering, and opening and saving pictures and depth maps.
The Pictures and layers 102 topic describes how layers work, and gives an overview of saving and opening pictures,
and copying and merging layers.
Filter effects 102 shows how combinations of filters can change the appearance of textures or pictures. This
illustrates creative uses. In general you can use filters for modifying background pictures, pre-processing the
rendered picture before lighting, or post-processing the lit picture.
The other topics in this chapter cover lighting.
Basic lighting 104 introduces general and metallic lighting presets, and editing lighting.
Glass and transparent lighting 106 shows how to get glass effects for both opaque and transparent renders.
Ceramics and multiple lighting 108 introduces ceramic presets, and explores several techniques for combining
different lighting.
Multiple render techniques 111 discusses issues and methods for combining renders, especially where opaque and
transparent holons are involved.
Surface cleaning and other issues 113 shows some of the challenges that can occur with rendering and lighting,
and ways to improve the results.
Shadows 116 gives advice for setting up shadows before rendering, and using them in lighting.
Lighting with regions 120 shows how to divide an object into parts with different lighting effects.
Depth of field 123 shows how to use the DOF filter to simulate camera lens effects after lighting has been applied.
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4.1 Pictures and layers
The Picture window manages up to three pictures, a depth map and optionally an alpha channel for transparency.
They always have equal dimensions.
The Unlit picture always exists. It is created by rendering, and used for lighting, along with the depth map and
alpha channel.
The Lit picture is created by lighting.
The Background picture may be created in various ways, and may be used for lighting or layering.
One or two layers may be used at a time.
The front layer may be the Unlit or Lit picture (or neither, when working with the Background picture.)
The back layer may be the Background picture, or a plain background color.
You choose layers by clicking or releasing the toolbar buttons for the three pictures.
There are two masking options for the layering:
The Background Mask button uses the depth map as a binary mask between object and background.
The Alphablend button uses the alpha channel to blend between front and back layers.
You can also adjust the opacity of the front layer, and use various merge modes.
Saving pictures
When you save a picture, the principle is WYSIWYG. Set the layering to show what you want before saving.
If you choose BMP or JPG format, the layers are automatically combined into a single image in the file.
If you choose PSD (Photoshop) format and any layer options are in use, the layers are preserved in the file.
If you choose PSD format and no layer options are in use, you are asked if you want to save layers. If you
choose Yes, the Background Mask button is used for masking. If you choose No, only the active picture is
saved.
If you choose TGA format, the file includes an alpha channel that is made from either the alpha channel if it
exists, or from the background mask.
If you want to save your picture with a transparent background for layering in other programs, choose PSD format
with layers.
Opening pictures
You can open a BMP, JPG or PSD file and choose the Unlit, Lit or Background picture as the destination. Some
reasons to open a picture are:
To use a background picture with lighting or layering.
To create a depth map from the picture colors using the Depth window, then apply lighting to it.
To replace the colors of a rendered object with a picture.
Copying and merging layers
Sometimes you will want to copy one picture to another, or merge layers into one of the pictures (usually the
Background picture.) This is also WYSIWYG. First select the source picture, or the layers that you want to
combine. Then click the Copy/Merge button in the toolbar (or the Copy/Merge... option in the Edit menu). The
dialog describes the source layers and lets you choose the destination picture.

4.2 Filter effects
The Effects menu provides filters for various kinds of image manipulation. Some are more versatile than the names
suggest. In this chapter we will experiment with combinations to modify textures.
1.

Go to the Picture window.
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In the Effects menu, choose Pic Textures... to open the Pic Texture editor.

3.

Click the Texture Presets button
. Select the Plasmatic category and select the 'Aerial map 1' preset.
Click OK to close the preset window.
4. Click OK to apply the texture and close the Pic Texture editor. The picture should be filled with the texture.
5. In the Effects menu, choose Remove Noise...
6. Set Iterations to 20 and Amount to 100, Lighten to 0, uncheck Mono, and click OK to apply it.
7. In the Effects menu, choose Remove Noise...
8. Set Iterations to 20, Amount to -90 and check Mono, and click OK to apply it.
9. In the Effects menu, choose Gaussian Blur...
10. Set Width to 20, Amount to 20 and Lighten to 2, and click OK to apply it.
Here are portions of the picture at each step:

Now we will start with another texture.
1. In the Effects menu, choose Pic Textures... to open the Pic Texture editor.
2.

Click the Texture Presets button
. In the Tile Patterns category select the 'Bathroom tile 1' preset. Click
OK to close the preset window.
3. Click OK to apply the texture and close the Pic Texture editor.
4. In the Effects menu, choose Remove Noise...
5. Set Iterations to 20, Amount to 50, Lighten to 6 and check Mono, and click OK to apply it.
6. In the Effects menu, choose Gaussian Blur...
7. Set Width to 2, Amount to -52, Lighten to 0, and click OK to apply it.
8. In the Effects menu, choose Gaussian Blur...
9. Set Width to 25, Amount to -76, and click OK to apply it.
10. In the Effects menu, choose Remove Noise...
11. Set Iterations to 15, Amount to 20, Lighten to 0 and uncheck Mono, and click OK to apply it.
Here are portions of the picture at each step:
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4.3 Basic lighting
This topic starts by introducing some of the lighting presets, and follows with some important advice about the
presets. Then we start editing the lighting.
Introduction to lighting presets
1.
2.
3.
4.
5.

6.
7.

8.
9.
10.
11.
12.

13.
14.

In the File menu choose Open Sample File... and navigate to the Tutorials folder. Select 'Tovestorus' and
click OK to open it.
Click the Render New button in the Rendering toolbar.
Click the Lighting button to open the Lighting window.
Scroll the lighting preview to an interesting part of the picture. It will be a bit rough until it has rendered longer.
Click the Lighting Presets button
to open the Lighting Preset window. You can keep this window open
while you adjust lighting, so you will want to arrange the windows so you can see the lighting preview and as
much of the Lighting window as your screen size allows.
Select the 1.6 Basic category, and select the 'B/W soft' preset.
Scroll around the lighting preview to check the surface quality. It should be reasonable when the Picture
window render rate is below about 1500. When it is, click the big Stop button in the lower left of the Lighting
window to stop rendering (it is easier than stopping in the Picture window and switching back to the Lighting
window.) The button changes caption to Apply.
Click the Apply button to apply lighting. This picture is an example of lighting that overrides any colors in the
object.
If the Lighting Preset window isn't visible, click the Lighting Presets button
in the Picture window toolbar
to bring it to the front.
In the Lighting Preset window, select the 'Overcast' preset. Click the Apply button to apply it.
In the Lighting Preset window, select the 'Sunlight outdoors' preset. Click the Apply button.
In the Lighting Preset window, select the 'High gloss' preset. Click the Apply button. Notice that the shiny
surface includes reflections, but they are messy because the surface isn't smooth enough. The best way to
get a very smooth surface is with the Polish filter.
Click the Lighting button to show the Lighting window.
In the Lighting window, in the Surface Cleaning panel, set the Polish control to 9. Click the Apply Polish

button
(on the right of the Polish control. It takes a while to update the depth map, so the progress
gauge under the lighting preview shows you when it's done.
15. Click the Apply button. Now the reflections and highlights are much cleaner, so it looks shinier.

Pictures and Lighting

B/W soft

Overcast

Sunlight outdoors
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High gloss

Now we will look at some metallic effects.
16. In the Lighting Preset window, select the 1.6 Metal category, and select the 'Aluminium' preset. Click the
Apply button.
17. You may notice that the reflections are slightly colored, because they used the already lit picture as the
source. Go to the Lighting window and notice that the lighting preview now shows pure gray reflections,
because the lit picture is now aluminium. You could apply lighting again to get the more pure result, or you
may prefer the slightly colored reflections. Reflection and refraction will usually use the previously lit picture as
the source, so keep in mind that they depend on the previous lighting. If no lighting has been applied yet, the
reflections will be missing, so it's a good habit to apply lighting twice if it includes reflection or refraction. If the
effects are strong, it may be worth applying more than twice. In other topics we will explore more creative
techniques using reflection and refraction.
18. In the Lighting Preset window, select the 'Copper 1' preset and apply it.
19. Try out the other presets in the 1.6 Metal category. In general they ignore the object's coloring to achieve the
desired metal appearance, but some of them will vary a bit with the coloring.

Alum inium

Copper 1

Gold shiny 1

Rosw ell 1

You will certainly want to explore all the lighting presets, if you haven't already. When it comes to using them,
there are a few things you should know for best results. Each preset can look good in some contexts and not in
others, depending on the complexity of the object, whether it has curved or flat surfaces, the depth of the object,
background colors, etc. That may tempt you to try out lots of presets. You can save some time by starting with
the 1.6 categories. Most of the other presets were created in v1.0 for pure fractals or novelty value, and many of
them have issues affecting geometry and object quality. You might want to avoid such presets except where it's
necessary for specific effects (such as pencil or ink simulation, or post-processing imported pictures). Here are the
guidelines:
For correct geometry, in the Depth panel: Depth 20, Extra off, True on.
For best resolution, in the Depth panel: Fine on; in the Light Sources panel: all lights have Smoothing 0.
They are discussed further in Surface cleaning and other issues
Editing lighting
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No matter how many presets you have, there are times when you want something different. For example, the light
angles or shadows don't suit the object, the coloring or intensities aren't ideal, you want a different material or
other minor adjustments, or you want novelty.
Many of the adjustments you are likely to make will be in the Light Sources panel: light position, intensity and
color, and the diffuse and shininess properties.
1.
2.
3.

4.

5.
6.
7.
8.
9.

In the Lighting Preset window, select the 1.6 Basic category and the 'Matte' preset. This uses purely diffuse
lighting, with a bit of ambient.
Scroll the lighting preview to show the center left of the object.
In the Light Sources panel, the lighting ball represents the lights and their effect on a sphere. You can select
lights by clicking on them, or by using the # control on the right. Set the # control to 0 to select ambient light,
then from 1 to 3, noticing the Intensity setting for each light. Light 1 is the dominant light. (It is usual for the
strongest light(s) to cast shadows, and useful to have one or more 'infill' lights to lighten the shadows.)
Select light 1. Increase the Intensity and notice that some of the lighter parts of the center of the object start
to saturate to white. As you increase it further, the outer ring starts to saturate yellow and lose shape.
Reduce Intensity until there are no more saturated areas.
Select light 0 (ambient). Adjust the Intensity up and down to see the effect. Too much ambient light creates a
washed out effect. Negative values can be used to balance excess light from other sources.
Select light 1. Click the Sync button. When this is down, you can edit the material controls for all lights at
once.
Adjust the Diffuse Color control. This determines how much the object's coloring filters the diffuse light. At 0,
diffuse light ignores the object's coloring, and negative values invert it. Set it back to 100.
Reduce the Diffuse % control. As the amount of diffuse light is reduced, highlights appear, creating a shiny
surface. Set Diffuse % to 20.
Adjust the Shininess control. This sets the size of the highlights.

Shiny surfaces are most realistic if they have some reflection as well as highlights, and a background color or
picture to give something to reflect other than the object itself. One of the challenges for effective lighting is to keep
the intensities in balance. This is mostly between ambient light, diffuse lights, reflection, refraction and glow.

4.4 Glass and transparent lighting
In this chapter we explore glass effects, first with opaque rendering and then with transparent rendering. Convincing
glass effects require a background other than black, to allow reflection and refraction. Pictures or textures work
better than solid color.
1.
2.

In the File menu choose Open Sample File... and navigate to the Tutorials folder. Select 'Bauble ring' and
click OK to open it.
Click the Render New button in the Rendering toolbar. Let it render to 1500 and click the Stop Render

3.
4.

button
.
In the Picture window File menu, choose New Background Picture. A blank background picture is created.
In the Effects menu, choose Pic Textures... to open the Pic Texture editor.

5.
6.
7.
8.
9.

Click the Texture Presets button
. Select the Sky Summer category and select the 'Lazy afternoon'
preset. Click OK to close the preset window.
Click OK to apply the texture and close the Pic Texture editor. The picture should be filled with the texture.
Click the Lighting button to open the Lighting window. Scroll the lighting preview to show part of the object.
In the Glow, Haze and Background panel at the bottom of the Lighting window, set the Background Source
dropdown to the Back Picture option.
Click the Apply button to apply the default lighting with the background picture. Now we will try glass instead.

10. In the Lighting window, click the Lighting Presets button

. In the Presets window, select the 1.6 Glass
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category and select the 'Glass clear' preset.
11. If you scroll the preview to the lower part of the object you will see that it isn't very smooth. In the Surface
Cleaning panel, set Polish to 9 and click the Apply Polish button
.
12. You will also see some golden colors in the object because the reflection source is the Old Lit Picture, which
currently has solid coloring. There are several ways to get a cleaner lighting when using Old Lit Picture as a
source. One is to apply lighting at least twice, but it can still keep some residual colors, or build up highlights.
Another is to set the reflection or refraction to 0 and apply lighting, then restore the values and apply again.
This can work well, but sometimes the initial lighting is too dark. A third way is to change the source to Back
Picture for the first lighting, then set it back to Old Lit Picture and apply again. This is convenient and usually
works well, so we will do it.
13. Set the Reflection Source dropdown to Back Picture, and click Apply to apply the glass lighting.
14. In the Lighting window, set the Reflection Source dropdown to Old Lit Pic, and click Apply again. Now the
object looks like clear glass.
15. Try some of the other presets in the 1.6 Glass category, applying each one twice before trying another.

'Glass clear'

'Glass m ilky'

'Glass green dark'

With opaque rendering, these glass effects do a reasonable job without showing any internal structure. Now let's
try with transparent rendering.
1.
2.
3.
4.
5.
6.
7.
8.

Return to the Main window and go to the Rendering page.
Set the Holon Opacity to 6.
Click the Render New button. When the render rate is down to about 1200, stop the render.
Click the Lighting button. As before, the surface needs to be smoother.

In the Surface Cleaning panel, set Polish to 9 and click the Apply Polish button
.
In the Lighting Presets window, select the 1.6 Transparent category and select the 'Glass clear t' preset.
In the Reflection and Refraction panel, uncheck Translucent.
Click Apply to apply the lighting, then apply it again. The internal structure of the glass is visible, but not
much surface character.
9. Check the Translucent option. The surface is a bit bright, so increase the Gamma to 2.0 (in the Alpha panel)
to increase the opacity of the glass.
10. Apply the lighting twice. The result is similar to the clear glass with opaque rendering, but shows internal
structure.
11. Try some other glass presets in the 1.6 Transparent category, applying each one twice before trying another.
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'Glass clear t', Translucent off

'Glass clear t', Translucent on

'Glass green t'

The Translucent control and other alpha options are not included in the presets, because they are specific to
rendering choices and preferences. You can use any presets with transparency, and they will often need
adjustment depending on how long you render them and whether Translucent is on. With many presets,
translucency will make the surface too bright. You can balance this by some combination of reducing the Diffuse
% for all lights, increasing Gamma, reducing Refraction, or adjusting Glow or ambient intensity.
The 1.6 Transparent category also includes presets for ambient lighting. For some transparent renders you may
want to emphasize the transparent aspects without any other light sources. For this, all you need is ambient light,
and it can be useful to adjust the Gamma and Brightness controls in the Alpha panel, and the Saturation, Contrast
and Glow controls.

4.5 Ceramics and multiple lighting
In this chapter we look at ceramic material effects, individually and in combinations. Then we look at other
techniques for combining lighting. In general, these methods work best for objects with fairly smooth surfaces.
1.
2.
3.
4.
5.
6.

In the File menu choose Open Sample File... and navigate to the Tutorials folder. Select 'Pyrosculpture' and
click OK to open it.
Click the Render New button in the Rendering toolbar. Let it render to about 1000 and click the Stop
Render button
.
In the Picture window File menu, choose New Background Picture. A blank background picture is created.
In the Effects menu, choose Pic Textures... to open the Pic Texture editor.
The 'Pyrosculpture' file includes a texture, so you can just click OK to apply it. (Or if you prefer, choose
another from the presets.)
Click the Lighting button to open the Lighting window. Scroll the lighting preview to show part of the object.

7.

In the Surface Cleaning panel, set Polish to 9 and click the Apply Polish button
is shiny and looks much better with a smooth surface.

8.

In the Lighting window, click the Lighting Presets button
. In the Lighting Presets window, select the 1.6
Ceramic category and select the 'China aquavitreous' preset. (If the My Presets button is down, release it to
show the system presets.)
Click Apply to apply the lighting. When it finishes, apply it again. The second time is needed to get the
reflections right. The aqua coloring comes from the iridescence settings.
In the Lighting Presets window, select the 'Porcelain' preset.
Apply it twice. This preset is always white apart from some background reflections.
In the Lighting Presets window, select the 'China shiny' preset.
Apply it twice. This preset uses the object's coloring.

9.
10.
11.
12.
13.

. Most ceramic lighting
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14. Try the other 'China' presets, and the 'Pearly pink' preset, applying each twice.

'China aquavitreous'

'Porcelain'

'China shiny'

Those presets and a few others were designed to be used individually. Most others may be used individually but
are less stable, needing to be applied three or more times to converge. Some of them work best in combinations,
as the following sequence shows. Each result depends on what came before, and any of them might be a
satisfactory end point.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

In the Lighting Presets window, select the 'Shellac wood' preset.
Click the Apply button to apply it (just once).
In the Lighting Presets window, select the 'Krystal fairy' preset.
Click the Apply button to apply it.
In the Lighting Presets window, select the 'Krystal dark' preset.
Click the Apply button to apply it.
In the Lighting Presets window, select the 'Glass psyche' preset.
Click the Apply button to apply it.
In the Lighting Presets window, select the 'Shrinkwrap' preset.
Click the Apply button to apply it.

After 'Krystal fairy'

After 'Krystal dark'

After 'Shrinkw rap'

As well as using combinations of ceramic presets, you can apply them after other lighting. Metal presets are good
starting points to follow with one or more ceramics. Also note that the choice of background plays a big part in the
appearance of some ceramic lighting and combinations.
Replacing the Unlit picture
Another technique involves replacing the Unlit picture, to use different colors as the basis for lighting. We will look
at two examples that copy the Lit picture to the Unlit picture, and one using the Pic Texture filter.
Example 1: copying Lit to Unlit
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As the object's coloring has only smooth variation, we need to start with some lighting that provides more complex
coloring. We could have skipped the first three steps if the object's coloring was varied enough to work with 'Poster
68' or any presets in the Detail category.
1. In the Lighting Presets window, select the 'Krystal fire' preset.
2. Click Apply to apply the lighting. When it finishes, apply it again.
3.

4.
5.

Click the Copy Lit Pic to Unlit Pic button
in the Lighting window (the Copy/Merge button in the Picture
window toolbar can do the same thing, with an extra step to choose the destination picture), and click OK to
confirm.
In the Lighting Presets window, select the 1.6 Art FX category and select the 'Poster 68' preset.
Click Apply to apply the lighting.

6.
7.
8.

Click the Copy Lit Pic to Unlit Pic button
, and click OK to confirm.
In the Lighting Presets window, select the 1.6 Basic category and select the 'Soft light' preset.
Click Apply to apply the lighting. The result is shown in the first panel below.

Example 2: copying Lit to Unlit
1.
2.
3.
4.
5.
6.

In the Lighting Presets window, select the 1.6 Art FX category and select the 'Zebra' preset. This lighting
ignores previous colors and depends only on the object's shape.
Click Apply to apply the lighting.
Click the Copy Lit Pic to Unlit Pic button
, and click OK to confirm.
In the Lighting Presets window, select the 1.6 Ceramic category and select the 'Lacquered' preset.
In the Reflection and Refraction panel, set the Refraction Source dropdown to Back Picture. This gives a
cleaner result.
Click Apply to apply the lighting, then apply it again. The result is shown in the second panel below.

Example 3: using a texture to replace the Unlit picture
1.
2.
3.
4.
5.
6.
7.

In the Picture window toolbar, click the Unlit Picture button
to make the Unlit Picture active. (It should
show the zebra pattern on a white background.)
In the Picture window Effects menu, choose Pic Textures... to open the Pic Texture editor.
Click the Texture Presets button
. Select the Rocks category and select the 'White pink granite 1'
preset. Click OK to close the preset window.
Click OK to apply the texture and close the Pic Texture editor.
In the Lighting Presets window, select the 1.6 Ceramic category and select the 'Lacquered' preset.
In the Color panel, set Blur to 0.
Click Apply to apply the lighting, then apply it twice more. The result is shown in the third panel below.

1.6 Art FX 'Poster 68' follow ed by 1.6
Basic 'Soft light'

1.6 Art FX 'Zebra' follow ed by 1.6
Ceram ic 'Lacquered'

White pink granite texture follow ed by
1.6 Ceram ic 'Lacquered'
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In these three examples we first created new coloring that was flat (or at least not strongly shaded or shadowed),
and finished by applying lighting with shading effects. If you use strongly shaded lighting before the final step it can
overwhelm the shape.
Another option is to combine separate lightings by merging layers. You can do this in XenoDream if you are not
already using the Background picture, or you don't mind the background being changed for each new lighting. After
applying each lighting, you set the Layer Opacity and Merge Mode, and click the Copy/Merge button to merge the
Lit Picture with the Background picture, overwriting the Background picture. The alternative is to save each Lit
picture and merge them in another program.
Dirk Monteny has produced a tutorial showing how to emphasize outlines by combining two lightings. It is at
http://www.renderosity.com/mod/gallery/index.php?image_id=759685&member

4.6 Multiple render techniques
The previous topic covered ways of using a single render with multiple lighting. There are also situations that need
two or more renders combined to create the desired result. One is when you have objects that can't be combined
in a single set of holons. Another is combining opaque and transparent objects.
Combining two renders
If you want to combine two objects so they intersect, you can render the first object, then open the file for the
second object, Render More, and apply lighting to the combined object. The shadow bounds are calculated for the
first object, so shadows may be incomplete for the second object.
If the objects don't intersect, you can render and light them separately:
1.

Render the first object and apply lighting.

2.
3.
4.

Click the Copy/Merge button
and copy the lit picture to the background picture.
Open the second object and Render New.
Set up the lighting, set the Background Source to Background picture, and apply lighting.

You can repeat steps 2 to 4 to combine more renders. Each render may be opaque or transparent.
Combining opaque and transparent objects or parts of an object
The above method allows an object with lighting to show through one or more transparent objects in front of it. It
does not allow you to have opaque and transparent parts intersect, or some to be in front and others behind. Here
are some ways to do that.
One object and render
One obvious approach is to make a single object, and set some holon opacities to 100 and others to low values.
This doesn't work well in general, because of limitations in the rendering methods. Wherever any opaque holon
pixels are behind transparent holon pixels, the coloring becomes badly aliased (noisy). However, if you use a
single color for any overlapping holons then there is no aliasing, and the result can be acceptable, especially if you
use regions to give some holons different lighting.
Another limitation of this method is that lighting only applies to the surface, so opaque holons can't have their own
lighting show through transparent holons, which severely limits realism. The following methods can get around
that, using multiple renders. They only work for v2.2 onwards, due to a subtle change in how Render More works.
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One object, triple render
Note: this is an advanced technique, and is rather complicated.
The process uses three renders. The first render is the opaque holons with lighting applied, to serve as
background. The second render is the transparent holons. Then we do a combination render with the opaque
holons, in such a way that only the parts in front of the transparent holons are added. We apply lighting to get the
finished result.
A. The opaque render for the background:
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.

First create the object, or open it from a file.
Select the holons that you want to be transparent.
In the Rendering page Opacity panel, uncheck Sync, and set Opacity to about 8 (or your preferred setting).
You may also want to uncheck shadows Cast by holon for the transparent holons.
In the Regions page, make sure the region method is Per Holon. Set the Region control to 2.
Save it to a shape memory spot (#1).
Make all the transparent holons free and hidden.
Save it to a different shape memory spot (#2).
Set up the shadows for the opaque render.
Render New.
Set up the lighting for region 1 (the opaque holons) and apply it. If the shadows aren't right, make any
adjustments and render new again.
12. When you're happy with the applied lighting, click the Copy/Merge button and copy to the Background
picture.
B. The transparent render
For the transparent render, we will need to preserve the correct shadow bounds for the opaque holons, so we can't
render new. We can render more if we first clear the unlit picture and depth map.
1.
2.
3.
4.
5.
6.
7.

Select the Unlit picture (click the Unlit picture button
).
In the Edit menu, choose Clear Picture
In the Edit menu, choose Clear Depth Map.
In the Main window, restore from the first shape memory spot (#1).
Make all the opaque holons free and hidden.
Render More.
Set up the lighting for region 2 (the transparent holons) with background set to background picture, and stop
the render when it is sufficiently done. You may apply it to make sure. Render more if necessary (you won't
be able to render more of the transparent part later.) You may apply Polish at this time, or later.

C. The final opaque render
1.
2.
3.

4.

In the main window, restore from the second shape memory spot (#2). Only the opaque holons should be
visible.
Render More. The opaque holons will render where they are in front of the existing transparent render, but will
not render behind.
The lighting should already be set up for both regions, but you can make adjustments to either region now. If
the background is still set to background picture, the preview should show the desired result. Stop the render
when sufficiently done.
Apply the lighting.
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4.7 Surface cleaning and other issues
XenoDream objects can range from smooth and simple to finely detailed or completely chaotic. The rendering
process involves calculating a sample of 3D points that can never be perfect, and has limitations in some
situations. For example, it doesn't increase density for perspective, so it takes longer to render areas very close to
the camera; and some metamorphs can create areas of low density. When it comes to lighting, the results are not
always what you expect or want, so you have some choices for improving them.
The options fall into three categories: optimizing the rendered object, cleaning the object surface, and choosing
good lighting.
Optimizing the rendered object.
The first advice is for before rendering. See Optimizing for quality and speed
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.

The second choice is simply to let it render longer. Sorry, there are no magic tricks to fill in those last rough
patches faster.
Cleaning the object surface.
The Lighting window Surface Cleaning panel includes a variety of methods, from routine improvement to radical
surgery or creative effects. They each have their purposes, and none of them are intended to be used as defaults.
Holes: unless you're impatient with rendering, it is rare that objects with constructors will have any pinprick holes
where the background shows through. They are more likely to happen with fractals. You may consider Holes set to
1 or 2 as cosmetic improvement, while higher values are likely to change the appearance enough to be considered
as creative modification. You don't need to apply them permanently unless you want to fill holes repeatedly, or you
are also using Pits, in which case you should apply holes first. Creative uses are covered in Hole filling
backgrounds 92 (and also a tip for undoing surface cleaning).
This example shows the effect of increasing Holes values, with a white background behind the object.

Original

Holes 1

Holes 3

Holes 5

Stragglers: this is not one to use often. Set to 1, it removes single pixels that are surrounded by background,
which you may consider an improvement for some messy objects. Values of 4 or more erode the object edges to
some extent.

Original

Stragglers 1

Stragglers 3

Stragglers 7

Pits: this has a range of uses. Technically it is a variation of a median filter. Positive values fill in tiny depressions
or pitting in the surface, which can occur due to insufficient rendering time or deficiencies in the object itself. Any
lights with Smoothing will spread any pits out into dimples. Values of 1 to 5 are very good at filling these pits
without damaging the rest of the object (unless the detail includes single pixel depressions in a flat surface!).
Higher values should be considered as plastering. Negative values remove elevations in the surface, which may be
due to single points floating above the surface, or rough surfaces. Set it to -1 to remove floating points, or -9 to use
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it as coarse sandpaper. Pits affects only the preview until you apply it. You can apply Pits repeatedly, but after the
first time or two it only has an effect if the values are greater than previous times, or you use 9 or -9. The most
aggressive treatment is to apply either 9 or -9 in mixed order, possibly followed by polishing or smoothing.

Original

With Sm oothing on lights

Pits 1

Original

Pits 9 x3

... then Pits -9 x3, 9 x3

... and Polish 9 x2

Polish: this is very useful with constructors. It is the best way to get a smooth shiny surface with minimum
damage to edges or details. It can also be used to roughen surfaces. When you have objects with both fine details
and areas you would like to be smoother, look at the details in the lighting preview and see if small values of Polish
will be acceptable. If not, your only option is to render longer. Polish affects only the preview until you apply it.
When you are using regions you can polish regions individually or all at once.

Original

Polish 9

Smooth: this is strictly a creative effect, because it applies the smoothing and fringe settings of Light source 1
and tends to obliterate details.

Choosing good lighting
Good lighting depends on both what you are trying to achieve and the characteristics of the object. There are two
aspects to lighting that depend on the object: interaction with color, and interaction with the shape. Some presets
rely on the coloring or the angles of the object to create special effects, so will only look good for objects with
sufficient detail in the shape or color.
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The lighting parameters were implemented more for flexibility than realism, which allows for many effects that other
3D programs can't do, but requires extra care when you do want realism. Here are some guidelines to make it
easier.
In the Depth panel:
The Depth control lets you make objects appear flatter or deeper. Small values can be useful to create flattened
metal effects. It also provides important adjustment of edge and shading in most artistic effects. However, for
correct geometry it must be set to 20. Otherwise your spheres may look more like buttons or missiles.
The Extra depth option stretches shallow objects to give them more depth. For correct geometry it must be
unchecked.
The True depth option gives perspective correct angles for lighting, which has most effect away from the center,
especially for objects close to the camera. For correct geometry it should be checked.
The Fine depth option uses the best possible resolution for calculating depth and edge appearance, so you
would usually want it checked for the sharpest details and best quality edges. Some people prefer it off for
smoother surfaces. Otherwise you can improve the surface smoothness by rendering longer, using Polish or
resampling for anti-aliasing (or all of these.)
In the Light Sources panel:
The Smoothing and Fringe controls can be set individually for each light source (except 0, ambient light). They
filter the surrounding surface to make it appear smoother or rougher or with enhanced edges. Before v1.6 this was
often the only way to make some surfaces smooth enough for shiny effects. But it destroys details and thickens
edges, and except for artistic effects you will probably want to make sure Smoothing is set to 0 for all lights. You
can do this by clicking the Sync button before setting Smoothing to 0. Some presets use smoothing to create
extra highlights for glitter effects. Regions can be useful for confining such effects to specific holons.
Here are examples showing Depth set low or high, and the bad effect that Smoothing has on edges.

Depth 6

Depth 40

Sm oothing 20 Fringe 4

Lighting with strong highlights (Diffuse much less than 100) works best on reasonably smooth surfaces. For rough
or highly detailed objects, all those sparkles make it harder to see the shape, so it usually works better to use
mostly diffuse light. Several presets in the 1.6 Basic category are good starting points. However, lots of highlights
can be useful with Depth of Field filtering.
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Too shiny

100% diffuse

Reflection and refraction only look good with sufficiently smooth surfaces. Polishing can enhance the effect in
most circumstances. Small amounts of reflection can work for metals on slightly rough surfaces, but otherwise it
is only adding noise and should generally be avoided.

4.8 Shadows
This topic covers setting up shadows and using them, and what you can do before and after rendering to get the
best quality shadows.
XenoDream calculates shadow maps during the render (one for each shadow-casting light source). This method
allows complicated objects to cast shadows onto themselves, and allows realtime adjustment of lighting as a postprocessing step, with two costs:
1. Each shadow map uses memory. For very large renders you may need to either reduce the number of
shadows, or reduce the Shadow Resolution in the Render page Shadow panel.
2. The direction of the shadows has to be set before rendering.
Setting up shadows (Rendering page, before rendering)
While there is flexibility in how shadows can be used at lighting time, it helps to choose suitable shadow
directions first. Consider the scene geometry: is it an object by itself, or something with a back plane, a ground
plane, or mostly enclosed? Then consider where most of the light should come from, and whether it is from bright
points or larger areas such as windows or sky.
The addition of soft shadows in v2.3 makes it easier to simulate light from large areas. One light with a soft
shadow works well for small to medium area lights. For larger area lights it works better to use a number of lights
evenly spread, with soft shadows. (The shadow softness is adjustable at lighting time, so the decision before
rendering is just how to arrange the lights.)
There are two ways to set up shadow directions in the Rendering page:
1. Open a lighting/shadow preset. The Lighting/Shadow Preset dialog shows a shadow ball for each preset,
making it easier to choose.
2. Add and adjust lights on the shadow ball.
After opening a shadow preset, you may want to adjust the shadow positions to suit the camera angle.
When you open a preset, you have the option to Use All Lights, or only the lights that have shadows in the
preset.
When using a few bright lights with hard shadows, it's common to have some infill lights (weaker lights without
shadows) to show some detail in dark places. Most lighting presets have some infill lights, so if you have loaded
all lights you may want to turn some shadows off when adjusting the lighting.
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Sometimes you might want the shadows to fall in a particular place for effect, or to avoid certain features. In this
case, after setting the shadows you will need to do a test render (not too large, to save time) to see where the
shadows are, then adjust the positions on the shadow ball and render again.
Here are some examples showing the benefits of different shadow setups.

A single hard shadow

The sam e lighting, except the left light has shadow
softness 34 and the top light has a shadow w ith softness
70, for a crude approxim ation to a skydom e or reflective
ceiling.

The "Room w ith 4 w indow s" preset, approxim ating a room The "Skylight, 4 sh" preset has four very soft shadow s
w ith four square w indow s.
from above.
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The "Skydom e, 13 sh" preset uses 13 soft shadow s to
give a m ore realistic environm ental lighting.

An object by itself m ay suit m ore om nidirectional lighting,
as in the "Surround, 10 sh" preset.

Holons that shouldn't cast shadows
All
1.
2.
3.

holons cast shadows by default. There are several reasons why you might not want a holon to cast shadows:
The holon is highly transparent.
The holon is a plane and would block some lights from casting shadows that you want.
More commonly, when its shadow would never be visible and the holon extends over a significant area,
causing the shadow maps to be larger than necessary. This typically applies to ground planes and back
planes. You can improve the quality of shadows by not letting these holons cast shadows (see the example
below.)
To do this, select the holon and uncheck Cast By Holon in the Render Shadows panel.
Here is an example with a cuboid above a large horizontal plane, showing the improvement when the plane does
not cast a shadow.

Plane casts shadow

Softness 0, quality 1

Softness 0, quality 7

Softness 30, quality 4
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Plane doesn't cast shadow

Softness 0, quality 1

Softness 0, quality 7
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Softness 30, quality 4

If you have objects that extend beyond the screen borders, you would usually want to have the off-screen parts
cast shadows for correctness. But if you are really zoomed in, the shadow maps can lose some resolution and
add to the render time, so it may be acceptable to ignore the off-screen objects for casting shadows. You can do
this by unchecking Cast From Off Screen. However, with improvements in shadow map calibration in v2.3 there is
little to be gained, so it's easiest to just leave it checked.
In the Lighting window (after rendering)
If you set the lighting before rendering, the lights and shadows are already in sync. But what happens when you
open a Lighting preset or restore from a Lighting Memory Spot? It depends on the Shadow Angles option (the
dropdown box beside the Lighting Preset button). It has three choices for what to do with the lights that cast
shadows.
1.
2.
3.

Exact Shadows: any lights that don't match the rendered shadows will not cast shadows.
Nearest Shadows: any lights with shadows enabled that don't match the rendered shadows will change
position to the nearest rendered shadow that isn't already in use.
Add New Shadows: any lights with shadows enabled will add a shadow at their current position if there isn't
already one. It won't take effect until you render again.

The first two options are best when you want the lighting preset to adapt to the rendered shadows. However, they
don't let you see what shadows were saved in the preset (or memory spot). The third option lets you see the
preset as it was saved, and you can render (or render again) if it has different shadow positions that you want to
use. However, be aware that if you open a variety of presets with Add New Shadows, you may end up with several
more shadows than you need for the current lighting, and it may be worthwhile to delete the unwanted ones on the
Rendering page before rendering again.
Shadow quality
The Shadow Quality control in the Lighting window affects the speed and quality of shadows. It works differently
for hard and soft shadows. For hard shadows the main issue is aliasing (jagged edges or pixellation) due to limited
resolution of the shadow map, often worst near the camera due to perspective. Increasing shadow quality filters the
samples over a larger area. For soft shadows, in addition to the aliasing there are accuracy issues. Low quality
soft shadows are noisy. Increasing quality uses more shadow samples to test the distance to blocking objects
and calculate the percentage in shadow. This reduces noise and some artifacts. The softer the shadow, the higher
the quality it may need.
Shadow artifacts
Shadow maps can have a variety of artifacts in addition to aliasing. In v2.3 self-shadowing has been mostly
eliminated, but light bleeding can still be a problem.
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Light can bleed into the shadow at a thin boundary, where two shapes meet or intersect. There are no controls to
adjust for this. This example shows a vertical plane intersecting a horizontal plane, with a light on the left casting a
shadow. The bleed is worst at sharp angles, as can be seen by comparing light angles of 15 and 45 degrees from
the horizontal plane. Another option is to add a constructor holon between the light and the problem area. The
Shaft2 constructor is one of the easiest for making a long thin holon for placing behind a plane junction, as shown
here.

Vertical angle 15

Vertical angle 45

With Shaft2 added

Soft shadows use some approximations. One is calculating the average distance of blocker objects to determine
the area of the shadow. This generally works well but can be visibly wrong when a distant blocker crosses a near
blocker. Increasing quality rarely fixes it. You can try increasing or decreasing softness, or changing relative light
intensities to make it less obvious. In this example, a grid casts a shadow onto a plane, and a bar also casts a
shadow from higher up. The bar and grid shadows interfere with each other more as the shadow softness is
increased. In such a case you would probably want to reduce softness.

Shadow softness 15

Shadow softness 30

4.9 Lighting with regions
Sometimes it is useful to apply different lighting effects to regions of an object. They could be variations in material
or completely different lighting styles. The regions are defined before rendering, in the Main window Regions page.
After rendering, additional options appear in the Lighting window above the preview.
Setting regions by holon
The simplest way to set regions is with the Per Holon region method, where each holon can be set to any region.
This approach is especially useful with constructor holons, for example when you want to give them different
metallic appearances.
This exercise uses a simple object with three constructors, and we will set it to use three regions.
1. In the File menu choose Open Sample File... and navigate to the Tutorials folder. Select 'Bauble rope' and
click OK to open it.
2. Click the Regions tab page. The Preview shows each region in a different color, so initially it is all white.
3. The Method should already be set to Per Holon.
4. Select holon 2.
5. Set the Holon Region control to 2. Holon 2 is now red in the preview.
6. Select holon 3.
7. Set the Holon Region control to 3. Holon 3 is now yellow in the preview. The Number of Regions control

Pictures and Lighting

121

adjusts automatically in the Per Holon method, and shows 3.

Now to do the lighting.
1. Click the Render New button in the Rendering toolbar.
2. Click the Lighting button to open the Lighting window. Notice the Regions checkbox and panel visible above
the Lighting Preview.
3. In the Regions panel, the Active Region control selects the region to set lighting for. The Region Preview

4.

Mode button
shows all regions when down, and only the active region when up. Release the Region
Preview Mode button and scroll the preview. The inactive regions are shown as dark grey. It is often useful to
check that you are looking at the active region, then view with all regions to see them in combination.
We want to keep the background from changing every time we load a preset. Click the Enable Locking
button

5.

above the Regions panel. This enables the locks for each set of controls. Click the Lock

Background button
beside the Background Color control in the Haze, Glow and Background panel.
The color is already set from the file.
Set the Active Region to 1, if it isn't already. This is the base of the object.

6.
7.
8.
9.
10.

Click the Lighting Presets button
to open the Lighting Preset window.
In the 1.6 Basic category, select the 'Sunlight outdoors' preset.
Set the Active Region to 2. This is the ball of spheres.
In the Lighting Presets window, in the 1.6 Basic category, select the 'High gloss' preset.
This part of the object isn't smooth enough to look glossy yet. If the rendering rate is still above 800, let it
render longer, otherwise click the Stop button in the Lighting window. We want to polish the object only for
this region.
11. In the Surface Cleaning panel, uncheck the All checkbox to the right of the Polish control. Now set Polish to
2 and click the Apply Polish button
to the right of the Polish control.
12. Set the Active Region to 3. This is the rope.
13. In the Lighting Presets window, in the 1.6 Metal category, select the 'Copper old 1' preset.
14. Click the Apply button to apply the lighting. As some of the regions use reflection from the Old Lit picture,
apply the lighting again. The result is shown below.
15. Now we will try some different lighting combinations.
16. Set the Active Region to 1.
17. In the Lighting Presets window, in the 1.6 Metal category, select the 'Bronze 2' preset.
18. Set the Active Region to 2.
19. In the Lighting Presets window, in the 1.6 Metal category, select the 'Neptunium' preset.
20. Set the Active Region to 3.
21. In the Lighting Presets window, in the 1.6 Art FX category, select the 'Airbrush gold/red/blue' preset.
22. Click the Apply button to apply the lighting. As some of the regions use reflection from the Old Lit picture,
apply the lighting again. The result is shown below.

122

Using XenoDream v2.7

First lighting com bination

Second lighting com bination

Sometimes you may want to start with the same lighting for all regions, then adjust some parameters for each
region, to keep some things consistent (such as light source directions). You can also use more lock buttons
while opening presets.
Regions by holon with iterators
When the object has at least one iterator holon,
it can be useful for the largest iterator to inherit
regions from the other holons (if there are at
least two others.) To do this, select the iterator
holon and check the Inherit option on the
Regions page.
In this example, the two constructor holons are
set to regions 1 and 2 respectively, and the
iterator holon is set to inherit regions. The file is
'Coggem regions inherit' in the Data\Tutorials
folder.

Setting regions by gradient
The Gradient region method uses the holon gradients to form the regions. This allows a variety of shapes for
regions, and works best with Metamorph coloring on smooth objects, although it can be used any time.
A general approach is:
1. With Metamorph coloring, experiment with the Meta Pattern controls to find a suitable pattern, and choose
gradients that are not too busy.
2. On the Regions page, set the Region Method to Gradient.
3. Set the Number of Regions to 2 or 3.
4. Adjust the Red, Green and Blue controls to find a combination that gives a balanced pattern of regions.
Some values may need to be negative. If it doesn't seem to work out, try a different gradient.
Here are two examples:
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'Tw istorus goldblack' in Data\Tutorials
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Tw o regions using different ceram ic lighting

4.10 Depth of field
Real devices such as microscopes,
telescopes or cameras use one or more
glass lenses to focus the light into an
image. Objects at a particular distance
(the focal distance) appear in sharp
focus, while nearer or more distant
objects appear blurred. Depth of field is
the depth of the zone that is in focus.
Computer rendering usually ignores the
size of the lens and creates an image in
complete focus. A Depth of Field (DOF)
filter can be used after lighting to
recreate the effect of using a lens by
blurring parts of the picture.

This type of blur is very different from gaussian (bell curve) blur. It is generally uniform, unless modified by spherical
aberration (which concentrates more light towards either the center or edges). It takes the shape of the aperture. A
plain lens is circular, but cameras often have aperture shutters that impose a pentagon, hexagon or octagon
shape. When a bright point of light is out of focus it is blurred into this shape. Bigger lenses blur more.
Small amounts of DOF can be used to enhance most images, adding a sense of realism even when the blurring
isn't immediately obvious. Very large amounts are most appropriate when the nearest part of the object is relatively
close to the camera, as that is when the size of a real lens has most effect. Strong DOF also works best when the
out of focus region has high contrast, especially with highlights.
For this tutorial we will render a picture with shiny lighting and a background texture.
Setting up the picture
1.
2.

In the File menu choose Open Sample File... and navigate to the Tutorials folder. Select 'Shiny rings dof'
and click OK to open it.
Click the Render New button in the Rendering toolbar. Let it render to about 1200 (or about six minutes) and
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3.
4.
5.
6.
7.
8.
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click the Stop Render button
.
In the Picture window File menu, choose New Background Picture. A blank background picture is created.
In the Effects menu, choose Pic Textures... to open the Pic Texture editor.
The texture was included in the parameter file, so just click OK to create it.
Click the Lighting button to open the Lighting window. Scroll the lighting preview to show part of the object. It
needs to be smoother.
In the Surface Cleaning panel, set Polish to at least 6 and click the Apply Polish button
.
Click Apply to apply the lighting. When it finishes, apply it again. The second time is needed to add the
reflections.

Exploring the DOF filter
Usually you would rely on the DOF preview to get the settings right before applying it. Sometimes you might want
to save the picture first so you can restore it and try different settings. You can either save the Lit picture to a file,
or copy it to the Background picture if you've finished with it. We will copy it to the Background picture.
1.

In the Picture window toolbar, click the Copy/Merge button
option, and click OK.

2.
3.

Reselect the Lit picture by clicking the Lit Picture button
.
In the Effects menu, choose Depth of Field... to open the DOF filter.

4.
5.
6.

If you have used this filter before, click the Reset Values button
to return to the default settings.
Scroll the preview to the top of the image, left of center, to show part of two objects and the background.
Set Amount to 20. Adjust Focal Dist between 0 and 100, observing how the top object is in focus in the 30's,
the bottom object in the 50's and the background at 100.
With Focal Dist at 100, increase Amount to 40 for a stronger effect.
Now adjust the Highlights control to make the unfocused highlights brighter. A value between 10 and 15 is
about right for this image. (This is only necessary because we are working with a picture with 8 bit resolution,
so the highlights need compensation to restore the lost energy to blur them properly.)
Again adjust Focal Dist between 0 and 100 to see how the image varies. Here are some results:

7.
8.

9.

Focal distance 0

Focal distance 32

, choose the Overwrite Background Picture

Focal distance 100

10. Scroll the preview to find a part of the image you would like to be in focus, and adjust Focal Dist until it is
sharp.
11. Click OK to apply the effect and see the full picture. (The image is updated in tiles, and when working with
larger images you can click Cancel any time before it completes and make adjustments.)
12. Next we will restore the original picture. In the toolbar, release the Lit Picture button
Background picture.

to show the

13. Click the Copy/Merge button
, choose the Overwrite Lit Picture option, and click OK.
14. In the Effects menu, choose Depth of Field... to open the DOF filter.
15. Scroll the preview to an area with large highlights. You may need to change Focal Dist. Try all the Aperture
options to see how the highlights change shape.
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16. Set Aperture to Hexagon and adjust the Aberration control between 100 and -100, observing the highlights.
An ideal camera has no spherical aberration, so it's all a matter of what you want to see. The star shaped
Aperture options look best with Aberration near -100. The circle, pentagon, hexagon and octagon apertures
are most common in reality; the other shapes are for novelty.
17. Experiment with combinations and click OK to apply.
For the image at the top of this page, the settings were Amount 70, Focal Dist 55, Depth 0, Highlights 15,
Aperture Hexagon, Aberration 0.
Additional notes
From v2.4, the effect is scaled to the size of the picture, so if you adjust settings for a test render and then render
larger, you don't need to change the settings to get the same effect. However, if you use large amounts, expect
applying to be slow for the larger pictures.
The highlight Threshold should normally remain at 255, as only light that has been limited should be boosted. It
can be reduced to create extreme or special effects. The Background option provides a choice to boost the
background or not. If it has highlights then you would probably want to enable it, but if it has larger bright areas
then you would only enable it for burnout effects.
For images without highlights (mostly diffuse lighting), you can leave Highlights and Aberration at 0, use a Circle
aperture and adjust only the Amount and Focal Dist.
Sometimes you may want more or less of the object to be in focus without changing the amount of blur at the
limits. The Depth control allows this, with positive values increasing the depth of focus, and negative values
decreasing it.
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Depth Window

The Depth window allows you to create or modify the depth map depending on the colors in any of the pictures, or
the alpha channel. You don't need the Depth window just for rendering an object and lighting it (although it may be
used to add texture to the object.)
The basic use is to create depth for an imported picture
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, so lighting effects can be applied to it.

A more advanced use is to make a background picture 3D and combine it with a rendered object
can cast shadows onto it.
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, so the object

Importing depth maps
You can import a PGM, BMP or PSD file to create the depth map. It could be one that you saved from
XenoDream, or one that was exported from another program such as KPT Gel. Importing is not done in the Depth
window. In the Picture window File menu, choose Open Depth Map...
This would generally be for lighting purposes, but it can also be used to provide the depth information for the Depth
of Field filter in the Picture window Effects menu.
With the PSD option (which is 16bit greyscale), one possible use is to export the depth map and edit it in an
image editor to fix defects, then import it back into XenoDream and apply lighting. (Keep XenoDream open so you
don't lose the shadow data.)

5.1 Depth from picture files
In this topic we will open a picture file and use the Depth window to create a depth map from the colors. Then we
can use lighting effects.
First, choose a picture file to experiment with. A photograph is ideal, or anything with smooth shading. It must be
in JPG, BMP or PSD format.
1.
2.

3.
4.
5.

6.
7.
8.
9.

In the Picture window File menu, choose Open Picture... and select the picture file. Click OK to open it.
The Picture Destination dialog appears. Choose Overwrite Unlit Picture. If the picture file differs from the
current picture size, there are also options for resizing the picture. In this case, choose either the third or
fourth option. Click OK to close the dialog.
In the Picture window toolbar, click the Depth button to open the Depth window. The Lighting and Depth
windows both appear, with the Depth window on top.
Drag the Lighting and Depth windows to positions so that you can see the Lighting preview while working in
the Depth window.
The Lighting preview shows a heavily textured picture, probably too much with the default Depth settings.
Adjust the Height control between 10 and -10 to see the effect. You will probably find it looks best
somewhere between 1 and 3, positive or negative.
Experiment with the Red, Green and Blue controls to see how the relative mix affects the texture.
When you have an effect you like, click OK in the Depth window to create the depth map and close the Depth
window.
Try a variety of lighting presets to see how they work with the picture.
If the original picture has a lot of fine texture, resulting in a very rough depth map, there are two things you can

do. One is to use Polish. Set it to 1 or more and click Apply Polish
.
10. You can also blur the picture before creating the depth map. Copying the Unlit picture to the Background
picture allows you to blur it for depth while using the original for lighting. In the Picture window, select the Unlit
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picture (click the Unlit Picture button

if it isn't already down).

11. Click the Copy/Merge button
in the Picture window toolbar, select New Background Picture as the
destination, and click OK.
12. In the Picture window Effects menu, choose Gaussian Blur... and set Width to 5 and Amount to 100, and
click OK to apply the blur to the Background picture.
13. Click the Depth button to open the Depth window again.
14. In the Depth window, click the Source button repeatedly to cycle between the pictures. When it is set to
'Back Picture', the Lighting preview should show a smoother result due to the blurring.
Here is an example where the original picture has fine texture, and also artifacts from moderate JPG compression
(the checkerboard pattern) that become obvious in the depth map. Polish set to 3 or higher cleans it up nicely. The
results using blur before depth conversion were practically the same as polishing after, so that picture isn't shown.

Original picture

With depth and lighting

Polish 9 applied

Once you have a depth map, the lighting window is a powerful filter, and combined with the Picture window effects
you can do a lot of creative filtering with pictures.

5.2 Combining backgrounds with objects
This topic shows how to combine a background picture or texture with the rendered object, which allows the object
to cast shadows onto it. You can leave the background flat or add depth to it. We will use a Pic Texture, but you
can also do it with picture files.
First, create an object and a background:
1.

2.
3.
4.
5.
6.
7.

Render an object that doesn't fill too much of the screen, so you will be able to see the background around it
and some shadows. Make sure you have included at least one shadow that is not vertical. (If you are not sure
of what object to use, you can try the 'Tovestorus' file in the Data\Tutorials folder and reduce the Object Size
to 31.)
Select lighting that you want to use with it, that shows the shadows clearly.
In the Picture window File menu, choose New Background Picture to create a blank background picture.
In the Picture window Effects menu, choose Pic Textures... to open the Pic Texture editor.
Click the Pic Texture Presets button
(located under the texture preview) to open the Pic Texture
Presets window.
In the Sky Misty category, select the 'Gloomy low cloud' preset and click OK to close the presets window.
Click OK to apply the texture and close the Pic Texture editor.

Next, merge the background and object colors in the Unlit picture:
1.

In the Picture window toolbar, click the Unlit Picture button

to make it active.

Depth Window

2.

Click the Background Mask button

3.

Click the Copy/Merge button
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to show the background.

, choose Overwrite Unlit Picture, and click OK to merge the pictures.

Now we can create depth from the background colors while preserving the object depth:
1.
2.
3.
4.

5.
6.
7.
8.

In the Picture window toolbar, click the Depth button to open the Depth window.
In the Depth window, set the Object dropdown to Ignore. This will preserve the object and create depth for
the background.
Set the Height control to 0. This would leave the background flat.
Reduce the Distance control slowly until you see shadows near the object in the Lighting preview. You will
need to scroll the preview to a suitable view, for example the bottom right edge of the object to see shadows
cast from the top left. (It is possible with some camera and object combinations that you might need to
increase Distance instead.)
Experiment with the Height control to add some depth to the texture, trying both positive and negative values.
Adjust the Distance control to set the exact position of the shadows.
Click OK to apply the depth settings.
Make any changes to the lighting that you want, and click Apply to apply lighting.

Example using the Tovestorus sample file, with Distance 21.7 and Height 5.0:

Additional notes
If you want to cast a shadow onto the background but not add texture to it, set the Height control to 0. The
background plane will remain flat. You can change the angle of the plane with the Vertical and Horizontal
controls.
If the Distance setting is too small, the background will be partly in front of the object. It won't cast shadows
onto the object, but it will affect the edges depending on the lighting.
Before you apply the depth, you have the option to cancel the Depth window and go back and do the previous
steps with a new background, or the same background with different Depth options, but once you apply the
depth settings you can't go back unless you render the object again. But there is a way to have Undo:
If you want an option to undo the Depth window, you can save the depth map of the rendered object. You can do
this any time between rendering the object and applying depth.
1. In the Picture window File menu choose Save Depth Map.... Save it in PGM format, and click Yes to set the
base at the back of the object.
2. If you want to try a different background or depth settings, go to the File menu and choose Open Depth
Map... and select the file you saved. If you create a new background texture you will need to merge it with the
Unlit picture before opening the Depth window again.
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If you want to have the background texture in a different lighting region from the object, render the object with
regions, with all holons set to use region 2 or higher. Then in the Depth window, uncheck All Regions, and the
background should be in region 1.
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Exporting 3D Data

You can export two types of 3D data to use in other 3D programs; triangle meshes and depth maps.
Triangle meshes
A mesh is a full 3D representation, suitable for viewing from any angle.
Creating a 3D triangle mesh is a separate process from picture rendering, and has its own Mesh Export window. It
uses the current object and camera view from the Main window, but ignores any color, regions or rendering
settings. The standard format to export to is a Wavefront OBJ file, which can be imported by most 3D rendering
programs. For 3D printing you can export to STL files. For use in POVRay you can save to a POVRay .INC file.
The first three topics in this section explore mesh export.
Mesh export, surface method 132 gives an introduction to mesh export using the Surface method.
Mesh export, volume method 135 shows limitations of the Surface method, and how to use the Volume method,
which is usually best.
Mesh smoothing 138 shows how to make more rounded objects.
Mesh coloring

139

has a procedure for creating a mesh with a UV texture map from the XenoDream coloring.

For more information see Mesh questions and answers

148

.

Point Clouds
Point clouds are useful for single renders or animations with particle effects, and include the XenoDream coloring.
They can be exported in Krakatoa PRT format, PLY format, or CSV format. Krakatoa is a plugin for 3DS Max. PLY
files can be used in MeshLab and some other programs. Exporting point clouds is done directly from the Main
window File menu, where Export Point Cloud... opens a dialog.
Depth maps
A depth map captures the view from one angle. Depth maps (also known as height fields) can capture more detail
and store it much more efficiently, and are good solutions for terrains, or objects that will be viewed from one
direction or within a limited range and need a lot of detail. If accuracy is important, you can minimize perspective
distortion by increasing the camera distance to 10 or more, and increasing the camera zoom to compensate.
Exporting the depth map can be done any time after rendering a picture. In the Picture window File menu, choose
Save Depth Map.... Usually you want to save in PGM format, which can be imported as a terrain by some
programs. A few programs such as Vue require a special version of TGA format (16 bit RG encoded) instead of
PGM. It is also possible to save 16 bit greyscale PSD files, for use as a depth channel in Photoshop, or to edit the
depth map and reimport it in XenoDream.
Note: you may have experimented with importing terrains from picture files in other applications. Saving a depth
map is a different process because it gives you the actual shape of the object, not just a heightfield translated from
colors.

6.1 Mesh export, surface method
In the Mesh Export window we can produce a triangle mesh from the object in the Main window. The object must
be rendered specially to capture the 3D structure, because in general there is no way to convert our holon model
directly into triangles. The first step creates the raw data, and can use a lot of memory (RAM). The second step
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converts the data into a triangle mesh. A third step reduces the number of triangles.
For this tutorial we will capture the structure of a simple object using the Surface method. This method calculates
14 views of the object from different directions and combines them into a mesh. It works well for closed objects
that are not too complex. It treats them as solid, because any hollow spaces are not visible from outside.
1.

In the Main window File menu choose Open Sample File... and navigate to the Tutorials folder. Select
'Sphere ribblet' and click OK to open it. The object has this shape:

Next we need the Mesh Export window. We don't need to render the object as a picture first. In particular, if you
have rendered a large picture, it uses memory that will be needed for mesh export, so you would need to change
the render size back to something small like 800x600 to free up the memory.
1.

Click the Mesh Exp button in the Render toolbar to open the Mesh Export window. The Mesh Export window
toolbar contains most of the mesh controls, and uses dialogs for some other settings.

2.
3.

Click the Mesh Options button
in the Mesh Export window toolbar. The Mesh Options dialog opens.
Set Mesh Grid Size to 100, Autoscale to 95, Method to Surface, Isosurface level to 127, Mesh Filter to
Two Step, Amount to 3, Sharpness to 40, Simplify to Best Shape.
Click OK to close the Mesh Options dialog.

4.
5.

Click the Render New button
to start rendering for export. The object will begin rendering in grayscale in
the top left corner of the Mesh Export window, and the progress indicator shows 'Rendering...' along with the
surface pixel rate.

6.

When the rate gets down to about 10,000 (it should take 10-20 seconds) click the Stop Render button
The Triangulate button will now be enabled.

7.

Click the Triangulate button
. The progress indicator will go through a series of steps very quickly, then
show 'Triangles created:' and a number about 111,500. The triangulated object appears before the filtering
step, scaled to fill most of the window. It is updated at the end, improved by the filtering.
Choose each direction in the View Direction dropdown list to see the object from six directions, then set it to
Front again. The triangulation is rather coarse because we used the smallest grid size. A portion of it is
shown below. We can do better by increasing grid size.

8.

1.
2.

Click the Mesh Options button
to open the Mesh Options dialog.
Increase Mesh Grid Size to 200, and click OK.

3.

Click the Render New button
to start rendering. The object begins rendering at twice the size it was
previously. You may notice that it is actually about 400 pixels wide, because it is oversampled to twice the
mesh grid size to improve the triangulation accuracy.

4.

When the rate gets down to about 10,000, click the Stop Render button

5.

Click the Triangulate button

.

. This time the progress indicator takes longer, and should create about

.
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454,000 triangles. It looks better now:

If you're thinking that's a lot of triangles for such a simple shape, you're right. The triangulation needs to generate
the mesh at high enough resolution to get clean details. The next step is to reduce the number of triangles to what
is needed for the shape, depending on what you want to do with it. After triangulating, the Simplify button is
enabled.
1.
2.

3.
4.

Click the Simplify button
. The progress indicator counts the vertices up and down, and when it finishes
the Quality control is enabled. This lets you interactively adjust the number of triangles.
Adjust the Quality down to about 70. The progress indicator shows the number of triangles at about 222,500.
You can always expect to reduce triangles by more than half without any visible difference. Usually you will
want to go further than that.
Adjust the Quality down to about 30. This results in about 40,860 triangles, and represents the shape very
well. For some purposes you might save at this quality, but we will go further.
Adjust the Quality down to about 12, which gives about 6530 triangles. It looks highly faceted, because the
display exaggerates shading to make it easier to see, and does not show smooth shading.

5.

To see the triangles more clearly while adjusting quality, click the Colorize Mesh Display button
, and
adjust Quality through the whole range before setting it back to 12. Before saving we will tidy up the triangles
a bit with the smoothing filter.

6.

Click the Smooth Mesh button
to open the Smooth Mesh dialog. Set Passes to 2, Amount to 0.1 and
click OK. The triangles realign to be slightly more regular in shape. Note that the Quality control is now
disabled, because smoothing applies the reduction first. If you want to save an object at different resolutions,
you may omit this step, or else save the higher size first and simplify again.

7.
8.

Click the Mesh Options button
to open the Mesh Options dialog.
Check the option to Export Smooth Mesh. This calculates smoothed normals when saving, and will stay
checked so you don't need to set it again.

9.

Click the Save Mesh button
. You may want to navigate to or create a folder to save meshes in. Type a
filename, for example 'Sphere ribblet 6k'. Leave the file type as 'Wavefront OBJ file' and click OK.

Note: after adjusting Quality, you may have noticed the status panel showing '(Not Manifold)'. This happens when
simplification joins the edges of some small triangles inside a sharply creased or complicated area. (Actually it is
still watertight and correctly oriented, but not 2-manifold). It's not important for most rendering programs. But if you
want to do 3D printing, it can be a problem, and it can be avoided by setting the Simplify option to 3D Printing
instead of Best Shape.
Here is a sample render in Bryce 4 with two copies of the object, one with the object as is and the other with
smoothing removed. (You can remove smoothing in Bryce by editing the object and choosing Unsmooth, so you
don't have to save meshes with and without smoothing.) For simple objects that will not be the main focus of a
scene, you can often get away with fairly low triangle counts, which will improve performance and save hard drive
space.
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6.2 Mesh export, volume method
This topic shows some difficulties with the Surface method and introduces the Volume method for mesh export.
The Surface method captures views of the surface from 14 directions (six faces and eight corners of a cube,
approximately) and combines them into a mesh.
It can't reproduce features that are not visible from any of those directions, and may produce artifacts at visibility
boundaries.
If the object has thin plates visible from both sides, they will have dents or holes unless the Isosurface Level
setting is reduced.
Hollow objects are always filled.
The Volume method captures the object in a 3D grid, including all internal structure.
It works for any object, no matter how complex.
Hollow parts can be filled with the Fill Volume option, but it only works on parts that are "airtight" with no holes.
The first section shows the Surface method problem with thin plates and how to fix it. It also shows different filter
settings.
Issues with the Surface method
1.

In the Main window File menu choose Open Sample File... and navigate to the Tutorials folder. Select 'Cube
zypes' and click OK to open it. The object has this shape:

2.

Click the Mesh Exp button in the Render toolbar to open the Mesh Export window.

3.
4.
5.

Click the Mesh Options button
to open the Mesh Options dialog.
Set the Mesh Grid Size to 300, the Method to Surface, Isosurface Level to 127, Mesh Filter to Two Step,
Amount to 3 and Sharpness to 80.
Click OK to close the Mesh Options dialog.

6.

Click the Render New button

7.

When the rate gets down to about 10,000 click the Stop Render button

to start rendering.
.
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Click the Triangulate button
. When it finishes it will show about 750,000 triangles created, but the thin
parts of the object are full of holes. A portion is shown here:

We can greatly improve the result by reducing the Isosurface level setting to thicken the object.
1.
2.

Click the Mesh Options button
to open the Mesh Options dialog.
Set the Isosurface Level to 75 and click OK.

3.

Click the Triangulate button
. When it finishes, the object is now solid and smooth, although some of
the edges are a bit ragged and some of the tips are split off. A portion is shown here, along with a result using
the Bilateral filter. The Two Step filter is generally better.

Tw o Step filter, Sharpness 80

Bilateral filter

Sometimes you may want to make the shape even thicker, and it works well enough to set Isosurface Level as low
as 10, provided you use the Two Step filter. Setting it to 0 makes it too voxelized for the filter to fully eliminate.
Here are samples showing the effect of Sharpness settings. Sharpness is often a matter of preference, but different
settings may work better with some shapes.

Isosurface 15, Sharpness 0

Isosurface 15, Sharpness 90

Sometimes this may give a result you want. Often it is easier to just use the Volume method instead, especially if
the shape is more complicated. We will do that next.
Using the Volume method
(If you skipped the first section, first open the sample file 'Cube zypes' as described in step 1 in the first section,
and open the Mesh Export window.)
1.
2.
3.

Click the Mesh Options button
to open the Mesh Options dialog.
Set the Isosurface Level to 127. 150 is a good default for the Volume method, but lower values can be used
to thicken the object.
Set the Method to Volume. Another panel of Volume Options appears below.
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Check Fill Volume if it isn't already checked. This will make the object solid and avoid generating extra
triangles that will never be visible (except for transparent materials, when it can be useful to see some internal
structure.)
Set the Mesh Filter to Two Step and Sharpness to 80. Click OK to close the dialog.

6.

Click the Render New button
to start rendering. Changing the method requires the object to be
generated again. The progress indicator shows new voxels instead of new pixels, and the number reduces
faster. The rendered object has contour lines due to the binary voxel grid used to capture the shape.

7.

When the progress indicator falls to about 600, click the Stop Render button
detail you will want to go lower than that.

8.

Click the Triangulate button
. Notice that the first step is 'Filling Volume' and after that it shows the
percentage filled, which should be about 80% for this object. (If it is much less, you can click the Triangulate
button again to cancel triangulation, click the Render More button and let it render longer before triangulating
again.) You may also notice that when the object mesh first appears it is very bumpy, or 'voxelized', before the
mesh filtering smoothes it out. The Two Step filter does the best job of it. There should be about 880,000
triangles in this mesh. Without volume filling it would be much higher.

. For objects with fine

9. Click the Simplify button
and wait for it to finish.
10. Reduce the Quality control to 30, which results in about 79,000 triangles. This seems like a good size for this
object, preserving the shape and keeping all the blade tips sharp. If you reduce it much more, some of the tips
will get truncated.
11. Click the Smooth Mesh button
to open the Smooth Mesh dialog. Set Passes to 2, Amount to 0.1 and
click OK. This improves the regularity of the mesh after simplifying.
12. Click the Save Mesh button
Here is a sample render in Bryce 4.

. Type a filename and save it as an OBJ file.
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6.3 Mesh smoothing
In the previous topics we used small amounts of mesh smoothing after simplifying to improve mesh regularity. We
can also use larger amounts to change the shape of the mesh. For this example our shape is a cuboid sculpture
and we want to make it more rounded and smooth.
1.

In the Main window File menu choose Open Sample File... and navigate to the Tutorials folder. Select 'Cube
wrap' and click OK to open it. The object has this shape:

Next we create a mesh using the Volume method.
1. Click the Mesh Exp button in the Render toolbar to open the Mesh Export window.
2.
3.

Click the Mesh Options button
to open the Mesh Options dialog.
Set the Mesh Grid Size to 300, Autoscale to 95, the Method to Volume, Fill Volume checked, Isosurface
Level to 127, Mesh Filter to Two Step, Amount to 3, Sharpness 25 and click OK.

4.

Click the Render New button

5.

When the progress indicator falls to about 300, click the Stop Render button

6.

Click the Triangulate button

7.
8.

Click the Simplify button
and wait for it to finish.
Reduce the Quality to 33. This should result in slightly more than 100,000 triangles.

9.

Click the Smooth Mesh button
to open the Smooth Mesh dialog. Set Passes to 10, Amount to 0.5 and
click OK. This rounds the shape nicely.

10. Click the Save Mesh button

to start rendering.
.

. It should have filled about 90%, resulting in about 918,000 triangles.

. Type a filename and save it as an OBJ file.

This portion of a Bryce 4 render shows how smooth the object is.
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6.4 Mesh coloring
XenoDream does not currently have any direct UV mapping or other direct export of a colored mesh. However, in
v2.4 there is a way to create a UV texture map using the XenoDream coloring. It involves exporting both a mesh
and a point cloud and combining them in two other programs, both available as freeware. You will need UVMapper
and MeshLab.
An illustrated tutorial by Christina Bartsch is available here: http://teenabiz.de/tutorials.htm
The basic steps are as follows.
1.

Open a parameter file or create an object in XenoDream

2.

Export a point cloud in PLY format:

In the File menu, Export Point Cloud.
Check the Orient to Camera option.
Set the number of points fairly high, eg 10 million.
Click Generate, and in the dialog set the type to PLY and enter a filename. Click OK.
3.

Export a mesh in OBJ format:

Export the mesh (render, triangulate, simplify, adjust quality) and save as type OBJ.
4.

Use UVMapper to create a UV mapping for the OBJ file:

Start UVMapper.
Open the .obj file.
In the Edit menu, New UVMap, Box, to use a cubical box mapping.
In the File menu, Save model, with a different filename, eg ...UV.obj
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Use Meshlab to create a texture map from the point cloud colors:

Start Meshlab
In the File menu, Import Mesh, open the .ply file
Show the Layer List, and in it, click the + button to add a layer. In the file browser, open the ...UV.obj file that you
saved in UVMapper.
In the Filters menu, Normals curvatures and orientation, Transform: Scale, to scale the obj layer.
In the Filters menu, Normals curvatures and orientation, Transform: Move translate center, to center the obj layer.
Select the ply layer.
Scale and center the ply layer as above.
In the Filters menu, Sampling, Vertex attribute transfer, and check Transfer color; click Apply.
Select the obj layer.
In the Filters menu, Texture, Vertex color to texture. Set the width and height and click Apply to save the texture.
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Frequently Asked Questions

This FAQ has been revised and reorganized for version 1.6/2.0, and question numbering does not relate to the v1.5
FAQ.
1.
2.
3.
4.
5.

General questions and answers 142 .
Questions about objects and the Main window
Questions about pictures and lighting 146 .
Questions about meshes 148 .
Technical questions 150 .
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.

7.1 General questions and answers
1.01 Is XenoDream a fractal program?
The 1.0 release produced only pure fractals. From 1.1 onwards, we prefer to describe it as a modeler that includes
fractal methods, though it also includes rendering and post-processing. The results can range from pure fractals to
non-fractals depending on the mix of regular and constructor holons. I (Garth) first began experimenting with 2-D
IFS fractals for creating shapes in 1988 on an Amiga after reading an article in Byte magazine by Michael
Barnsley. My vision was to create a tool to help with SF/Fantasy illustration, and IFS fractals were a means to that
end. XenoDream does not include other types of fractal because they don't fit with 3-D modeling.
However you want to describe it, it's difficult to capture the variety of ways you can use it.
1.02 Where can I learn more about fractals?
The Fractal Art FAQ is a good place to start, at http://www.fractalus.com/fractal-art-faq
1.03 Is there a standard abbreviation for XenoDream?
Yes, 'XD' is commonly used.
1.04 Are there any other XenoDream tutorials?
Paul N. Lee has tutorials, examples of metamorphs and other useful information at http://www.nahee.com/
Fractals/XenoDream/
Doug Harrington has a tutorial with screenshots at http://fractalarts.com/ASF/XDtut1.html
Bryan Smith has written a number of exercises that are in the Files area of the XD Yahoo groups, and there are
other sample files there. (They may be moved to a new location when we stop using Yahoo groups.)
1.05 If I modify one of the sample parameter files, can I use it as my own?
Yes. Since XenoDream works in a single continuous parameter space (more or less), you can consider the
sample and starter files as convenient starting points, and it only takes a few clicks and drags to get somewhere
new. The purpose of a starting point is to make it easier to get wherever you're going. And you don't have to modify
the sample files to use them in compositions.
However, as a general rule, if you use third party parameter files without significant modification as complete works
or substantial parts of works, you should give credit to the original creator and not pass it off as your own work.
1.06 Which computer features have the most effect on render time and capability?
CPU speed: Yes. Only processing speed really affects render time, subject to having sufficient RAM. This
includes the CPU type and speed and the performance of the memory bus etc.
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RAM: more is better; but each instance of XD can only use 2GB in 32 bit Windows, or a bit more than 3GB in
64 bit Windows.
64 bit: No effect on speed, but does allow XD to use a bit more than 3GB of memory.
Multi core or multi CPU: There is no advantage for a single instance of XD, as neither rendering nor lighting use
multiple threads. However, you can take advantage of multiple cores by running more than one instance of XD,
for interactive use, manual rendering or batch rendering. Batch rendering is reported to run well with one instance
per core.
Graphics card: No. XD does not use any graphics hardware features because they don't help with this type of
calculation. (The latest technology offers hope for the future.)
1.07 Is XenoDream compatible with Windows Vista or Windows 7?
Yes, from v1.6 and v2.0 onwards. A few minor Vista features are not yet supported, such as taskbar thumbnails or
Flip3D while XenoDream is minimized.
1.08 Is XenoDream compatible with Linux or Mac?
Linux: XenoDream is reported to run very well in Xandros with Crossover Office, and other variants with Wine. In 64
bit versions it can use slightly more than 3GB of RAM. Some Wine versions have problems with CHM help files.
Mac PowerPC: No. We do NOT recommend running XenoDream under Virtual PC, as it is very slow and limited in
render size.
MacIntel: XenoDream has been tested and runs very well in each of Bootcamp, Parallels Virtualization, and
Crossover Office.
Native Linux or Mac versions are not planned at this time.

7.2 Questions about objects and the Main window
2.01 How can I center the object without changing the shape?
The object can change shape or appearance if you move the holons directly, or if you change the camera position,
depending on how close the camera is. To center the object for rendering, you need to rotate the camera. The
easiest way to do this is to drag in the Preview window when the current view is Camera. (Prior to v1.5, dragging in
the Preview window changed the camera position, but from v1.5 onwards it changes the camera angle.)
2.02 What's the difference between a starter shape and a parameter file?
There is no difference between the files; both are .xep files. The difference is how you open them. The Starter
Shapes... dialog lists only the files in the Starters folder, and when you open them it does not include any
rendering or lighting parameters. The term 'Starters' should only be used in this context and not to refer to sample
parameter files in general.
2.03 How can I add other files to the Starter Shapes list?
Copy the .xep files into the Data\Starters folder, in the XenoDream folder where the program is installed. If you
have changed the location of Starter Shapes in the Preferences dialog, use that location instead.
2.04 Can I make a Free holon larger than the parent shape?
Yes. From v2.3 you can increase holon scales above 100%, so this is easy to do.
In earlier versions it was only possible by using one of several Tile metamorphs (Tilex, Tiley, Tilez, Tilexy, Tilexyd),
with the following procedure:
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If you're not already using both metamorphs on the Free holon, set the unused style to one of those styles; set
Scale at 10 and Special to 0, and adjust Amount larger than 10.
If you are using both metamorphs, you could use an extender holon for the tile.
2.05 Some holons render slower; can I speed them up?
See Optimizing for quality and speed

81

for ways to balance holon density.

2.06 How can I get textures like marble or wood?
One way is to use metamorphs to create the textures. See Advanced coloring and wood
75 .

72

and Stone textures

The other way is to use Picture mapping 78 . You can either use an imported picture of the texture, ideally one
designed for seamless tiling, or create a texture in XenoDream, perhaps using the Pic Texture filter.

2.07 How can I cast shadows onto a backplane?
There are no drop shadow options to create fake shadows. You can use the shadows created by rendering and
lighting the object in either of two ways. One method is to add a plane holon behind the object before rendering.
The other is to combine the background with the object after rendering.
Method 1: add a free plane constructor to the object before rendering, and set shadow angles accordingly.
1. To add the plane, right-click in the center of the Holon window and choose Plane | Square Z from the
submenu.
2. Click the Free Holon button on the Holon toolbar.
3. On the Shape page, set all holon scales to 100, and adjust the Z Position to move the plane slightly behind
the rest of the object. You can temporarily rotate the camera 90 degrees to make that adjustment easier.
Then adjust the .Planez metamorph Scale to fill the background. You may need to adjust the Density for this
holon to render at the same rate as the others.
4. If the camera angle is not the default, you will need to check the plane's Reorient option and rotate it. Of
course you don't have to use a flat plane, or have it exactly vertical.
5. On the Rendering page, set at least one shadow to cast light onto the backplane.
6. Uncheck Cast By Holon for the plane, for best shadow quality.
7. For maximum control of the lighting on the backplane, you can use regions and set the plane holon to a
different region from the others. This allows you to use different material effects.
Method 2: use the technique in Combining backgrounds with objects 128 , with these differences:
1. Instead of creating a texture in the Background picture, just set the background color and choose Clear
Picture in the Picture window Edit menu. (Or you can use a texture or picture.)
2. In the Depth window, set the Height to 0 to not add any texture, and adjust Distance to position the shadow,
and optionally Horizontal and Vertical to tilt the plane.

2.08 How can I cast shadows onto a background picture?
The same two options apply as for casting shadows onto a backplane, but you need a Background picture.
For method 1 (using a plane holon), the steps are the same, but using Picture Mapping 78 for the coloring. With
the Coloring Method set to Metamorph coloring, set Map To to Background Picture for the backplane holon.
Method 2 is easier. The steps are the same as the previous question, but with a picture or texture in the
Background picture.
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Note: The picture colors are affected by lighting since it's now part of the rendered object. For best control, use
regions with the Per Holon method and assign the plane holon to region 2 so you can light it independently; for
example using the same lighting as the rest but changing the Diffuse%, Shininess and Diffuse Color to suit, and
the ambient color and intensity if necessary.

2.09 Can I save the shape memory spots?
Yes. There is an option in the Preferences dialog to keep them between sessions. You can also save them using
the buttons located under the Shape Memory Spots. (You can also use the Animation Memory Spots as extra
shape storage, and save and load them as a set. But unlike Shape Memory Spot files, they are not saved as
individual .xep files and can only be loaded back to the Animation Memory Spots.)
2.10 Can XenoDream import parameter files from other programs? Or export them?
Importing fractal parameters is not possible. While programs that produce either pure IFS or 'flame' variations have
similarities, there are significant differences that would make many of the results incompatible. It is therefore a low
priority for future consideration.
From v2.1 onwards, pure IFS fractals (no metamorphs) can be exported to UltraFractal.
From v2.2 onwards, you can import UltraFractal gradient files (*.ugr) in the Custom Gradient Preset window.
2.11 How can I make the 'flame fractal' type of pictures?
'Flame fractals' were developed by Scott Draves and made popular by KPT FraxFlame™ and more recently Mark
Townsend's Apophysis program. A flame is a 2-D IFS fractal with optional metamorphs and a transparent rendering
method that is slightly different from XenoDream's. The main differences are that they apply metamorphs in parallel
instead of one after another, and compute colors and density differently. Any object may be rendered with
transparency in XenoDream; here are some tips for getting shapes similar to the other programs.
Use between two and eight holons, with no constructors. Adjust the holon scales to set the density of the form.
Too high and you have a blob, too low and you have just a few lines and dots. Adjust them individually to change
the shape and contribution of each holon. To make those thin lines that flames often have, set either the X or Y
Scale very small, and/or set the Z Skew near 90 or 270.
Some of the classic flame styles only work if you stay in 2-D. To do this, keep the X and Y Skew, X and Y
Rotation and Z Position at 0. If you do any dragging in the Holon window, first set Constraints to XY Plane.
The metamorphs that correspond to ones used in classic flames are Spheric, Swirlz, Horshu and Sine. Some
other useful ones are Wabe, Vortex, Zagzigz.
To make Horshu behave the same as the horseshoe transformation, set its Scale to 20, Special to 0 and adjust
the Amount. Leave Reposition unchecked. Move the holon's position to change how it responds.
To make those circular holes, use Spheric. To keep the hole centered on the holon, check Reposition. Adjust
Amount for the strength of effect and Scale for the relative size of the hole. To get lots of holes, don't use Spheric
on all the holons; use it on only one or two and let the other holons iterate them.
Use a large holon with no metamorphs to make spirals or other iterated structures, as you usually would.
For coloring, use either the Holon Sequence method, or Metamorph method with Map From set to Flame. Set
holon opacity between 6 and 12 for smooth renders, higher for faster coarser renders. For lighting, use the 1.6
Transparent 'Ambient only' preset, experiment with the Gamma control in the Alpha panel. Try increasing the
ambient light intensity above 100 to increase vibrancy.
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There are some example files in the Data\Transparent folder.

2.12 I have run out of inspiration and can't seem to make anything interesting; any ideas?
This can happen, not because you've exhausted the possibilities (impossible with XD), but because there are so
many possibilities and it's not obvious what to choose next. Some people have asked why we didn't include a
random mutation generator where you choose from perhaps 12 options each time. The main reasons are that 3-D
preview would be a bit slow for this, and randomizing these kind of objects makes mostly junk. We have included
many options for randomizing subsets of parameters because it can be useful, but adjusting controls will often be
more productive. Here are some ideas if you feel stuck.
1.
2.
3.
4.
5.
6.
7.
8.

Don't start from scratch. Open either a Starter Shape or a parameter file (yours or one of the samples) and
experiment with it...
Look at it from different camera angles. Or adjust the front clipping plane to see what's inside it.
Look at it with transparent preview if you haven't already.
Select one of the holons and adjust the rotations, position, scales or skews to see what happens. Repeat
with other holons.
If it has metamorphs, adjust the parameters, or try a different metamorph, or add a second metamorph if it
doesn't already have one.
Add another holon, with or without a constructor, and experiment with it.
Try doing one of the tutorials but making some different choices. You never know where it could lead.
If your object has relatively smooth surfaces, experiment with multiple lighting techniques 108 .

Many people find it relaxing just to pick a starting point and experiment with holon and metamorph parameters,
and the most interesting shapes also become starting points for another day. Interesting shapes can usually
produce plenty of worthwhile variations. Some people save sets of shape memory spots to come back to later.
Some keep notebooks of ideas.
2.13 Is there any way to combine holons with boolean operations?
No. Of course you can add holons together, but there is no way to do other boolean operations such as
subtraction. The reason is that when calculating each point in a holon, there is no information available about other
points in the same holon or in other holons. The only information available to each point is what it inherits (for an
iterator holon), and what is encoded in its own metamorphs.
There are several metamorphs that allow clipping a holon to a cube or sphere, or cutting holes in it (and in v2.5,
walled tunnels). From v2.3 there is a more flexible way to cut away parts of a holon, using the Meta Pattern Mask.
See Making Holes in Holons 63 for a tutorial.

7.3 Questions about pictures and lighting
3.01 Can I save progress in a large render and resume rendering in another session?
Not yet. You can save and open pictures and depth maps, but not shadow masks or alpha channels; so in
principle you could resume rendering if neither shadows nor transparency are used, if you follow the necessary
steps.
3.02 How long should I render?
It depends. If you use Hybrid or Ordered render methods, rendering stops by itself when 100% complete.
The Chaos method depends on several factors.
For transparent renders in general you can stop it as soon as it looks dense enough or saturated enough; but if
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you will be using lighting that shows a solid surface, it may need longer (pixel rates in the hundreds, rather than
thousands) and may need lower opacities to compensate.
For objects with relatively smooth surfaces, you can often stop it around 500 or higher, sometimes fixing up a
few blemishes with Pits.
For objects with finer detail, quality will improve noticeably if you go to 100 or less. This is especially true when
using the Holon Sequence coloring method with few or no constructor metamorphs, when sometimes the fine
color detail continues to improve after the shape seems well defined, and it can justify going well below 100.
3.03 Are there any options for anti-aliasing in rendering or lighting?
At present there are no options for anti-aliasing the shape in the rendered or lit picture. The Rendering page has an
option to Antialias Color, which works very well for Metamorph coloring, and most of the time for Holon Sequence
coloring.
Another option is to filter the finished picture using Gaussian Blur in the Picture window Effects menu. Set Amount
between 1 and 10, and adjust Width for the best effect.
For best quality anti-aliasing, render the picture two or more times larger, save it in BMP or PSD format and resize
it down in an image editor.
3.04 How do I import a picture to apply lighting to it?
First, in the Picture window File menu choose Open Picture... and select a file. Choose Unlit Picture as the
destination. When prompted to change the size to fit the picture, click Yes.
Second, click the Depth button in the Picture window toolbar to open the Depth window.
See Depth from picture files
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for a tutorial.

3.05 How do I save a Pic Texture with a parameter file?
If you have already applied a Pic Texture, saving a parameter (.xep) file will include the texture. When you open the
parameter file, the texture is loaded too. But you don't see it unless you open the Pic Texture editor. If you want to
apply it to the Background picture, you will need to create or select the Background picture first.
3.06 Is any lighting saved in a parameter file?
Yes. Parameter files include ONE set of lighting parameters (including multiple regions if you have used them).
The current values are saved, regardless of what may have been applied to the picture previously.
3.07 How can I save more than one lighting for use on a single picture?
Apart from multiple regions, there is currently no way to store more than one set of lighting in a parameter file.
There are two options:
1. save them as lighting presets, and write the sequence in the comments field on the File page before saving
the parameter file.
2. save a separate parameter file with each set of lighting parameters. Open the first one, render and light it.
Then open the second file, apply lighting, and so on.
3.08 Can I start lighting before rendering is finished?
Yes, you can preview lighting and adjust parameters etc without stopping the render. If you start too soon on a
larger render the surface won't be well enough defined to assess the results, but it improves all the time.
You cannot apply lighting without stopping the render. As long as you are using the Chaos render method, you
can resume rendering after applying lighting if it needs more.
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Note: it is best to wait until you are sure you have rendered long enough before applying Pits or Polish. Resuming
a render afterwards may reduce the quality.
3.09 How can I get rid of those black spots or rough patches that appear when I use lighting?
See Surface cleaning and other issues

113

for illustrations and discussion of the options.

3.10 Why does lighting make the object too chunky, with thick edges?
Many of the legacy presets have high amounts of smoothing on the light sources, which gives a smooth surface at
the cost of smoothing the features too. Try the 1.6 preset categories, and see Surface cleaning and other issues
113 for more details.
3.11 Why do some lighting presets seem to distort spheres and other shapes?
Many presets have the Extra depth option checked, and/or various Depth values. Some were for specific effect,
others were a legacy from v1.0, which had only pure fractals with no constructor metamorphs, so there were no
'standard shapes' to pose this problem. Try setting Depth to 20, unchecking Extra and checking True, for normal
geometry. See Surface cleaning and other issues 113 for more details.
3.12 What are those white spots and how can I get rid of them?
They are most likely highlights from the lights reflecting off fine details. (They may be other colors depending on
the lighting.) For some shapes this indicates that you should render longer, and/or do some surface cleaning. If
there is supposed to be fine detail in the shape, you should consider using mostly diffuse light. See Surface
cleaning and other issues 113 for an illustration.
3.13 Why does the preview change after applying lighting with reflection or refraction?
If the source for reflection or refraction is 'Old Lit picture', then applying lighting changes the Lit picture, so the
reflection or refraction changes and the preview shows this. Reflection and refraction are implemented as a kind of
environment mapping, offering creative flexibility, but you need to keep in mind where the effect comes from. Using
the Old Lit picture means it takes at least two passes to get an effect. Before you have applied any lighting, there
is no Lit picture and therefore no reflection can come from it. So you apply some lighting, then you see the
reflection and/or refraction, adjust if necessary, and apply again. Of course you can change lighting between
applying.
3.14 Sometimes the program hangs when I open the Lighting window. What can I do?
The problem has been partially resolved in v2.1 (with threaded lighting) and further improved in v2.2, but if you still
find it happening, in the Main window Options menu the Preferences dialog has an option in the Technical panel for
No Lighting Preview on Window Activation. Try checking this option. The only disadvantage is that the lighting
preview won't update until you scroll it or change something in the Lighting window.
If you are rendering large pictures with the View set To Fit, it may help to set it to 100% before switching to lighting
or depth.

7.4 Mesh questions and answers
4.01 What should I use for the Mesh Grid Size?
Bigger mesh grid size means more resolution and better quality results, so use as much as the object needs.
There are two issues.

Frequently Asked Questions
1.

2.
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An object with no fine detail and no areas of high curvature (eg sharp edges) may be captured perfectly at a
moderate grid size, and higher settings just take longer without worthwhile improvement. Simple rounded
shapes may be fine at 200 or 300.
The size is limited by how much RAM you have. With 2GB you can handle up to about 17 million triangles,
although grid sizes above 500 will use more memory for capturing, leaving less available for triangle
processing. Using the Volume method, complex objects can generate many more triangles than simple
objects, so it can be a good idea to test them at moderate sizes to see how many triangles are generated,
and estimate how large you can go. Doubling the grid size generates about four times the number of triangles,
sometimes more.

4.02 How does mesh export compare with v1.5?
If you previously used v1.5 for mesh exporting, you will notice huge improvements. Besides the new Smoothing
option and numerous bugfixes there are a few you should know about.
1. Later versions use less memory, allowing more triangles, and are much faster and more robust.
2. Mesh filtering uses different methods that are much better.
3. With Volume Filling enabled, the progress indicator shows the percentage of voxels filled. If it is near zero you
can abort Triangulation early and render more before triangulating again.
4. Version 2.2 and later always produce 2-manifold meshes (watertight and no extra triangles sharing edges), for
compatibility with some applications that require it. However, simplification did not maintain a perfect manifold
in v2.2, while in v2.3 it can with the 3D Printing option.
4.03 Why does the mesh render look different from the Main window preview?
The Main window Camera view shows the object in perspective, while the Mesh Export window does not. The
amount of difference depends on the camera distance on the View page. If you use the orthogonal views in the
Main window, the object will look the same as in the Mesh Export window. Another reason for differences is when
the main preview is zoomed in. Mesh export will include the whole object unless the Lock Scaling option is used.
4.04 Why is my object rendering too small in the Mesh Export window, when it was sized right in the
Main window?
The mesh render autoscales the object to fit the mesh grid. If you zoomed into the object, or if it has some points
out of view that you may not have noticed, this will cause the object to render much smaller for the mesh. There
are two options to fix this. One is to eliminate the unwanted points in the Main window, if that is possible. The
other is to use the Lock Scale button in the Mesh Options dialog. Lock the scale, then return to the Main window
View page and increase the Camera Zoom (and optionally Object Size), and render the mesh again. You may
need to readjust the zoom a few times to get it right. In extreme cases you may need to reduce the zoom (or
Object Size) before the initial mesh render, to have enough zoom range after locking the scale.
4.05 Can I export meshes including color or regions?
Not directly at present. Some color or region export may be implemented in future. There is a more complicated
way to create UV mapped textures from XD coloring, in the Mesh coloring 139 topic.
4.06 Can I import meshes to use XD's simplification?
Not at present.
4.07 Can I use meshes as part of an object in the Main window?
Not at present. It may be implemented in future.
4.08 The Fill Volume option isn't working no matter how long it renders. Is there anything I can do?
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This can happen if the object has areas that fill in very slowly or not at all. Metamorphs in the Fractal category
often cause this.
One solution for shapes that are not too complicated is to use the Surface method instead, and possibly reduce
the Isosurface Level to 90 or less.
4.09 What are the best settings to make objects for 3D printing?
Some 3D printers have a minimum thickness for parts, so it may help to thicken the object by using lower values
of Isosurface Level. The triangulation is more voxelized, but the two step filter can clean it up completely, as long
as Sharpness is less than 95, so you can set Isosurface Level as low as 10 if you want.
After triangulating, click the Mesh Info button to see if there are small pieces in the mesh that need to be removed,
and if necessary, adjust the threshold to exclude them. You can click a line in the list to exclude that size and
below.
For the Simplify option, always use 3D Printing, and set Quality below 95 and above 5 or so, to ensure that the
mesh is manifold and any small pieces have been removed. The status panel should indicate '(Manifold)'.
Saving to STL files is often required for 3D printing, and you can set the dimension in the Options dialog if you
know what the printer requires.

7.5 Technical questions
5.01 What is the format of .xep parameter files?
The format is basically text with INI style name-value pairs. Most lines contain values for whole sets of parameters.
The program can read files with Windows or UNIX style line breaks, but name-value pairs must not be broken with
any additional line breaks.
In general, all lines except for ParRevision and XenoDreamPar are optional.
Essential data will have default values if not specified, and some optional data such as Pic Textures will be left
unchanged if not specified.
If a name-value pair is included, the full number of expected parameters must be present.
A full specification is not currently available, but if you need more information, enquiries are welcome.
5.02 What is the format of camera data in the .xep files?
XenoDream uses a rotation matrix for the camera orientation, and calculates angles from that as needed.
The ViewOrientation parameter specifies the nine values of the rotation matrix first, followed by the position of the
origin relative to the camera.
The ExportCamera parameter is not read by XD, but generated for the benefit of anyone wanting to export camera
data for synchronizing other renders. It specifies the X, Y, Z camera angles and the X, Y, -Z origin position.
The first two parameters of ViewPars are Object Size and Camera Zoom. These both use a square law instead of
linear response.

